FOREWORD

The Laboratory Division of the Indiana State Police (ISP) conducts tests on various body fluids, body fluid stains, and human hair for criminal justice agencies. DNA analysis is performed as needed on the various biological materials. The Laboratory reserves the right to evaluate and prioritize the items submitted and limit the total number in order to expedite service. The analysts of the Forensic Biology Section shall have a minimum of a baccalaureate or an advanced degree in a natural science or a closely related field. DNA analysts shall have successfully completed college course work covering the subject areas of genetics, biochemistry, molecular biology and statistics. All analysts undergo an intensive formalized training program dealing with forensic techniques and instrumentation. Completion of the Training Program is required before analysis of evidence is performed. Additionally, all analysts participate in proficiency testing utilizing open trials, blind trials, and/or re-examination techniques. The accuracy and specificity of test results are ensured by running known controls with each set of tests.
TABLE OF CONTENTS

1. Serology Methods
   a. Serology Examination
   b. Phenolphthalein (Kastle-Meyer)
   c. Luminol
   d. HemDirect Hemoglobin Test
   e. Takayama
   f. Acid Phosphatase
   g. Microscopic Examination for Spermatozoa
   h. Christmas Tree Stain
   i. Hair Examination
   j. Report Writing

2. DNA Methods
   a. DNA Examination
   b. Sampling Protocols
   c. Organic Extraction (Regular)
   d. Demineralization and Organic Extraction of Bone and Teeth
   e. Organic Extraction (Differential)
   f. QIAcube Extraction (Differential)
   g. Microcon® Concentration
   h. Centri-sep cleanup
   i. Maxwell® 16 Extraction
     1) Regular Sample Preparation
     2) Differential Sample Preparation
     3) Maxwell® Procedure
   j. Rehydration of a sample after storage
   k. Quantifiler® Trio Quantification
     1) Introduction
     2) Standard Curve Preparation
     3) Experiment Set-up
     4) Experiment Analysis
     5) Interpretation
   l. PowerPlex® Fusion 6C with the 3500 Series Genetic Analyzer
     1) Introduction
     2) Amplification
     3) Electrophoresis
   m. GeneMapper® ID-X
     1) PowerPlex® Fusion 6C Data Analysis
   n. Interpretation Guidelines
     1) Identification of a Mixture
     2) Determination of Allele Peaks
     3) Evaluation of Controls
     4) Determination of Number of Contributors
     5) STRmix™ Interpretation
     6) STRmix™ Run Diagnostics
     7) STRmix™ Troubleshooting
     8) Report Writing and Statistical Rules
3. **Forensic Relationship Methods**
   a. **Interpretation**
   b. **Statistical Rules**
   c. **Report Writing**

4. **Y-STR Methods**
   a. **Y-STR Examinations**
   b. **PowerPlex® Y23**
      1) **Introduction**
      2) **Amplification**
      3) **Electrophoresis**
   c. **GeneMapper® ID-X**
   d. **PowerPlex® Y23 Interpretation Guidelines**
      1) **Stutter**
      2) **Mixture Interpretation**
   e. **PowerPlex® Y23 Report Writing**

5. **Automated DNA Methods**
   a. **Regular Extraction Preparation**
   b. **Differential Extraction Preparation**
   c. **Initial Tube Transfer Method**
   d. **Automated DNA IQ Extraction Method**
   e. **Automated Quantification Method – Trio**
   f. **Automated Amplification Setup Method – PowerPlex® Fusion 6C**
   g. **Automated CE Plate Setup Method**
   h. **Final Tube Transfer Method**

**APPENDICES:**

1. **Flow Charts**
   Appended 1
2. **HID Real-Time PCR Analysis Software Set-up**
   Appended 2
3. **Applied Biosystems® 3500 Software Set-up**
   Appended 3
4. **Setting Up GeneMapper® ID-X Software Settings**
   Appended 4
5. **STRmix™ Software Settings**
   Appended 5
6. **PowerPlex® Fusion 6C Stutter Table**
   Appended 6
7. **Report Wording**
   Appended 7
8. **Definitions**
   Appended 8
9. **Server Instructions**
   Appended 9
10. **Relationship Comparison Statistical Reference**
    Appended 10
11. **Applied Biosystems® 3500 Software Set-up Y23**
    Appended 11
12. **GeneMapper® ID-X Software Settings Y23**
    Appended 12
13. **PowerPlex® Y23 Stutter Table**
    Appended 13
1. **Serology Methods:**

1.1. **Scope:** This test method is designed for the guidance of laboratory personnel who assist investigations where body fluids or stains occur as physical evidence in a variety of alleged criminal activities. The scope of this type of evidence includes but is not limited to the following: identification of human blood, semen, and human hair. This test method may be expanded or altered as techniques and/or new genetic analyses are found applicable and validated.

1.1.1. Trace evidence including but not limited to hair, fibers, glass, or paint may be collected from evidence submitted for serological examination. Collected trace evidence shall be retained in the original packaging unless value is immediately apparent. Appropriate notes shall be taken on the trace evidence collected. When required, hairs shall be evaluated for the possibility of human origin and the potential for future analysis.

1.1.2. A search is made of submitted items for the presence of biological material.

1.1.3. If applicable, stain cards from whole blood samples, cuttings from body fluid stains and other DNA evidence may be retained by the laboratory for possible future testing. See flow charts.

1.1.4. The retained items may be released at the prosecutor’s request. The request shall be documented in the case record. A valid court order shall circumvent this procedure.

1.2. **Precautions/Limitations:**

1.2.1. **Evidence**

1.2.1.1. Liquid items such as blood standards shall be refrigerated not frozen. Stained materials may be frozen, refrigerated or stored at room temperature in a dry environment. Items to be analyzed for latent prints should not be frozen or refrigerated.

1.2.1.2. Stains that are still moist shall be air dried in a secure area before submission to the laboratory.

1.2.1.3. Clean paper or cardboard containers shall be used to package dried evidence. Plastic containers shall not be used for packaging because they hold moisture which often leads to putrefaction of biological materials. Exceptions to this rule would include blood tubes, body tissue samples and condoms. Each item should be placed in separate containers from the point of collection.

1.2.1.4. If multiple items are placed in one container at time of collection, they may be submitted in the single, original package.

1.2.1.5. Specific examinations performed on items of serological evidence shall be determined by laboratory personnel.

1.3. **Related Information:**

1.3.1. [Appendix 1 Flow Charts]

1.3.2. [Work Sheet Manual]

1.4. **Instruments:**

1.4.1. **Balances** – An analytical balance used for preparation of analytical reagents and buffers.

1.4.2. **Centrifuges** – A serofuge capable of operating at 3,400 rpm and a microcentrifuge capable of greater than 15,000 rcf, are used for separation of solid components from fluids.

1.4.3. **Alternate light source (ALS)** – A light source to aid in the location of stains and trace evidence by use of various wavelengths of light.
**INDIANA STATE POLICE**  
**FORENSIC BIOLOGY SECTION**  
**TEST METHODS**

1.4.4. **Crosslinker** - Preprogrammed ultraviolet exposure unit which is factory set to ~120,000 microjoules per cm².

1.4.5. **Digital camera** – Used to document evidence and/or the packaging.

1.4.6. **Microscopes** – A light microscope with magnification up to 400X, a stereoscope for general screening of items, and a phase contrast microscope for the identification of spermatozoa.

1.4.7. **Miscellaneous Laboratory Equipment** – Supportive laboratory equipment including ovens, incubators, pipettors, rotators, stirring/heating plates, vortex mixers, vacuum pumps, UV lights, and refrigerators/freezers for storing of reagents, buffers and evidence.

1.4.8. **pH meter** – An instrument capable of manual or automatic temperature compensation and reading +/- 0.01 pH units. Used for preparation of buffers and reagents.

1.5. **Reagents/Materials:** See Reagent Preparation Manual for instructions and logs.

1.5.1. **Alpha Naphthyl Phosphate Solution**

1.5.2. **Acid phosphatase Acetate Buffer**

1.5.3. **Acid phosphatase Dye Solution**

1.5.4. **Glucose, saturated**

1.5.5. **HemDirect Hemoglobin Cassettes**

1.5.6. **HemDirect Hemoglobin Buffer**

1.5.7. **3% H₂O₂**

1.5.8. **Luminol Reagent**

1.5.9. **Phenolphthalein Stock Solution**

1.5.10. **Phenolphthalein Working Solution**

1.5.11. **10% Sodium Hydroxide**

1.5.12. **Takayama Solution**

1.6. **Hazards/Safety:**

1.6.1. All chemicals shall be handled in a safe method as referenced in the specific SDS.

1.6.2. Preparation of the Phenolphthalein Stock Solution shall be performed in a chemical fume hood.

1.6.3. The spraying of Luminol reagent in the laboratory shall be confined to a chemical fume hood whenever practical.

1.6.4. Universal Precautions shall be in use whenever biological materials are being handled.

1.6.5. Extreme caution shall be used when handling liquid body fluid samples.

1.6.6. Biological waste shall be disposed of in the appropriate waste receptacle.

1.7. **Reference Materials/Controls/Calibration Checks:**

1.7.1. **HemDirect Hemoglobin tests** shall be performance checked before use in casework.

1.7.1.1. Each new lot of HemDirect Hemoglobin Tests shall be analyzed with a 1:10 dilution of blood dried on filter paper or a 1:500 dilution of liquid human blood. A positive result as described in the HemDirect test method shall be obtained before use in casework. The worksheet used to record the results shall be retained.

1.7.1.2. If the lot fails the quality control test it may be retested. If it fails a second time the lot shall not be used for casework. The Technical Leader shall be informed within one business day of the failure.

1.7.2. Running known controls with each test ensures the accuracy and specificity of the test results. See the specific test procedure for the appropriate controls to be run.
1.8. Procedures/Instructions:

1.8.1. Examination Procedure

1.8.1.1. Standards for Comparison

1.8.1.1.1. Appropriate standards, such as whole blood or buccal swabs, from those individuals involved should be submitted along with the unknown materials to be analyzed.

1.8.1.1.2. The whole blood standard should be submitted in a purple top tube that contains ethylene-diamine-tetra-acetic acid (EDTA). Prior to examination, while in the custody of the ISP Laboratory, this tube shall be refrigerated.

1.8.1.1.3. A stain card may be prepared from at least one whole blood standard from each individual.

1.8.1.1.4. Buccal swab standards containing multiple swabs from an individual may be labeled and treated as one item.

1.8.1.1.5. Oral swabs in a sexual assault kit with no identified standard may be used as a standard if a single source profile is obtained.

1.8.1.1.6. The analyst's notes shall indicate the presence of hair standards. In sexual assault kits where a blood or buccal swab standard is present the hair standards do not need to be opened or examined, just noted.

1.8.1.1.7. Elimination/Victim standards in property crime cases should be returned to the submitting agency.

1.8.1.1.8. Suspect standards in all cases and elimination/victim standards in crimes against person cases shall be retained as a subitem for future reference and analysis.

1.8.1.1.9. In cases where a secondary standard is needed, the item to be used as a secondary standard shall be clearly identified as such in the case report.

1.8.1.1.9.1. The use of a blood stained article of clothing may be appropriate if stains from the person wearing the clothing can be definitively identified (i.e. blood from around the wound area).

1.8.1.1.9.2. In the case of a missing person, personal items such as toothbrush, hairbrush, razor or other item may be submitted.

1.8.1.1.9.3. When a contributor requests items to be used as secondary standards during the submission process, it should be indicated on the Request for Laboratory Examination form.

1.8.1.2. Trace Evidence

1.8.1.2.1. A clean piece of paper shall be used under each item as it is examined. The exam paper should be retained in the original package. After returning the item to its package, fold the exam paper, tape it closed (making sure all trace evidence is secure within the bundle) and place it in the package with the item.

1.8.1.2.2. Items may be tape lifted to collect evidence. Where tape lifting is not appropriate, tweezing and/or scraping may be substituted. Items involving multiple examination requests shall only be tape lifted or scraped after consultation with analysts from the other disciplines.

1.8.1.2.3. All collected trace evidence shall be stored with original item unless value is immediately apparent.
1.8.1.2.4. Analyst shall document in the notes the presence of hair, fibers, plant material, glass, paint, etc. Such trace evidence shall be reported out only when it is deemed to have value. In those cases where the material appears to be extraneous debris of no significance, the trace statement may be omitted from the report.

1.8.1.2.5. Hair combings need not be opened or examined, just their presence noted. If opened, the approximate number and quality of hairs shall be documented.

1.8.1.2.6. In cases where there is other DNA evidence of investigative value that has been tested and profiles obtained, no DNA testing of the collected hair shall be performed without the approval of a Biology Unit Supervisor or Laboratory Manager.

1.8.1.2.7. In cases where there is no other DNA evidence of value, the prosecutor/investigator shall first be contacted for approval of consuming the hair sample if further analysis of the hair is performed.

1.8.1.2.8. When appropriate, examination of the hair collected shall be performed to determine if hair consistent with human origin is present.

1.8.1.2.9. Human hairs can be submitted for DNA analysis when beneficial.

1.8.1.3. Dried Stains (See flow charts)

1.8.1.3.1. Visual Inspection – A visual inspection of the item shall be conducted to determine the location, if present, of unknown stains. An ultraviolet light or an alternate light source may be used to help locate stains.

1.8.1.3.2. If phenolphthalein is being performed on stains which demonstrated positive luminol result and phenolphthalein is negative, no further testing should be performed due to the possibility of false positives for luminol. These results should be reported out as inconclusive.

1.8.1.3.3. Confirmatory testing for semen and blood/human blood is at the discretion of the analyst.

1.8.1.4. Stain Evaluation – Sexual Assault kits

1.8.1.4.1. No serological testing shall be performed on samples within a kit.

1.8.1.4.2. Exceptions require permission from a supervisor with documentation in the case record.

1.8.1.4.3. Acid Phosphatase testing and sperm searches may be done at the request of a Prosecutor with proper justification and documentation in the case record.

1.8.1.5. Stain Evaluation – All other

1.8.1.5.1. After attempting to identify the stain, the stain shall be evaluated for further testing.

1.8.1.5.2. If no biological material is identified on the item, no further testing shall be performed, except for instances where touch DNA or handler/wearer analysis is appropriate.

1.8.1.5.3. If the stain is found to be biological but no standards are available for comparison, the stain or a portion thereof may be retained by the laboratory for future testing. DNA testing may be performed and results entered into the Combined DNA Index System (CODIS) when eligible. See flow charts.

1.8.1.5.4. If the stain is found to be biological material and all necessary standards have been submitted, the analyst shall determine if DNA testing shall be performed based on an
evaluation of the stain. Things that may be considered include, but are not limited to, the amount, size, concentration, location and condition of the stain.

1.8.1.6. **Collection and labeling of swabs**

1.8.1.6.1. Each swab in a submitted item or collected and retained by the analyst shall have a unique identifier if serological testing is performed on any of the swabs for that item. If different testing results are obtained between swabs in the same item each result will be reported.

1.8.1.6.2. If no serological testing is performed and the swabs are being treated as one sample (i.e. portions of all swabs are combined together for DNA analysis), the swabs may be labeled together as one item.

1.8.1.6.2.1. If the swabs are being treated differently for DNA analysis (i.e. one swab is tested while the other is not), the swabs shall have unique identifiers.

1.8.2. **Sampling of items that may contain unknown or dangerous drugs**

1.8.2.1. Caution should be exercised when opening and examining evidence with unknown powders and liquids or known dangerous powders or liquids. A fume hood and appropriate personal protective equipment shall be utilized when sampling evidence. Every effort should be made to prevent exposure to potentially hazardous materials. Analysts shall use the designated fume hood.

1.8.2.2. Narcan (or similar product) should be available and in a clearly marked location during analysis.

1.8.2.3. Place any utensils and consumables to be used inside the hood so that it will not be necessary to reach outside the hood during item examination.

1.8.2.4. Open and examine the item(s) within the designated hood.

1.8.2.5. Change gloves frequently. When changing gloves, dispose of used gloves in a biohazard bin located inside the hood.

1.8.2.6. Collection of possible DNA by swabbing the item shall occur inside the designated hood. Allow the swab to dry in the designated hood.

1.8.2.7. Seal the evidence within the hood. An additional outer container may be used if the packaging cannot be fully cleaned.

1.8.2.8. Once the evidence examination is complete, clean the hood thoroughly.

1.8.2.9. Dispose of any unused consumables.

1.8.2.10. The hood biohazard bag shall be closed and placed inside the larger biohazard bin.

1.8.3. **Phenolphthalein (Kastle-Meyer Reagent), Presumptive Test for Blood**

1.8.3.1. **Principle:** Phenolphthalein is an oxidizable organic molecule, which can be oxidized by free hydroxyl ions liberated by peroxidase-like action. The heme group of hemoglobin possesses a peroxidase-like activity, which may catalyze the breakdown of hydrogen peroxide to form free hydroxyl radicals. Phenolphthalin (reduced form) is oxidized by the free hydroxyl ions to phenolphthalein (oxidized form), producing a pink color.

Phenolphthalein (abbreviated Phe on controlled worksheets) is a presumptive test for the presence of blood. Confirmatory testing shall be performed for conclusive identification. Phenolphthalein has been shown to give false positives or weak reactions with various oxidizing agents, plant material, etc.
**1.8.3.2. Procedure**

1.8.3.2.1. Rub the suspected bloodstain with a piece of filter paper or a cotton swab or make a small cutting of the suspected bloodstain and place on white filter paper or in a white spot plate well.

1.8.3.2.2. Add one to three drops of the phenolphthalein working solution to the stain.

1.8.3.2.3. Wait 10-15 seconds, assuring no pink color develops at this time.

1.8.3.2.4. Add one to three drops of 3% Hydrogen Peroxide.

1.8.3.2.5. Upon addition of the Hydrogen Peroxide an immediate pink color is indicative of the possible presence of blood.

1.8.3.3. Reagents shall be tested with positive and negative controls and the results recorded in the case notes. This shall be performed and recorded daily when in use and prior to use on evidence. Lot numbers and/or preparation dates of reagents shall also be recorded.

**1.8.4. Luminol, Presumptive Test for Blood**

1.8.4.1. **Principle:** Luminol is a presumptive test designed to process large areas where stains are not readily visible. Luminol works best on old stains (where the heme group has been converted to hemin) and while it does soak the area tested, it should not interfere with additional testing. In the luminol test, the hemin acts as a catalyst, triggering the oxidation of luminol by hydrogen peroxide in an alkaline solution.

Confirmatory testing shall be performed for conclusive identification. Luminol has been shown to give false positives with certain metal compounds, plant peroxidases and some cleansers, especially cleansers which contain hypochlorite (bleach). Luminol is an alternative method that can be used on items where bloodstains are not easily visible.

1.8.4.2. **Procedure**

1.8.4.2.1. Prepare the luminol solution by adding the contents of the powdered luminol tube (8 oz size) to 8 oz (250 ml) of distilled water in a plastic reagent bottle. Alternate powdered luminol tubes are available in 4 oz and 16 oz sizes. If these are used, add the corresponding amount of distilled water, 4 oz (125 ml) or 16 oz (500 ml).

1.8.4.2.2. Gently mix the powder and distilled water with a gentle swirling action in order to avoid mixing an excessive amount of air or oxygen into the solution.

1.8.4.2.3. Transfer the luminol solution into a fine mist spray bottle. Any unmixed powder remnants should be left in the bottom of the plastic reagent bottle and not transferred into the spray bottle to avoid clogging the sprayer.

1.8.4.2.4. The mixed luminol solution should be used within about 20 - 30 minutes.

1.8.4.2.5. All individuals present during testing shall wear gloves, eye protection and a surgical mask or equivalent.

1.8.4.2.6. Spray the area of interest in the dark until well-soaked. Luminol’s reaction with a true bloodstain produces a luminescent glow, frequently in patterns such as spatters, smears, wipes or drag marks, or even footwear impressions.

1.8.4.2.7. 

1.8.4.3. Any remaining luminol solution cannot be stored for later use because the reagent will lose potency. The remaining luminol solution can be disposed by washing it into the sink with a
large quantity of water. Also, be sure to clean out the spray bottle and nozzle with clean water, as any luminol remaining in the sprayer will form a difficult-to-remove clog.

1.8.4.4. Reagents shall be tested with positive and negative controls and the results recorded in the case notes. This shall be performed and recorded daily when in use and prior to use on evidence or at a crime scene. Lot numbers of reagents shall also be recorded.

1.8.5. HemDirect Hemoglobin Test, Confirmatory Test for Human Blood

1.8.5.1. Principle: Human blood reacts with an anti-human hemoglobin antibody, which forms a red line in the “test” region of the HemDirect cassette.

1.8.5.2. Procedure

1.8.5.2.1. Place a ~2mm² cutting, a few flakes, a few drops of liquid blood diluted to 1:500, or ~1/8 of a swab in the tube of supplied extraction buffer. The cutting shall remain in the buffer solution for 5 minutes. A maximum extraction time of 10 minutes may be utilized for inhibited samples.

1.8.5.2.2. Add three drops of the extraction buffer/sample mix with the provided pipette to the sample well of the cassette.

1.8.5.2.3. A positive result may be recorded as soon as red lines are observed in both the “C” (control) and “T” (test) regions.

1.8.5.2.4. Negative results (a red line in only the “C” region; no line in the “T” region) should be confirmed after 10 minutes.

1.8.5.2.5. If a line in the “C” region does not appear after 10 minutes, test results are invalid and shall be repeated.

1.8.5.3. Each new lot of HemDirect kits shall be performance checked before use. Additional testing of reagents with positive and negative controls before use on evidence is not required. Lot numbers of reagents and the result of the internal positive control shall be recorded.

1.8.6. Takayama, Confirmatory Test for Blood

1.8.6.1. Principle: Takayama reacts with the heme portion of the blood to form characteristic hemochromogen microcrystals.

Some vegetable peroxidases may form Takayama crystals similar to those formed by blood; however, these substances do not have the same appearance or physical properties as blood.

1.8.6.2. Procedure

1.8.6.2.1. Prepare working solution by combining glucose, sodium hydroxide, pyridine, and distilled water. The working solution may be made up and stored in the refrigerator for up to one month.

1.8.6.2.2. Place a small cutting, few threads or flakes on a microscope slide and cover with a cover slip. Alternatively, a drop of stain extract may be dried onto the slide.

1.8.6.2.3. Flood under the cover slip with the prepared Takayama reagent.

1.8.6.2.4. Gently heat the microscope slide on a hot plate or equivalent heat source. Optionally, if the stain is weak, the test may be allowed to sit at room temperature.
INDIANA STATE POLICE  
FORENSIC BIOLOGY SECTION  
TEST METHODS

1.8.6.2.5. When cutting turns bright pink/red, remove from heat and allow to cool to room temperature before observing under the microscope. Negative samples may never turn to the bright pink color.

1.8.6.2.6. Bright red, spiky crystals should be apparent in the presence of a sufficient concentration of blood. Tapping of the cover slip to separate crystals from the cutting may be necessary to observe crystals.

1.8.6.3. Reagents shall be tested with positive and negative controls and the results recorded in the case notes. This shall be performed and recorded daily when in use and prior to use on evidence. Lot numbers and/or preparation dates of reagents shall also be recorded.

1.8.7. Acid Phosphatase, Presumptive Test for Semen

1.8.7.1. **Principle:** Seminal fluid is typically found to contain acid phosphatase in levels 400 -1000 times those found in other body fluids. This test uses the ability of acid phosphatase to hydrolyze a phosphate ester substrate to release a free alcohol, which in turn reacts with a diazonium salt to give a brilliantly colored end product.

Acid Phosphatase (abbreviated AP on controlled worksheets) is a presumptive test for the presence of semen. Confirmatory testing shall be performed for conclusive identification. Possible sources of acid phosphatase other than semen include vaginal secretions, urine, sweat or fecal material.

1.8.7.2. **Procedure:** Prepare substrate and dye solution immediately prior to testing. These solutions will be stable for 1-2 hours at room temperature. Alternatively, use previously aliquoted and frozen solutions.

1.8.7.2.1. Weigh out about 20 μg of alpha naphthyl phosphate and place in shell vial or small test tube.

1.8.7.2.2. Weigh out about 20 μg of fast blue or fast red dye (shall be in diazonium salt form) and place in second shell vial or small test tube.

1.8.7.2.3. Add about 1 ml of acetate buffer to each and mix.

1.8.7.2.4. Cut a small (approximately 2 mm x 2 mm) portion of the stained material and place it on a small piece of filter paper, in a white ceramic spot plate well or in a small test tube. An extract can be used.

1.8.7.2.5. Wet the cutting with the alpha naphthyl phosphate solution. Wait about 1 minute.

1.8.7.2.6. Add 1-2 drops of the dye solution to the cutting.

1.8.7.2.7. The development of color (depending on dye used) in less than 15 seconds is indicative of the presence of acid phosphatase. Color soaked into the filter paper under the sample is also indicative of a positive test.

1.8.7.2.8. A slow development of color could be an indication of acid phosphatase from sources other than semen. This may be indicated on the worksheet as a slight color change (SCC). A SCC result shall be reported as a negative result.

1.8.7.2.9. The interpretation of the results shall be reported by the analyst.

1.8.7.3. Reagents shall be tested with positive and negative controls and the results recorded in the case notes. This shall be performed and recorded daily when in use and prior to use on evidence. Lot numbers and/or preparation dates of reagents shall also be recorded.

1.8.8. Extraction of Body Fluid Stains
1.8.8.1. **Principle:** Evidentiary stains can be extracted and the extracts used for body fluid stain identification.

1.8.8.2. **Procedure**

1.8.8.2.1. Prepare samples (and backgrounds, if used) for testing by eluting a cutting of the stain (approximately 3 mm by 3 mm) in an appropriate amount of distilled water in a microcentrifuge tube overnight in the refrigerator. Alternatively the sample can be eluted in a 37°C oven for a minimum of 30 minutes or at room temperature for a minimum of 1 hour.

1.8.8.2.2. After incubation, the cutting should be removed, placed into the cap with holes for drainage or a spinex basket, and the extract spun down.

1.8.9. **Visual Observation of Spermatozoa**

1.8.9.1. **Principle:** The visual identification of spermatozoa is a scientifically accepted method of positively identifying the presence of seminal material.

1.8.9.2. **Procedure**

1.8.9.2.1. Place ~10 μl of the previously extracted sample on a microscope slide and cover. Phase contrast microscopy is used to differentiate the cellular appearance. Spermatozoa are round to ovoid with an acrosomal cap, midpiece, and tail. When the tail and midpiece are not present, the distinctive flattened profile of turned spermatozoa should be observed.

1.8.9.2.2. Alternatively a small (1 mm x 1 mm) cutting may be eluted directly onto the slide with a drop of distilled water, agitating with forceps. Remove the cutting and cover the extract with a cover slip.

1.8.9.2.3. The observations should be rated using the following system:

   - POS (+) Only a few sperm or sperm heads on the entire slide.
   - 1+ One sperm or sperm head per several fields of view.
   - 2+ One sperm or sperm head in about half of all fields of view.
   - 3+ One sperm or sperm head in most fields of view.
   - 4+ Several sperm or sperm heads in most fields of view.

1.8.10. **Christmas Tree Stain (Kernechtrot-Picroindigocarmine Differential Stain) (Optional procedure to help visualize spermatozoa)**

1.8.10.1. **Principle:** The Christmas tree stain is used to assist in scanning slides for the presence of spermatozoa. Red and green colored stains are utilized to enhance the appearance of spermatozoa and epithelial cells in biological samples.

1.8.10.2. **Procedure**

1.8.10.2.1. Pipette ~5-10 μl of the pellet from the bottom of extracted sample tube and place onto microscope slide. Previously prepared slides from the evidence collection kit may go directly to heat fix and staining procedures.

1.8.10.2.2. Also prepare a slide from a 1:50 dilution of a sperm positive semen stain to use as a positive control for the staining procedure.

1.8.10.2.3. Heat fix the sample onto the slide.

1.8.10.2.4. After the slide has cooled, place on a level surface and add several drops of the SERI Christmas Tree Stain A (red stain) to the slide. Stain for about 10 to 15 minutes.
1.8.10.2.5. Rinse stain from the slide by gently running distilled water over the slide.

1.8.10.2.6. Return slide to a level surface and add several drops of the SERI Christmas Tree Stain B (green stain) to the slide. Stain for about 10 seconds.

1.8.10.2.7. Rinse stain from the slide by gently running 95 to 100% ethanol over the slide.

1.8.10.2.8. Allow slide to air dry or dry in 56°C oven. After drying, slide is ready to view microscopically applying bright field procedure.

1.8.10.3. Reagents shall be tested with a positive control and the results recorded in the case notes. This shall be performed and recorded with each batch of staining. Lot numbers and/or preparation dates of reagents shall also be recorded.

1.8.10.4. Interpretation

1.8.10.4.1. Spermatozoa will appear as small red/pink structures and have the following staining characteristics:

<table>
<thead>
<tr>
<th>Acrosomal cap</th>
<th>clear to pink</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post acrosomal cap</td>
<td>dark pink to red</td>
</tr>
<tr>
<td>Midpiece</td>
<td>green to blue</td>
</tr>
<tr>
<td>Tail</td>
<td>green to blue</td>
</tr>
</tbody>
</table>

1.8.10.4.1.1. Nucleated epithelial cells will appear as green rhomboid-like structures with a red/pink nucleus. The cell's appearance can vary in shape, often being folded or overlapping and are normally larger than the spermatozoa heads.

1.8.10.4.2. NOTE: The smear slides contained in evidence collection kits shall be viewed using phase contrast microscopy before proceeding to the Christmas tree stain procedure.

1.8.11. Visual Observation of Human Hair

1.8.11.1. Principle: Before DNA analysis can be performed on hair collected as evidence, a determination of possible human origin and the identification of the root shall be performed.

1.8.11.2. Procedure

1.8.11.2.1. When the unknown hairs are on a tape lift, the lift should be examined using a stereomicroscope to eliminate obvious hair fragments, fibers, and animal hairs. All hairs of possible human origin with sufficient root material should be removed from the lift and placed in a paper bindle. A wet mount should be prepared when further examination is required to determine human origin and/or presence of root material. Unknown hairs are placed on a microscope slide with a drop of distilled water, covered with a cover slip, and examined with a light microscope. The number and general appearance of the human hairs should be noted when practical. If additional hairs/fibers are present in the original package, they should be placed in a separate bindle and retained in the package.

1.8.11.2.2. Observation should begin with the presence of scales (imbricate in humans and some animals). Human hairs demonstrate a wide variety in color and pigment distribution among individuals. The color in the cortex should be fairly uniform throughout the length and breadth of the hair. An exception would be dyed or bleached hairs, which could demonstrate a sudden or
gradual color change at the dye line. (Animal guard hairs demonstrate a characteristic color banding). The medulla (the amorphous central core) can be continuous, discontinuous, fragmentary, or not present in human hair. Medullary index should be one-third or less the total diameter of the hair. There is considerable variation in the general appearance of human hairs depending on the body area. In general there is less variation in diameter along the length in human hairs than in animal hairs. The appearance of the root is very important both in determining origin and in determining the area to sample for DNA. The appearance of a large skin tag is not necessarily an indication of success in extraction of DNA.

1.8.11.2.3. Examination documentation shall be of sufficient detail so that an equally qualified analyst is provided enough information in the case notes so as to reach the same conclusion. In the case of hair, when a “human hair” conclusion is reached the notes shall include observations regarding scale type, medulla, coloring/pigment distribution and any other pertinent observations.

1.8.12. Crosslinker Procedure

1.8.12.1. Consumables (pipette tips, microtubes, columns, etc.) may be exposed in the crosslinker for 2 to 15 minutes before use in casework. Time in excess of 15 minutes shall have the approval of the Technical Leader documented in the case record.

1.8.12.2. The use of the crosslinker may reduce the presence of amplifiable DNA.

1.9. Records:

1.9.1. If a worksheet is utilized, the examination of sexual assault kits and suspect collection kits shall be recorded on an approved worksheet.

1.9.2. Results of testing of body fluids shall be recorded on the worksheets designed for that purpose, or alternatively be recorded in the case notes within the description of the item as long as all required controls are documented appropriately.

1.9.3. All photos and electronically created documentation shall be stored as part of the case record. See Appendix 9 for instructions.

1.9.4. The technical review of the case record shall be recorded on the worksheet provided for that purpose.

1.10. Interpretations of Results:

1.10.1. The quality and quantity of a sample shall determine which tests are performed. Conclusions reached are based on the actual tests performed in each case. See specific tests for interpretation guidelines.

1.10.2. The analyst shall report out any identified body fluid stains present and list all items retained for possible DNA analysis in the report.

1.11. Report Writing General Rules for Serological Analysis:

1.11.1. Serology results shall be reported prior to any DNA results for each item.

1.11.2. Item numbers shall include all leading zeros.

1.11.3. Items shall be reported by item in order.

1.11.4. The description of each item in the results section shall not include the packaging.
1.11.5. Retention statements generally will be with the serological results for an item. For sexual assault kit results the retention statement may be included in the DNA results. If no serology results are being reported, the retention statement shall be the last statement of the results paragraph.

1.11.6. At a minimum, first and last name of victim(s) and/or suspect(s) shall be used throughout the entire report.

1.11.7. The significant contents of an item shall be listed in the report unless accounted for in the item description.

1.11.8. Reports shall be typed into a word document with specific formatting.
   1.11.8.1. A hanging indent shall be used set at 0 and a margin will be used, set at 1.5 (see below).

   Item 001 Evidence collection kit - Helen Jones: Items 001A through 001K1 were present or prepared from items within the kit. The kit will be returned to the submitting agency.
   Item 001A Blood standard: A stain card was prepared and retained as item 001A1. The blood standard was returned to item 001.
   Item 001A1 The DNA profile developed from the stain card was used for comparison purposes.
   Item 001B Vaginal wash: No seminal material was detected. The vaginal wash tube was returned to item 001.
   Item 001C Vaginal/cervical swabs: Two swabs, 001C1 and 001C2 were present. Amylase was detected. Serological testing

1.11.8.2. Original items and their description will be bolded. All other information shall be in normal Verdana 12.

1.11.9. Similar results with an item may be grouped together. Multiple results from an item/subitem may be reported in order of importance.

1.11.10. The number of items within an item should be listed with the item (i.e. Four swabs were present or Three samples were retained).

1.11.11. The trace paragraph, request for additional standards, pending DNA analysis paragraph and evidence disposition statement shall be after all reported results when appropriate.

1.11.12. See Appendix 7 for wording examples.

1.12. References:


2. DNA METHODS:

2.1. Scope: This test method is designed for the guidance of Laboratory personnel who assist investigations where the specificity of DNA testing is needed. Evidence amenable to DNA testing includes blood, seminal fluid, saliva, bone, tissue and hair. This manual may be expanded or altered as new techniques and/or genetic systems are found applicable.

2.1.1. The DNA is first extracted from the biological sample, quantified, amplified to produce many fluorescently tagged copies of specific regions of the DNA and finally processed to separate and detect a DNA profile(s). The analyst compares the DNA profile identified in the sample with the DNA profile from a reference standard from an individual to determine similarities or dissimilarities. In addition, the analyst may provide likelihood ratio statistic to give weight to the strength of an inclusion or exclusion.

2.1.2. Return of Evidence

2.1.2.1. Stain cards from whole blood samples, cuttings from body fluid stains, appropriate DNA extracts, and other selected DNA evidence may be retained by the laboratory for any possible future testing. For amplified DNA see 2.8.1.2.7. For subitems and extracts see flow charts.

2.1.2.2. The retained items may be released at the prosecutor’s request. The request shall be documented in the case record. A valid court order shall circumvent this procedure.

2.2. Precautions/Limitations:

2.2.1. Evidence

2.2.1.1. Liquid items such as blood standards shall be refrigerated.

2.2.1.2. Stains which are still moist shall be air dried in a secure area before submission to the Laboratory.

2.2.1.3. Clean paper or cardboard containers shall be used to package dried evidence. Plastic containers shall not be used for packaging because they hold moisture which often leads to putrefaction of biological materials. Exceptions to this rule would include blood tubes, body tissue samples and condoms.

2.2.1.4. Specific examinations performed on items for DNA analysis shall be determined by laboratory personnel.

2.3. Related Information:

2.3.1. Worksheet Manual

2.3.2. Appendix 6 PowerPlex® Fusion 6C Stutter Table

2.4. Instruments:

2.4.1. Applied Biosystems® 3500 Genetic Analyzer Capillary Electrophoresis Instrument – Simultaneously separates and detects multiple amplified DNA samples by size by capillary electrophoresis using fluorescent tagged primers.

2.4.2. Applied Biosystems® 7500 Real Time PCR System – Measures accumulation of amplification product over time to determine total DNA present by the use of a fluorescent reporter molecule.

2.4.3. Autoclave - An instrument that uses heat and steam to sterilize solutions, contaminated equipment and waste.

2.4.4. Balance - An analytical balance used for preparation of analytical reagents and buffers.
2.4.5. **BIOMEK NX® Automation Platform** – Robotic liquid handling system.

2.4.6. **BIOMEK 3000 Automation Platform** – Robotic liquid handling system.

2.4.7. **Centrifuges** - A microcentrifuge capable of operating at greater than 15,000 rcf and a clinical serofuge capable of operating at a maximum of 3,400 rpm; used for the purification of DNA in evidence samples and the separation of solid components from liquids, respectively.

2.4.8. **Crosslinker** - Preprogrammed ultraviolet exposure is factory set to 120,000 microjoules per cm². Preset ultraviolet time exposure is factory set to 2 minutes.

2.4.9. **Laminar Flow Hood** – An air purifying biohazard cabinet that maintains a nominal inflow velocity of 80 fpm which prevents contaminants from entering or escaping the work area.

2.4.10. **Maxwell® 16** – Robotic extraction system.

2.4.11. **Microscope** - A light microscope with magnification up to 400X, a stereoscope for general screening of items, and a phase contrast microscope for the identification of spermatozoa.

2.4.12. **Miscellaneous Laboratory Equipment** - Supportive laboratory equipment including ovens, incubators, pipettors, rotators, stirring/heating plates, vortex mixers, vacuum pumps, UV lights, and refrigerators/freezers for storing of reagents, buffers and evidence.

2.4.13. **pH Meter** – An instrument capable of manual or automatic temperature compensation and reading +/- 0.01 pH units. Used for preparation of buffers and reagents.

2.4.14. **Thermal cycler** - An instrument that can be programmed to rapidly cycle between high and low temperatures. This process is used to make many fluorescently tagged copies of specific regions on a DNA strand(s).

2.4.15. **Water Purification System** - An apparatus that routes water through a series of filtering devices to produce high quality, uncontaminated water used in buffer preparation and DNA typing methods.

2.5. **Reagents/Materials: See Reagent Preparation Manual for instructions and logs where appropriate.** Reagents critical to the DNA analysis process are listed in the Critical Reagent Manual.

2.5.1. Bone Demineralization Buffer
2.5.2. Digest/Wash Buffer
2.5.3. DTT 0.39M
2.5.4. DTT 1M
2.5.5. EDTA 0.5M
2.5.6. Nuclease Free Water (NFH₂O)
2.5.7. Phenol/Chloroform/Isoamyl Alcohol
2.5.8. Proteinase K (Pro K) 10 mg/ml
2.5.9. Proteinase K (Pro K) 18 mg/ml
2.5.10. Proteinase K (Pro K) 20mg/ml
2.5.11. Sarkosyl 20% w/v
2.5.12. SDS 20% w/v
2.5.13. Stain Extraction Buffer Stock Solution
2.5.14. Stain Extraction Buffer with DTT
2.5.15. Stain Extraction Buffer for Automation
2.5.16. TE⁻¹
2.5.17. TRIS/EDTA/NaCl Solution
2.5.18. TRIS-HCl pH 7.5, 1M
2.5.19. TRIS-HCl pH 8.0, 1M
2.6. Hazards/Safety:

2.6.1. All chemicals shall be handled in a safe method as referenced in the specific Safety Data Sheets (SDS).

2.6.2. The addition of phenol/chloroform/isoamyl alcohol during extraction, vortexing of the extracts, and transfer to Microcon® shall be performed in a chemical fume hood.

2.6.3. The manual preparation of samples for electrophoresis by the addition of Hi-Di™ formamide shall be confined to a chemical fume hood. **Caution:** Formamide is an irritant and teratogen; therefore universal precautions and a fume hood shall be utilized when manually working with formamide to avoid inhalation and contact with the skin.

2.6.4. The manual handling of lysis buffer should be confined to a chemical fume hood.

2.6.5. Universal Precautions shall be in use whenever biological materials are being handled.

2.6.6. Extreme caution shall be used when handling liquid body fluid samples.

2.6.7. Biological waste shall be disposed of in the appropriate waste receptacle.

2.7. Reference Materials/Controls/Calibration Checks:

2.7.1. The accuracy and specificity of test results are ensured by running known DNA controls and reagent controls at the same time as evidence samples. See the specific test for the appropriate controls to be run and the interpretation of the results.

2.8. Procedures/Instructions:

2.8.1. Examination Procedure

2.8.1.1. **Standards for Comparison**

2.8.1.1.1. Appropriate standards, preferably whole blood or buccal swabs, from individuals involved, should be submitted along with the questioned materials.

2.8.1.1.2. Whole blood standards should be submitted in a purple top tube that contains ethylene-diamine-tetra-acetic acid (EDTA). This tube shall be refrigerated.

2.8.1.1.3. Alternately a swabbing taken from the inside cheek of an individual may be collected, dried, and placed in a sealed envelope to be used as a standard.

2.8.1.1.4. When supplied, a secondary standard shall be clearly marked as such and treated as a standard.

2.8.1.2. **DNA Analysis**

2.8.1.2.1. All extracts are considered work product. Extracts should only be retained if needed for Y-STR analysis or if from an unknown item in a crimes against a person case where the original, retained subitem has been consumed. Retained extract tubes shall be labeled with the case number and unique sample designation and shall be sealed within a zip lock bag or plastic sleeve, keeping different samples separated by heat sealing or in separate bags. The extracts shall be maintained for long term storage within the original item or subitem. Extraction controls for those associated samples shall also be retained in separate compartments or bags within the item or subitem(s). All other extracts shall be discarded. See flow charts.
2.8.1.2.1.1. Evidence collection kit samples (where a male suspect is indicated) that demonstrate no amplifiable male DNA shall be returned, and their extracts shall be discarded.

2.8.1.2.1.2. Once any Y-STR analysis is complete, associated sample extract(s) may be discarded unless the original subitem was consumed.

2.8.1.2.2. If more than one swab from an area/stain is present within an item the analyst must indicate whether a single swab, multiple swabs or a combined sample of two or more swabs are being analyzed in the case notes. Combined samples in which not all samples within the item were combined shall be tracked in the case notes by a unique identifier.

2.8.1.2.3. When multiple samples have been retained from one item, the analyst can limit the number of samples per item to be extracted. A representative sample shall be tested initially. On an initial examination, 5 samples per piece of clothing or bedding should be sufficient to be extracted. Additional samples may be extracted as necessary.

2.8.1.2.4. Sexual Assault kits: Four to six samples/body areas may be chosen for the first tier of analysis based on the priority list below. If foreign allele at eight or more loci are not obtained from first tier testing, the remaining samples present in the kit shall be tested in a second tier of testing. Analysts may choose to test all samples in the first tier. Not testing additional samples if no informative results are obtained requires permission of a supervisor with documentation in the case record.

2.8.1.2.4.1. If the kit contains the following samples, these samples shall be selected for testing utilizing differential extraction methods:

   2.8.1.2.4.1.1. Either vaginal/cervical swabs or vaginal wash
   2.8.1.2.4.1.2. Anal/rectal swabs
   2.8.1.2.4.1.3. External genital swabs

2.8.1.2.4.2. Additional samples shall be chosen based on the following suggested priority list developed based on internal studies of success rates by sample type. Selection of samples is dependent on case information provided and other samples that are present in the kit or already being tested.

   2.8.1.2.4.2.1. Breast swabs
   2.8.1.2.4.2.2. Dried secretions/bitemark swabs (including other body area swabs)
   2.8.1.2.4.2.3. Internal genital swabs
   2.8.1.2.4.2.4. Underwear
   2.8.1.2.4.2.5. Speculum swabs
   2.8.1.2.4.2.6. Bra
   2.8.1.2.4.2.7. Oral swabs

2.8.1.2.4.3. Differential extractions should be performed on samples considered intimate or most likely to contain seminal material (e.g., vaginal/cervical swabs, anal swabs, internal genital swabs or external genital swabs.) If a sample is selected that is likely targeting skin...
cells and not seminal material (e.g., dried secretions/bitemark swabs or fingernail scrapings), the analyst may choose to perform a regular extraction.

2.8.1.2.4.3.1. The analyst may choose to perform a regular extraction for any samples tested as part of a second tier of analysis (as directed above), regardless of sample type.

2.8.1.2.4.4. Up to four swabs from each selected envelope/body area shall be combined for extraction and evaluated for the presence of male DNA. The combined amount of swabs shall not exceed the volume equivalent of one swab. Representative areas from underwear shall be extracted as one extract.

2.8.1.2.4.5. Smear slides, fingernail scrapings, debris, hairs, clothing other than undergarments and other items not listed above are never required but may be extracted at analyst’s discretion, depending on the contents and results of other items in a kit.

2.8.1.2.5. A quantification procedure shall be performed to estimate the quantity of extracted DNA, human and male.

2.8.1.2.5.1. In a sexual assault case, if there are no informative autosomal STR results, samples with male DNA at \( \geq 0.003 \, \text{ng/\mu l} \) shall be retained and a Y-STR analysis case shall be created.

2.8.1.2.6. In order to be used in a comparison with evidentiary samples, any standard (primary or secondary) shall demonstrate a single source profile. Any exception to this rule shall only be made with the approval of the Technical Leader and documented in the case record.

2.8.1.2.7. A portion of the amplified DNA is removed and used in the typing method. The remaining amplified DNA, considered work product, shall be destroyed after the case has been administratively reviewed.

2.8.1.2.8. The amount of sample available for testing, the recoverability of DNA from the sample, and the quality of the DNA shall affect which tests are performed. The conclusions reached are based upon the analysis performed.

2.8.1.3. General Rules

2.8.1.3.1. If one sample/cutting has a quantity of DNA that would require concentration and another sample/cutting from the same item has an appropriate quantity for analysis without additional treatment; it shall be left to the analyst’s discretion as to whether or not both samples, or just the one sample will be typed.

2.8.1.3.2. Multiple reagent blanks (RB) may be extracted as part of a sample batch. Any samples proceeding for additional testing such as Y-STR analysis should have more than one reagent blank. All reagent blanks shall at a minimum be carried through quantification. Amplification shall be performed on the reagent blank demonstrating the highest small autosomal quantification value. If no small autosomal value is detected, the highest large autosomal or Y value shall be analyzed. One reagent blank may be reserved without additional treatment to be used with those samples in the batch not requiring additional treatment. A
batch is defined as all samples before a reagent blank(s) with no intervening reagent blanks.

2.8.1.3.3. Any additional treatment to a sample shall be done to the corresponding reagent blank. This would include but not be limited to additional Microcon® purifications, use of Centri-sep columns, amplifying more than 5 µl, or increased injection parameters. Reagent blanks shall not be diluted unless performed during the Biomek robotic processing of samples.

2.8.1.3.4. The extraction of unknown and reference samples shall be performed separately (separated by time and/or space). This shall include a separate reagent blank for reference and unknown samples and, when practical, use of separate extraction worksheets, separate columns of the same extraction worksheet, or clear indication of which samples are unknown and which are references.

2.8.1.3.5. Extraction and typing of background samples is often not beneficial, and is therefore not required, but may be done at the discretion of the DNA analyst to aid in the interpretation of case sample results. If a background sample is extracted it shall be typed if DNA was detected during the quantification step. The background sample shall be concentrated only if the sample it is the background for is concentrated.

2.8.2. Crosslinker Procedure

2.8.2.1. Consumables (pipette tips, microtubes, columns, etc.) may be exposed in the crosslinker for 2 to 15 minutes before use in casework. Time in excess of 15 minutes shall have the approval of the Technical Leader documented in the case record.

2.8.2.2. The use of the crosslinker may reduce the presence of amplifiable DNA.

2.8.3. Sampling Protocols

2.8.3.1. Sample size may vary from indicated values depending on many factors including but not limited to total sample available and serology test results.

2.8.3.2. The analyst shall consume only as much of the available sample as is needed. Normally not more than half of the available sample will be used for testing. If it is necessary to consume an entire sample in testing or an amount such that the remaining portion is insufficient for additional testing, the analyst shall first receive permission from the prosecutor or investigator and document such in the case record. This may be done at the time of submission.

2.8.3.3. Sampling for Regular Extraction

2.8.3.3.1. Blood: Sample approximately 3 X 3 mm from a blood stain or 3 µl of whole blood.

2.8.3.3.2. Envelope: Sample approximately 1 X 1 cm of a gummed envelope flap or stamp. Cut sample into smaller pieces before placing in extraction tube. Alternatively, may swab gummed area or wash with three 50 µl rinses and place each rinse into the extraction tube.

2.8.3.3.3. Cigarette: Sample ½ to all of paper approximately 5 mm down from end or ½ of the paper and filter approximately 5 mm down. Filter not to be used when extracting with Maxwell® 16. Cut sample into smaller pieces before placing in extraction tube.
2.8.3.3.4. **Epithelial Swabs:** Sample from 1/4 to entire swab used to collect epithelial cells. For automated extractions, the total sample addition should not exceed the equivalent of one swab and the reagent volume shall not be adjusted/increased.

2.8.3.3.4.1. For swabs from a sexual assault kit, samples from multiple swabs may be combined into one tube with the total sample not to exceed the equivalent of one swab.

2.8.3.3.5. **Hair:** Rinse root end of hair in 100% ethanol and then dH₂O before sampling 1 cm of root end. If desired a second 1 cm of hair may be extracted separately as a sample blank.

2.8.3.3.6. **Tissue:** Cut a piece of tissue approximately 3 X 3 mm. If tissue is immersed in liquid nitrogen, it shall also be crushed into a fine powder. Transfer the sample to a microcentrifuge tube. Larger samples than indicated may be used, as needed, with the amounts of stain extraction buffer with DTT and Pro K increased proportionally.

2.8.3.3.7. **Combining extracts:**

2.8.3.3.7.1. Two or more swabs/samples may be extracted in separate extraction tubes, when using an organic extraction, combining at step 2.8.9.2. Multiple completed automation extracts may be combined before concentrating at step 2.8.9.2. The number and volume of the associated RBs shall be the same as the samples.

2.8.3.4. **Sampling for Semen (Differential Extraction)**

2.8.3.4.1. **Swabs:** A sample from at least one swab contained in an envelope shall be taken and combined into one tube. Samples from multiple swabs may be placed in one tube with the total sample not to exceed the equivalent of one swab.

2.8.3.4.2. **Clothing:** Sample approximately a 5 X 5 mm cutting.

2.8.3.4.3. **Smear Slides:** Use a moistened swab and swab entire smear, including underside of coverslip. Sample swab as above.

2.8.3.4.4. **Vaginal Wash:** Spin down vaginal wash and collect pellet on one or more swabs. Sample swab(s) as above.

2.8.3.5. **Bone and Teeth**

2.8.3.5.1. Sample cleaning/preparation methods (e.g., scraping, heating, etc.) that best address the variability of sample quality may be used as necessary.

2.8.3.5.2. Remove and separate any soft tissue adhering to sample with a sterilized scalpel or other appropriate tool.

2.8.3.5.3. Immerse and agitate at least 1 cubic inch of bone in cold distilled water.

2.8.3.5.3.1. A small brush or toothbrush may be used to gently remove any dirt/debris from the outer surfaces and exposed inner surfaces of sample.

2.8.3.5.3.2. Small bone samples with difficult-to-reach surfaces may be cleaned by sealing the sample in a 50 ml conical tube containing distilled water, then vortexing briefly, changing out the solution, and repeating as necessary.

2.8.3.5.3.3. If necessary, the specimen can be further cleaned by immersion in ethanol and ethyl ether for about 15 minutes each.
2.8.3.5.3.4. If surface staining is present, it is recommended to remove the outer table of bone by scraping or sanding.

2.8.3.5.4. Rinse sample in distilled water and allow the sample to dry.

2.8.3.5.5. Pulverize sample into a fine powder by manual mechanical crushing or by use of a freezer/mill. Bone samples may require multiple freezing/crushing steps. Larger samples (e.g., bones and adult teeth) may need to be initially reduced in size to accommodate the method of pulverization. Note: any medical/dental/restorative work on a bone or tooth sample shall be removed prior to pulverization.

2.8.3.5.5.1. **Manual Mechanical Crushing with Tissue Pulverizer**

   2.8.3.5.5.1.1. Larger samples may initially need to be reduced to ~0.5 in. fragments or smaller to accommodate the physical size of the pulverizer.

   2.8.3.5.5.1.2. Crush bone sample using the pulverizer and mallet. Optionally, sample may be immersed in liquid nitrogen for ~1–10 minutes to aid in crushing.

2.8.3.5.5.2. **SPEX SamplePrep® 6770 Freezer/Mill**

   2.8.3.5.5.2.1. Sample must initially be reduced to ~0.25 in. fragments (width of a pencil eraser) or smaller to accommodate the requirements of the mill. Larger fragments will decrease pulverization efficiency and may damage the mill.

   2.8.3.5.5.2.2. Insert a sterilized blunt end cap into a sterilized grinding cylinder.

   2.8.3.5.5.2.3. Add the sample to the cylinder. Do not add sample in excess of 1/3 total volume of the cylinder.

   2.8.3.5.5.2.4. Insert a steel impactor into the cylinder and seal the cylinder with a sterilized flanged end cap.

   2.8.3.5.5.2.5. Slowly add liquid nitrogen to the freezer/mill until it reaches the fill mark. An initial amount of liquid nitrogen will quickly boil off as the tank cools. When the liquid settles, add additional liquid nitrogen up to the fill mark. Initial cooling of the instrument will consume ~4–5 L of liquid nitrogen, and each sample pulverization will require an additional ~1 L liquid nitrogen.

   2.8.3.5.5.2.5.1. Always handle liquid nitrogen containers or any item exposed to liquid nitrogen (including grinding cylinders) with cryogenic gloves.

   2.8.3.5.5.2.6. Load assembled sample vial into the freezer/mill chamber (blunt end first). Optionally, up to two additional samples may also be prepared in vials and placed in the pre-cooling chamber above the freezer/mill chamber.

   2.8.3.5.5.2.7. Close the freezer/mill and pulverize the sample using the following protocol: Cycles: 4, Pre-cooling: 10 min, Run: 2 min, Cool: 2 min, CPS (cycles per second): 10. Regularly check the control panel on the freezer/mill to ensure that sufficient liquid nitrogen is remaining in the tank. If “LOW LN LEVEL” is displayed, pause the protocol by pressing “PAUSE”, open the freezer/mill, and add...
liquid nitrogen to the fill mark, then close the freezer/mill and resume the protocol.

2.8.3.5.2.8. When the program is complete, open freezer/mill and remove vial from freezer/mill chamber. To conserve liquid nitrogen, any subsequent samples should be immediately loaded into the mill and pulverized as described above. If additional samples were loaded in the pre-cooling chamber during the initial sample run, they may be pulverized with the following protocol (omitting the pre-cooling phase): Cycles: 4, Pre-cooling: 0 min, Run: 2 min, Cool: 2 min, CPS: 10.

2.8.3.5.2.9. Allow vial to warm up for ~5–10 minutes before using the cap extractor tool to open the vial. If the sample was “sticky” or “tacky” prior to pulverization, it may be necessary to open the vial earlier to aid removal. Transfer the contents of the vial into a sterilized weigh boat and separate the impactor from the sample. A sterilized spatula may be used to aid sample removal.

2.8.3.5.6. Transfer the pulverized sample into one or more tubes. Manual mechanical crushing typically generates small sample fragments accompanied by some powder, while a freezer/mill typically converts an entire sample to a very fine powder.

2.8.3.5.7. For a regular organic extraction, fill one or more microcentrifuge tubes approximately halfway with bone or tooth powder. The amounts of extraction reagents may be increased proportionately as needed for a regular organic extraction. A sample size of approximately 0.5 grams of bone or tooth powder is recommended for the bone demineralization procedure.

2.8.4. Regular Organic Extraction With Microcon® Concentration Of All Sample Types Including Blood, Hair, Tissue And Bone. (Microcon® 100 or Fast Flow)

2.8.4.1. Place the sample in a 1.5 ml microcentrifuge tube or a Qiagen® Investigator® Lyse&Spin basket with 2 ml collection tube. Each group of samples being extracted shall include a reagent blank as the last sample in the batch.

2.8.4.2. To the sample add 300 µl of stain extraction buffer with DTT and 7.5 µl Proteinase K (Pro K) solution (10 mg/ml). Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid. Analyst may increase the amounts of stain extraction buffer with DTT and Pro K proportionally for larger samples. The same treatment shall be performed to any associated reagent blanks.

2.8.4.3. Incubate the tube at 56°C overnight (18 hours minimum/24 hours maximum). An extraction time of no less than 2 hours may be used for standards (blood or buccal swabs). A shortened extraction time may only be used with the approval of the Technical Leader (documented in case record) for any other sample types.

2.8.4.4. For samples lysed in a 1.5 ml microcentrifuge tube:

2.8.4.4.1. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube. For hairs, bones, or tissue it may be preferable to transfer supernatant to a clean microcentrifuge tube before proceeding to 2.8.4.6.

2.8.4.4.2. Using a wooden applicator stick, remove the cutting and proceed to 2.8.4.6 or
2.8.4.4.3. Transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Spin in a microcentrifuge at approximately 14,000 rcf (relative centrifugal force) for about 5 minutes. Remove and discard the basket insert.

2.8.4.5. For samples lysed in a Qiagen® Investigator® Lyse&Spin basket:

2.8.4.5.1. Spin in a microcentrifuge at 10,000 – 14,000 rcf for at least 1 minute. Remove and discard the basket insert.

2.8.4.6. In a fume hood, add 300 µl of phenol/chloroform/isoamyl alcohol to which buffer has been added (p/c/i) to the stain extract and vortex the mixture at low speed (in the fume hood) to attain a milky emulsion.

2.8.4.7. Spin in a microcentrifuge until completely separated (for at least 3 minutes) at approximately 14,000 rcf. Multiple p/c/i extractions may be performed to further clean up an extract if desired. If larger volumes are used in step 2.8.4.2, equivalent volumes of p/c/i shall be used. The same treatment shall be performed to any associated reagent blanks.

2.8.4.8. See 2.8.9 for Microcon® procedure.

2.8.5. Demineralization and Organic Extraction of Bone Samples with Amicon® Ultra-4 30 kDa Concentration

2.8.5.1. Place the sample in a 50 ml conical or other appropriately sized container. Each group of samples being extracted shall include a reagent blank as the last sample in the batch.

2.8.5.2. To the sample add 4.5 ml of bone extraction buffer and 300 µl Proteinase K (Pro K) solution (20 mg/ml). Vortex and spin briefly to force the sample into the extraction fluid. The same treatment shall be performed to any associated reagent blanks.

2.8.5.3. Incubate the samples in an orbital shaker at 56°C and 150 rpm overnight (18 hours minimum/24 hours maximum). A shortened extraction time may only be used with the approval of the Technical Leader (documented in case record).

2.8.5.4. Spin samples briefly at high speed. It may be preferable to transfer supernatant to a clean tube before proceeding to 2.8.5.5.

2.8.5.5. In a fume hood, add an equal volume of phenol/chloroform/isoamyl alcohol to which buffer has been added (p/c/i) to the extract and vortex the mixture (in the fume hood) to attain a milky emulsion.

2.8.5.6. Spin in a centrifuge until completely separated (for about 5 minutes at maximum speed).

2.8.5.7. In a fume hood, transfer approximately half of the aqueous layer to an Amicon® Ultra-4 30 kDa column (do not UV crosslink Amicon® Ultra-4 columns).

2.8.5.8. Place the Amicon® Ultra-4 columns in the centrifuge with one filter facing the outer wall. Centrifuge samples at max speed (up to 7500 x g (rcf) on a fixed angle rotor). Continue spinning until approximately 250 µl of sample remains.

2.8.5.8.1. Note: Do not allow columns to become completely dry. Spin times may be adjusted per sample to address variability.

2.8.5.9. In a fume hood, discard the flow through and add the remaining aqueous layer to the column.

2.8.5.10. Repeat 2.8.5.8 until approximately 250 µl of sample remains. Discard the flow through.
2.8.5.11. Wash sample with 2 ml of nuclease free water. Spin (maintaining column orientation) at max speed until approximately 100 µl of sample remains.

2.8.5.12. Transfer the sample to a clean microcentrifuge tube.

2.8.5.13. Wash the column with an additional 100 µl of nuclease free water by pipetting up and down. Combine with extract.

2.8.5.14. Store at 4°C or proceed to QIAquick® purification.

2.8.6. QIAquick® Purification for Bone Samples

2.8.6.1. QIAquick® purification may be performed at any time. The same treatment shall be performed on the associated reagent blank (or a portion of) for each sample batch.

2.8.6.2. Optionally, UV crosslink columns for 15 minutes.

2.8.6.3. Add 5 volumes of Buffer PB to 1 volume of sample (example for 200 µl of sample add 1000 µl Buffer PB). Place up to 750 µl into the spin column.

2.8.6.4. Spin 30 seconds at 17,900 x g (rcf); 13,000 rpm. If liquid remains in column, spin another 30 seconds.

2.8.6.5. Discard the flow through.

2.8.6.6. Repeat until all sample has been applied to the column.

2.8.6.7. Wash the sample by adding 750 µl of Buffer PE.

2.8.6.8. Spin 30 seconds at 17,900 x g (rcf); 13,000 rpm. If liquid remains in column, spin another 30 seconds.

2.8.6.9. Discard the flow through.

2.8.6.10. Spin 1 minute at 17,900 x g (rcf); 13,000 rpm.

2.8.6.11. Place the column into a clean microcentrifuge tube (not provided in kit). To elute DNA, add 100 µl Buffer EB to the center of the membrane and let stand at least 1 minute.

2.8.6.12. Spin 1 minute at 17,900 x g (rcf); 13,000 rpm. Discard the column.

2.8.6.13. Extracts can be stored refrigerated or frozen prior to quantification/amplification. Prior to use after storage, the samples shall be vortexed and spun briefly in a microcentrifuge.

2.8.7. Differential Organic Extraction With Microcon® Concentration Of Semen Stains (Microcon® 100 or Fast Flow)

2.8.7.1. Place the sample in a 1.5 ml microcentrifuge tube. Qiagen® Investigator® Lyse&Spin baskets shall not be used for differential extractions. Each group of samples being extracted shall include reagent blanks (sperm and non-sperm fraction) as the last samples in the batch.

2.8.7.2. To the sample add:
   - 400 µl Tris/EDTA/NaCl
   - 25 µl 20% Sarkosyl
   - 75 µl NFH$_2$O
   - 5 µl Pro K (10 mg/ml)

2.8.7.3. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid.

2.8.7.4. Incubate at 37°C for 2 hours.
2.8.7.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube.

2.8.7.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge for about 5 minutes at approximately 14,000 rcf.

2.8.7.7. Alternately transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Spin in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the basket insert.

2.8.7.8. While being very careful to not disturb any pelleted material, remove the supernatant fluid from the extract and place it into a new, labeled tube. This supernatant is the non-sperm fraction. Analysis of the non-sperm fraction resumes at 2.8.7.15. The pellet remaining in the tube is the sperm fraction.

2.8.7.9. Wash the sperm pellet by resuspending it in 500 µl digest/wash buffer, vortexing the suspension briefly, and spinning the tube in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the supernatant fluid, being careful not to disturb the pellet.

2.8.7.10. Repeat 2.8.7.9 two additional times for a total of three washes of the sperm pellet.

2.8.7.11. To the tube containing the washed pellet add:
- 150 µl Tris/EDTA/NaCl
- 50 µl 20% Sarkosyl
- 150 µl NFH₂O
- 10 µl Pro K (10 mg/ml)
- 40 µl 0.39M DTT

2.8.7.12. Close the tube cap, vortex and spin briefly in a microcentrifuge to force all fluid and material to the bottom of the tube.

2.8.7.13. Incubate at 37°C for 2 hours.

2.8.7.14. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube.

2.8.7.15. In the fume hood, add 400 µl phenol/chloroform/isoamyl alcohol to which buffer has been added (p/c/i) to both the tube containing the sperm pellet and to the tube containing the non-sperm fraction. Vortex the mixture briefly at low speed (in the fume hood) to attain a milky emulsion.

2.8.7.16. Spin in a microcentrifuge until completely separated (for at least 3 minutes) at approximately 14,000 rcf. Multiple p/c/i extractions may be performed to further clean up an extract if desired. The same treatment shall be performed to any associated reagent blanks.

2.8.7.17. See 2.8.9 for Microcon® procedure.

2.8.8. QIAcube® Workstation Differential Extraction

2.8.8.1. For each sample, combine 240 µl Tris/EDTA/NaCl, 6 µl 20% Sarkosyl, 54 µl NFH₂O and 3 µl Proteinase K (10 mg/ml). Example: for 16 samples, combine 3840 µl Tris/EDTA/NaCl, 96 µl 20% Sarkosyl, 864 µl NFH₂O, and 48 µl Pro K.

2.8.8.2. Place each sample in a 1.5 ml microcentrifuge tube. Each group of samples being extracted shall include reagent blanks (sperm and non-sperm fraction) as the last samples in the batch.

2.8.8.2.1. For differential fractionation on the QIAcube® workstation, samples shall be loaded specifically into properly labelled QIAGEN 1.5 ml tubes.
2.8.8.3. To the sample add 300 µl of the Master Mix. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid.

2.8.8.4. Incubate the sample at 37°C for 2 hours.

2.8.8.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube.

2.8.8.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge for about 5 minutes at approximately 14,000 rcf.

2.8.8.7. Alternately transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Spin in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the basket insert.

2.8.8.8. Place the 1.5 ml tube containing the sample in Position L3 of the QIAcube® rotor adapter with cap open and flipped into holder. Place the rotor adapter with sample into the appropriate position on the QIAcube® centrifuge.

2.8.8.9. Prepare lysis buffer master mix with the volumes of Lysis buffer and 1M DTT indicated below:

<table>
<thead>
<tr>
<th># Samples</th>
<th>Lysis buffer (µl)</th>
<th>1 M DTT (µl)</th>
<th>Buffer Bottle 2 (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>4250</td>
<td>43</td>
<td>3850</td>
</tr>
<tr>
<td>3</td>
<td>4880</td>
<td>49</td>
<td>4280</td>
</tr>
<tr>
<td>4</td>
<td>5110</td>
<td>52</td>
<td>4710</td>
</tr>
<tr>
<td>5</td>
<td>6255</td>
<td>63</td>
<td>5255</td>
</tr>
<tr>
<td>6</td>
<td>6885</td>
<td>69</td>
<td>5685</td>
</tr>
<tr>
<td>7</td>
<td>7515</td>
<td>76</td>
<td>6115</td>
</tr>
<tr>
<td>8</td>
<td>8145</td>
<td>82</td>
<td>6545</td>
</tr>
<tr>
<td>9</td>
<td>8775</td>
<td>88</td>
<td>6975</td>
</tr>
<tr>
<td>10</td>
<td>9520</td>
<td>96</td>
<td>7520</td>
</tr>
<tr>
<td>12</td>
<td>10800</td>
<td>110</td>
<td>8400</td>
</tr>
</tbody>
</table>

2.8.8.10. Place 200 µl of lysis buffer master mix into labelled 2 ml tubes and place them in the appropriate location in the QIAcube® shaker. Add the appropriate amount of Lysis Buffer master mix to a 30 ml reservoir bottle (Buffer Bottle 2) as indicated above and load onto the QIAcube® instrument at Reagent Bottle Rack Position 2.

2.8.8.11. Fill both tip racks with QIAGEN® “Disposable Filter-Tips, 1000 µl, wide bore.”

2.8.8.12. Add Digest Wash buffer to a 30 ml reservoir bottle and place in the QIAcube® deck at Reagent Bottle Rack Position 1 as follows:

<table>
<thead>
<tr>
<th># Samples</th>
<th>Digest Wash Buffer (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>6620</td>
</tr>
<tr>
<td>3</td>
<td>8680</td>
</tr>
<tr>
<td>4</td>
<td>10740</td>
</tr>
<tr>
<td>5</td>
<td>12800</td>
</tr>
<tr>
<td>6</td>
<td>14860</td>
</tr>
<tr>
<td>7</td>
<td>16920</td>
</tr>
<tr>
<td>8</td>
<td>18980</td>
</tr>
<tr>
<td>9</td>
<td>21040</td>
</tr>
</tbody>
</table>
2.8.8.13. For ≤ 6 samples, run “Custom Separate + Lyse 6” protocol.


2.8.8.15. When the final protocol is finished, remove samples from QIAcube®.

2.8.8.16. For automation processing, transfer samples into 1.5ml Click-Fit tubes and proceed to step 5.8.2.2.12.

2.8.8.17. For Maxwell 16 processing, continue to step 2.8.11.3.

2.8.9. Microcon® Concentration Of Extracted DNA (Microcon® 100 or Fast Flow)

2.8.9.1. To a Microcon® Concentrator add 100 µl TE^-4.

2.8.9.2. For Microcon® concentration immediately after organic extraction, transfer the aqueous phase (top layer) to the concentrator in the fume hood. Avoid pipetting organic solvent from the tube into the concentrator. For Microcon® concentration of other DNA extracts, transfer the extract(s) to the concentrator.

2.8.9.3. Close the cap on the concentrator and spin in a microcentrifuge at 500 rcf for at least 10 minutes. Microcon® 100 may be spun up to 1,200 rcf.

2.8.9.4. Optional Step: Carefully remove the concentrator unit from the assembly and discard the fluid from the filtrate cup. Return the concentrator to the top of the filtrate cup.

2.8.9.5. Remove the cap and add 200 µl nuclease free water (NFH₂O) or TE^-4 to the concentrator. Replace the cap and spin the assembly in a microcentrifuge at 500 rcf for at least 10 minutes. Microcon® 100 may be spun up to 1,200 rcf.

2.8.9.6. Remove the cap and add a measured volume of NFH₂O or TE^-4 (40 µl is the recommended amount however, varied amounts can be added in some circumstances) to the concentrator. Remove the concentrator from the filtrate cup and carefully invert the concentrator into a new, labeled retentate cup. Discard the filtrate cup.

2.8.9.7. Spin the concentrator in a microcentrifuge at 1,000 rcf for at least 3 minutes. The Microcon® 100 should be spun 500-1,200 rcf for at least 5 minutes.

2.8.9.8. Discard the concentrator. If desired, the sample can be brought up with additional water by adding it to the retentate cup. Cap the retentate cup.

2.8.9.9. Extracts can be stored refrigerated or frozen prior to quantification/amplification. Prior to use after storage the samples shall be vortexed and spun briefly in a microcentrifuge.

2.8.9.10. Multiple Microcon® concentration steps may be performed to further clean up or concentrate any extract. The same treatment shall be performed on the associated reagent blank (or a portion of) for each sample batch.

2.8.10. Centri-sep Clean-Up Of Extracts

2.8.10.1. Clean-up of extracts with Centri-sep columns may be performed at any time. The same treatment shall be performed on the associated reagent blank (or a portion of) for each sample batch.
2.8.10.2. Remove the top column cap and reconstitute the column by adding 800 μl of nuclease free water (NFH$_2$O). Leave the column end stopper in place so the column can stand up by itself. Replace the column cap and hydrate the gel by shaking and inverting the column or vortexing briefly.

2.8.10.3. Allow the column to hydrate for at least 30 minutes at room temperature. Reconstituted columns may be refrigerated at 4°C overnight. Allow to warm up to room temperature before proceeding.

2.8.10.4. Remove the air bubbles from the column gel by inverting the column and sharply tapping the column, allowing the gel to slurry to the opposite end of the column. Stand the column up and allow the gel to settle while in a microtube rack.

2.8.10.5. First remove the column cap, and then remove the column end stopper from the bottom.

2.8.10.6. Allow the excess column fluid to drain into a 2 ml wash tube. If the fluid does not begin to flow immediately through the column apply gentle pressure to the top of the column to force the fluid to start through the column filter. This can be accomplished by snapping the cap on briefly. Discard this fluid.

2.8.10.7. Spin the column and wash tube in a microcentrifuge at 750 rcf for 2 minutes. **NOTE:** It is important to keep track of the position on the column using the orientation mark molded into the column.

2.8.10.8. Optionally: discard eluate and rinse column with 150-200 μl NFH$_2$O and spin for 2 minutes at 750 rcf.

2.8.10.9. Blot any drop at the end of the column. Discard the wash tube. Do not allow the gel material to dry excessively.

2.8.10.10. Transfer the sample extract to the top of the column, without disturbing the gel surface. Keep track of amount of sample added to column (less than 50 μl is recommended).

2.8.10.11. Place the column into the sample collection tube (1.5 ml) and place both into the microcentrifuge. The highest point of the gel media in the column should always point toward the outside of the rotor. Spin the column and the collection tube at 750 rcf for 2 minutes.

2.8.10.12. Discard the spin column and cap the sample collection tube.

2.8.10.13. Extracts can be stored refrigerated or frozen prior to quantification/amplification. Prior to use after storage, the samples shall be vortexed and spun briefly in a microcentrifuge.

2.8.11. Maxwell® 16 Protocol

2.8.11.1. **Maxwell® 16 Preparation of Samples For Any Cellular Material (except bone):**

2.8.11.1.1. For each sample, combine 350 μl Incubation Buffer with 10 μl Pro K (18 mg/ml) and 40 μl DTT (1M). Alternatively, Stain Extraction Buffer for Automation (SEBA) may be substituted for Incubation Buffer. **Example:** for 16 samples, combine 5,600 μl Incubation Buffer (or SEBA) with 160 μl Pro K and 640 μl DTT.

2.8.11.1.2. Place sample at the bottom of a 1.5 ml microcentrifuge tube or a Qiagen® Investigator® Lyse&Spin basket with 2 ml collection tube. Each group of samples being extracted shall include a reagent blank as the last sample in the batch.

2.8.11.1.3. To the sample add 400 μl Master Mix. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid.
2.8.11.1.4. Incubate the samples at 56°C for at least one hour. Alternatively, samples may be incubated overnight.

2.8.11.1.5. For samples lysed in a 1.5 ml microcentrifuge tube:

2.8.11.1.5.1. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube. (For hairs it may be preferable to transfer supernatant to a clean microcentrifuge tube before proceeding).

2.8.11.1.5.2. Add 200 µl of Lysis Buffer to each sample.

2.8.11.1.5.3. Vortex samples briefly and spin down.

2.8.11.1.5.4. Using a wooden applicator stick, remove the cutting and proceed to 2.8.11.1.7 or

2.8.11.1.5.5. Transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Optionally, the Lysis Buffer may also be transferred to the spin basket. Spin in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the basket insert.

2.8.11.1.6. For samples lysed in a Qiagen® Investigator® Lyse&Spin basket:

2.8.11.1.6.1. Spin in a microcentrifuge at 10,000 – 14,000 rcf for at least 1 minute. Remove and discard the basket insert.

2.8.11.1.6.2. Add 200 µl of Lysis Buffer to each sample.

2.8.11.1.7. Save the extract until ready for automated DNA extraction. Do not refrigerate or freeze sample. Leave processed sample at room temperature (~22-25°C) overnight, if necessary.

2.8.11.1.8. Proceed to 2.8.11.3 for Maxwell® 16 automated extraction.

2.8.11.2. Maxwell® 16 Preparation of Samples For Differential Extractions:

2.8.11.2.1. For each sample, combine 400 µl Tris/EDTA/NaCl, 10 µl 20% Sarkosyl, 90 µl NFH₂O and 5 µl Proteinase K (10 mg/ml).

2.8.11.2.2. Place the sample in a 1.5 ml microcentrifuge tube. Qiagen® Investigator® Lyse&Spin baskets shall not be used for differential extractions. Each group of samples being extracted shall include reagent blanks (sperm and non-sperm fraction) as the last samples in the batch.

2.8.11.2.3. To the sample add 505 µl of the Master Mix. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid.

2.8.11.2.4. Incubate the sample at 37°C for 2 hours.

2.8.11.2.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube.

2.8.11.2.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge for about 5 minutes at approximately 14,000 rcf.

2.8.11.2.7. Alternately transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Spin in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the basket insert.
2.8.11.2.8. While being very careful to not disturb any pelleted material, remove the supernatant fluid from the extract and place it into a new, labeled tube. This supernatant is the non-sperm fraction. Analysis of the non-sperm fraction resumes at 2.8.11.2.11. The pellet remaining in the tube is the sperm fraction.

2.8.11.2.9. Wash the sperm pellet by resuspending it in 500 µl digest/wash buffer, vortexing the suspension briefly, and spinning the tube in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the supernatant fluid, being careful not to disturb the pellet.

2.8.11.2.10. Repeat step 2.8.11.2.9 two times for a total of three washes of the sperm pellet.

2.8.11.2.11. Lysis buffer step

2.8.11.2.11.1. For each sample pair (sperm and non-sperm fraction) combine 600 µl of Lysis Buffer with 6 µl of 1M DTT.

2.8.11.2.11.2. Add 400 µl of the Lysis Buffer master mix to each sperm fraction sample and 200 µl to each non-sperm fraction sample.

2.8.11.2.12. Vortex sample and spin down briefly.

2.8.11.2.13. Save until ready for automated DNA extraction. Do not refrigerate or freeze sample. Leave processed sample at room temperature (~22-25°C) overnight, if necessary.

2.8.11.2.14. Proceed to 2.8.11.3 for Maxwell® 16 automated extraction.

2.8.11.3. Maxwell® 16 Instrument Automated DNA Purification:

2.8.11.3.1. Place the number of cartridges to be used into the cartridge preparation rack. Each cartridge corresponds to one sample. Place each cartridge into the rack. Hold the cartridge firmly and remove the seal.

2.8.11.3.2. Place one plunger into well #8 of each cartridge.

2.8.11.3.3. Transfer the entire sample into well #1.

2.8.11.3.4. Place 0.5 ml elution tubes (properly labeled) into the elution tube slot. Add 50 µl of Elution Buffer.

2.8.11.3.5. Turn on the Maxwell® 16 Instrument. Verify “LEV” and “FNSC” modes are displayed.

2.8.11.3.6. Scroll to “Run” on the Menu screen and press the “Run/Stop” button.

2.8.11.3.7. Open the door when prompted to do so on the LCD display. Press the “Run/Stop” button to extend the platform.

2.8.11.3.8. Place the cartridge rack into the Maxwell® 16 Instrument.

2.8.11.3.9. Press the “Run/Stop” button. The platform will retract. Close the door.

2.8.11.3.10. Upon method completion, open the instrument door. The plungers should be located in Well #8 at the end of the run. Check to make sure that all of the plungers have been removed from the magnetic rod assembly. If the plungers have not been removed, push them down gently by hand and remove them from the magnetic rod assembly.

2.8.11.3.11. Press the “Run/Stop” button to extend the platform.
2.8.11.3.12. Remove the elution tubes from the heated elution tube slots, as soon as possible and close the top on each tube. (Leaving the heated elution tubes in the instrument for an extended period of time can result in evaporation of the sample.) Samples can be stored at 4°C or frozen. Prior to use after storage, the samples shall be vortexed briefly and spun in a centrifuge for about 5 seconds.

2.8.11.3.13. Remove cartridges and plungers from the instrument platform and discard.

2.8.11.3.14. When completed, clean the Maxwell® 16 Instrument and cartridge rack with 70% ethanol and turn off machine.

2.8.12. Rehydration of a Sample after Storage

2.8.12.1. Evaluate the stored sample and associated reagent blank for approximate volume.

2.8.12.2. If enough liquid is present in the sample and the reagent blank they can be used for amplification.

2.8.11.3.1 The sample and reagent blank shall be quantified and treated as normal.

2.8.12.3. If the volume is low or none, determine if the sample and/or the reagent blank extract was concentrated and consumed or almost consumed from the case record.

2.8.12.3.1. If the reagent blank was concentrated and consumed after the issue of the 2009 DNA QAS audit document no further testing should be done.

2.8.12.3.2. If the case was completed before the issue of the 2009 DNA QAS audit document and the reagent blank was consumed consult with the Technical Leader about reagent blanks.

2.8.11.4 If the volume is low and the loss of volume is from dehydration, the sample can be rehydrated.

2.8.11.4.1 To the sample add 20-100 µl of nuclease free water.

2.8.11.4.2 Add nuclease free water to the reagent blank as needed. The volume added should not exceed the least amount added to any associated sample.

2.8.11.4.3 The final volume of the reagent blank should not exceed the volume of any associated sample.

2.8.11.4.4 If the reagent blank did not dehydrate, an additional reagent blank with the same volume of nuclease free water as added to the sample shall be created and tested with the sample.

2.8.11.4.5 Briefly vortex the samples.

2.8.11.4.6 Incubate at least 2 hours to 4 hours in a 56°C oven.

2.8.11.4.6.1 Briefly vortex after one hour and place back in oven for the remaining time.

2.8.11.4.7 Quantify the sample and reagent blanks after rehydration.

2.8.12. Quantifiler® Trio DNA Quantification

2.8.12.1 Introduction

2.8.12.1.1 The Applied Biosystems® Quantifiler® Trio DNA Quantification Kit utilizes multicopy target loci to simultaneously quantify an 80 bp small autosomal target (sm.
auto), a 214 bp large autosomal target (lg. auto), and a 75 bp male Y-chromosome target (Y) to enable estimation of the amount of human DNA, male DNA, and level of degradation. The Internal PCR Control (IPC) enables inhibitor detection in the sample extract prior to STR amplification.

2.8.12.1.2 Each assay target consists of PCR primers and TaqMan® probes labeled with both a reporter dye and non-fluorescent quencher. During PCR the TaqMan® probes anneal to a specific location between the targeted forward and reverse primers. Taq DNA polymerase cleaves the hybridized probes separating the reporter dye from the quencher, resulting in increased fluorescence.

2.8.12.1.3 The 7500 Real-Time PCR System measures the fluorescent signal of all four target reporter signals (VIC®, ABY®, FAM™, and JUN®) as well as a passive reference dye (Mustang Purple®) to help normalize the signal between samples. The signals for each sample are compared to that of a standard curve of known quantity to estimate DNA concentrations.

2.8.12.1.4 The Quantifiler® Trio kit shall be stored at -15 to -25°C upon receipt. All kit components shall be maintained together in the kit sleeve.

2.8.12.1.5 Allow the entire kit to thaw prior to first use after which all components shall be stored at 2 to 8°C.

2.8.12.1.6 The Quantifiler® Trio Primer Mix and the Quantifiler® THP PCR Reaction Mix shall be protected from excessive exposure to light.

2.8.12.1.7 The preparation of the quantification plate shall be performed in the PCR amplification set-up area.

2.8.12.2 Standard Curve Preparation (may be set up in the PCR Amplification set-up area)

2.8.12.2.1 Label four microcentrifuge tubes “Std 1” through “Std 4”.

2.8.12.2.2 Dispense the appropriate volume of Quantifiler® THP Dilution Buffer to each tube using the appropriate option from the table below.

2.8.12.2.3 Briefly vortex the Quantifiler® THP DNA Standard [100 ng/μl stock].

2.8.12.2.4 Add the calculated amount of Quantifiler® THP DNA Standard to the tube labeled “Std 1” and mix thoroughly.

2.8.12.2.5 Using a new pipette tip, add 4 μl of “Std 1” to “Std 2” and mix thoroughly.

2.8.12.2.6 Complete the dilution series by adding 4 μl of “Std 2” to “Std 3” and “Std 3 to “Std 4”, mix thoroughly and use a new pipette tip with each step.

2.8.12.2.7 The standard curve is stable for up to 2 weeks when stored at 2 to 8°C.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Concentration (ng/μl)</th>
<th>Dilution Buffer</th>
<th>DNA Standard</th>
<th>Dilution Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std 1</td>
<td>50</td>
<td>15 μl dilution buffer (Option 1)</td>
<td>15 μl DNA stock (Option 1)</td>
<td>2X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25 μl dilution buffer (Option 2)</td>
<td>25 μl DNA stock (Option 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>35 μl dilution buffer (Option 3)</td>
<td>35 μl DNA stock (Option 3)</td>
<td></td>
</tr>
<tr>
<td>Std 2</td>
<td>2.0</td>
<td>96 μl dilution buffer</td>
<td>4 μl Std 1</td>
<td>25X</td>
</tr>
<tr>
<td>Std 3</td>
<td>0.08</td>
<td>96 μl dilution buffer</td>
<td>4 μl Std 2</td>
<td>25X</td>
</tr>
</tbody>
</table>
2.8.12.3 Quantification Reaction Preparation

2.8.12.3.1 Each quantification plate shall contain a standard curve series run in duplicate in column 12 and a Non-Template Control (NTC) in well H11.

2.8.12.3.2 Determine the number of samples to be quantified, including standards and NTC, and add ~3 reactions to compensate for the loss that occurs during pipetting.

2.8.12.3.3 Using the Quantifiler® Trio Plate Record Worksheet, calculate the required amount of each component of the master mix.

<table>
<thead>
<tr>
<th>PCR Master Mix Component</th>
<th>Volume per Reaction (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Trio Primer Mix</td>
<td>8</td>
</tr>
<tr>
<td>Quantifiler® THP PCR Reaction Mix</td>
<td>10</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>18</strong></td>
</tr>
</tbody>
</table>

2.8.12.4 Quantification Experiment Setup

2.8.12.4.1 Turn on the computer.
2.8.12.4.2 Turn on the 7500 Real-Time PCR instrument.
2.8.12.4.3 Open the HID Real-Time PCR Analysis Software v1.2.
2.8.12.4.4 Select the **Quantifiler® Trio** icon on the Home screen.
2.8.12.4.5 Enter the experiment name: First case on plate_date_plate# (i.e. 00A1234_01Jan16_01).
2.8.12.4.6 Ensure the following experiment properties are selected:
Instrument: 7500 (96 Wells)
Experiment Type: Quantitation – HID Standard Curve
Reagents: TaqMan® Reagents
Ramp speed: Standard (~1 hours to complete a run)

2.8.12.4.7 Select Plate Setup from the left navigational panel.

2.8.12.4.8 Sample names may be entered manually or imported from a DNA Workbook into the HID Software. All samples shall be uniquely identified by case number and sample identifier.

2.8.12.4.8.1 Sample Name manual entry:
2.8.12.4.8.1.1 Select Add New Sample to enter each sample name.
2.8.12.4.8.1.2 Sample Type shall be designated as “Unknown” for casework samples.
2.8.12.4.8.1.3 Select the Assign Targets and Samples tab to enter the sample information into each well. Unused wells shall be left blank.
2.8.12.4.8.1.4 Verify that the standard curve and NTC information is correct.

2.8.12.4.8.2 Sample Name import:
2.8.12.4.8.2.1 In the DNA Workbook, navigate to the “Quant” tab, ensure that the sample information is filled out, and click Create Quant Import File. Copy the .txt file to the “IMPORT” folder on the 7500 Real-Time computer desktop.
2.8.12.4.8.2.2 In the HID Software, select File → Import, navigate to and select the .txt file that was created by the workbook.
2.8.12.4.8.2.3 The associated samples and standards will populate within their respective wells. Verify that the samples, standard curve, and NTC information is correct.

2.8.12.4.9 Assay targets, standard curve quantities, assay parameters, and export criteria are automatically assigned when using the Quantifiler® Trio template.

2.8.12.4.10 Save the plate document to the “CASEWORK” folder on the D: drive.

2.8.12.4.11 Click

2.8.12.4.12 The Quantifiler® Trio assay will take ~1 hour.

2.8.12.5 HID Real-Time PCR Analysis Software set-up See Appendix 2

2.8.12.6 Experiment Analysis
2.8.12.6.1 Analyze the experiment by clicking

2.8.12.6.2 Evaluate the slope, Y-intercept, and R² values of all three standard curves as described under 2.8.12.7 Interpretation Guidelines.

2.8.12.6.2.1 Up to 2 points from each curve may be deleted by right-clicking on the well, selecting omit, and selecting the appropriate target(s) or well. The results must be reanalyzed to incorporate the changes.
2.8.12.6.2.2 Omission of more than 2 points in any standard curve requires documented approval by a supervisor and notification to the Technical Leader.

2.8.12.6.3 Export the .txt data file to the “CASEWORK” folder on the D: drive using the previously established export properties.

2.8.12.6.4 Import the .txt data file to the DNA Workbook Trio Raw Data tab.

2.8.12.6.5 View and Print the Quant Results and Quant Std Curve tabs. The case notes shall contain the quantification values, IPC CT values, degradation indices, and a graph containing all three standard curves with slope, R², and y-intercept values for each curve.

2.8.12.6.6 The .eds run file and .txt data file shall be saved to each associated laboratory case number and request folder located in the analyst’s folders on the server.

2.8.12.6.7 Quantification values from the small autosomal target shall be used for amplification of autosomal STRs.

2.8.12.6.8 Quantification values from the male target shall be used for amplification of Y-STRs.

2.8.12.6.9 The quantification plate shall be discarded after the analysis is complete.

2.8.12.7 Interpretation Guidelines

2.8.12.7.1 Standard Curve: Evaluate the Small Autosomal, Large Autosomal, and Y standard curves individually or simultaneously.

2.8.12.7.1.1 Slope: Indicates the PCR amplification efficiency for the assay. A slope of -3.3 indicates 100% amplification efficiency. The analyst shall obtain
documented Technical Leader approval to use data when a slope is outside the acceptable range.

<table>
<thead>
<tr>
<th>Target</th>
<th>Acceptable slope range</th>
<th>Average slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Autosomal</td>
<td>-3.1 to -3.7</td>
<td>-3.4</td>
</tr>
<tr>
<td>Small Autosomal</td>
<td>-3.0 to -3.6</td>
<td>-3.3</td>
</tr>
<tr>
<td>Y</td>
<td>-3.0 to -3.6</td>
<td>-3.3</td>
</tr>
</tbody>
</table>

2.8.12.7.1.2 **Y-intercept**: The expected C$_T$ value for a 1 ng/µl sample. Y-intercept averages may vary by instrument, kit lot, and pipetting differences. The analyst shall obtain documented Technical Leader approval to use data when a Y-intercept value is outside the acceptable range.

<table>
<thead>
<tr>
<th>Target</th>
<th>Acceptable Y-intercept range (C$_T$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Autosomal</td>
<td>23.0 to 27.0</td>
</tr>
<tr>
<td>Small Autosomal</td>
<td>25.0 to 29.0</td>
</tr>
<tr>
<td>Y</td>
<td>25.0 to 29.0</td>
</tr>
</tbody>
</table>

2.8.12.7.1.3 **R$^2$ value**: A measure of the closeness of fit between the standard curve regression line and the individual C$_T$ data points of the standard curve. A value of 1.00 indicates a perfect fit between the regression line and the data points. This value shall be ≥ 0.980. If the R$^2$ value is <0.98 the experiment is inconclusive and shall be repeated with notification to the Technical Leader documented in the case record.

2.8.12.7.2 **Internal PCR Control (IPC)**: Differentiates between a sample containing no human DNA and reactions affected by the presence of PCR inhibitors, assay setup, and chemistry or instrument failure.

2.8.12.7.2.1 An elevated IPC C$_T$ value (relative to quantitation standards) is an indication of the presence of an inhibitor or high concentration of human template DNA.

2.8.12.7.2.2 If inhibition is suspected, the analyst may re-Microcon® and/or Centri-sep the sample prior to amplification and typing of the sample.

2.8.12.7.2.3 If high concentration of human DNA is present, the analyst may make dilutions of the sample and re-quantify.

2.8.12.7.2.4 The analyst shall make reasonable efforts to rectify samples in which the IPC is undetected. If a DNA profile is not developed from a sample with an undetected IPC, it shall be reported as inconclusive.
2.8.12.7.3 Non-Template Control (NTC): Contains PCR reagents with water or dilution buffer in place of template DNA and is therefore expected to be undetected (i.e. value of 0.00) for all three quantification values. However, background fluorescence or contamination may occur resulting in quantification values with one or more targets.

2.8.12.7.3.1 A NTC demonstrating quantification value(s) ≥0.001 ng/µl requires documented notification to the Technical Leader and shall be considered a failed control. The quantification shall be repeated.

2.8.12.7.3.2 A NTC demonstrating quantification value(s) <0.001 ng/µl may be due to background fluorescence. The analyst may proceed with amplification and typing of the samples using caution with interpretation of any profiles obtained from the samples.

2.8.12.7.4 Dynamic range: The quantitation standard curve ranges from 50 to 0.0032 ng/µl. Quantitation values are most reliable when they fall near the middle of the standard curve and less reliable as they approach the ends and beyond.

2.8.12.7.4.1 If the quantity of small autosomal DNA in a sample is <0.01 ng/µl, no additional autosomal STR analysis of that sample shall be performed.

2.8.12.7.4.2 If the quantity of male DNA in a sample is <0.003 ng/µl, no additional Y-STR analysis of that sample shall be performed.

2.8.12.7.4.3 The analyst should make a reasonable effort to target <50 ng/µl during extraction. If a sample quantifies >50 ng/µl and is suitable for amplification, a dilution shall be made and quantified.

2.8.12.7.5 Female To Male Ratio (FTMR): In instances where it is valuable to identify a male contributor from a female contributor (i.e. sexual assault cases), the FTMR can assist in prioritizing samples and determining which are suitable for autosomal STR analysis and which are suitable for Y-STR analysis. The female DNA contribution is determined by subtracting the quantity of male DNA from the quantity of small autosomal DNA (equation: [sm. auto-Y]/Y). The selection of samples to continue DNA analysis may be prioritized at analyst discretion by using the FTMR and quantity of male DNA input as described below.

2.8.12.7.5.1 Priority 1: Samples with FTMR ≤5:1 are generally expected to yield interpretable information from male contributor with autosomal STR analysis.
2.8.12.7.5.2 Priority 2: Samples with FTMR between 5:1 and 20:1 may yield interpretable information from the minor male contributor with autosomal STR analysis if the concentration of male DNA is sufficient (i.e. ≥0.025 ng amplification input). The relative value of autosomal STR analysis of samples in this range should be weighed against other related samples.

2.8.12.7.5.3 Priority 3: Samples with FTMR between 20:1 and 50:1 are generally expected to yield minimal information from the minor male contributor with autosomal STR analysis if the concentration of male DNA is sufficient (i.e. ≥0.025 ng amplification input). The relative value of autosomal STR or Y-STR analysis of samples in this range should be weighed against other related samples.

2.8.12.7.5.4 Priority 4: Samples with FTMR >50:1 are generally not expected to yield interpretable information from the minor male contributor with autosomal STR analysis. Y-STR analysis may be recommended if appropriate. If a sperm fraction is amplified, the corresponding non-sperm fraction may be amplified regardless of the FTMR and amount of male DNA present.

2.8.12.7.6 Degradation Index: A value to assist in the identification of degradation prior to amplification. The degradation index is calculated by dividing the small autosomal by the large autosomal quant values. An index >1 may indicate that the analyst should increase the template DNA for autosomal STR amplification to generate interpretable data from the larger molecular weight loci.

2.8.12.7.7 Reagent blank: Should not have associated DNA and is therefore expected to be undetected (i.e. value of 0.00) for all three quantification values. However, background fluorescence or contamination may occur resulting in quantification values with one or more targets.

2.8.12.7.7.1 A reagent blank that demonstrates quantification value(s) ≥0.001 ng/µl requires documented notification to the Technical Leader. It shall be considered a failed control unless re-quantification and/or amplification demonstrate no contamination. It is recommended that the analyst evaluate the results for possible sample switching and requantify if that is suspected.

2.8.12.7.7.1.1 The analyst may re-extract the associated samples if contamination is suspected.

2.8.12.7.7.1.2 If the reagent blank is amplified and no peaks above analytical threshold are observed in the electropherogram, the associated samples may be interpreted with caution.

2.8.12.7.7.2 A reagent blank that demonstrates quantification value(s) <0.001 ng/µl may be due to background fluorescence or low level contamination.

2.8.12.7.7.2.1 If all associated samples fail to demonstrate a sufficient quantity of DNA for amplification (i.e. <0.01 ng/µl for autosomal STRs; <0.003 ng/µl for Y-STRs), they shall be reported as such.

2.8.12.7.7.2.2 If the reagent blank is amplified and no peaks above analytical threshold are observed in the electropherogram, the associated samples may be interpreted normally.

2.8.12.7.7.3 A reagent blank that demonstrates peaks in the electropherogram shall be considered a failed control.
2.8.13 PowerPlex® Fusion 6C System (Applied Biosystems® 3500 Series Genetic Analyzer)

2.8.13.1 Introduction

2.8.13.1.1 The Promega PowerPlex® Fusion 6C System is a 27-locus multiplex that amplifies 23 autosomal short tandem repeat (STR) loci (CSF1PO, FGA, Penta D, Penta E, SE33, TH01, TPOX, WFA, D1S1656, D2S1338, D2S441, D3S1358, D5S818, D7S820, D8S1179, D10S1248, D12S391, D13S317, D16S539, D18S51, D19S433, D21S11, and D22S1045), two gender determining loci (Amelogenin and DYS391), and two additional rapidly mutating Y-STR loci (DYS570 and DYS576) in a single reaction. Separation and detection occurs using capillary electrophoresis with overlapping loci visualized simultaneously by using PCR primers labeled with six different fluorescent tags (FL-6C, JOE-6C, TMR-6C, CXR-6C, TOM-6C, and WEN-6C).

2.8.13.1.2 The Applied Biosystems® 3500 Series Genetic Analyzer utilizes electrokinetic injection of DNA molecules into polymer-filled capillaries which separates the DNA fragments by size. The fluorescent tag labeled primers incorporated into amplification products are responsive to the frequency of the 20mW solid state laser. Upon excitation, the fluorophores are raised to a higher energy level and when they return to their normal energy level a fluorescent signal is emitted. This signal is detected by a CCD (charge-coupled device) camera within the 3500 Genetic Analyzer which converts the signal to a computer image where it is visualized as a peak on the electropherogram.

2.8.13.1.3 The data produced by the 3500 Genetic Analyzer is analyzed with GeneMapper® ID-X Software which results in peaks labeled with their allele designation. The allele designation for each sample is accomplished through the use of an internal lane standard (ILS). The ILS contains 21 fragments of known length and is injected with each sample. The sample DNA fragments are compared to the ILS to determine the base pair size and the software assigns the allele designation by comparing the sizes to an allelic ladder.


2.8.13.1.5 All PowerPlex® Fusion 6C components should be stored at -10°C to -30°C upon receipt in the appropriate laboratory locations. The PowerPlex® Fusion 6C Allelic Ladder is packaged separately for shipping and should be stored in the post-amplification kit. Once thawed all components are stable at 2-10°C for 6 months. Do not refreeze.

2.8.13.1.6 The PowerPlex® Fusion 6C 5X Primer Pair Mix, PowerPlex® Fusion 6C Allelic Ladder Mix, and WEN ILS 500 shall be protected from excessive exposure to light.

2.8.13.1.7 The preparation of the amplification reactions shall be performed in the PCR amplification set-up area.
2.8.13.2 PowerPlex® Fusion 6C Amplification Set-Up

2.8.13.2.1 For initial use, thaw the Amplification Grade Water, PowerPlex® Fusion 6C 5X Master Mix, and PowerPlex® Fusion 6C 5X Primer Pair Mix. Centrifuge briefly to bring contents to the bottom, then vortex to mix. Do not centrifuge after vortexing as this may cause the primers/dNTPs to be concentrated at the bottom of the tube. The Master Mix and Primer Pair Mix shall be stored at 2-10°C after first use.

2.8.13.2.2 Determine the number of samples to be amplified including controls. Add ~3 reactions to this number to compensate for the loss that occurs during reagent transfer.

2.8.13.2.3 Place one 0.2 ml PCR reaction tube for each sample into a rack and label appropriately. A 96-well plate may be used.

2.8.13.2.3.1 If utilizing a 96-well plate for amplification, well locations where allelic ladder will be utilized for capillary electrophoresis shall be left empty during amplification.

2.8.13.2.4 The recommended amplification target range is 1.0 to 2.0 ng of template DNA. Amplification of greater than 2.0 ng of template DNA may result in increased artifacts and interfere with interpretation. Only samples with concentration less than 0.066 ng/µl may target less than 1.0 ng template DNA and shall be interpreted with caution.

2.8.13.2.5 For samples that will amplify 5 µl of template DNA, use the PowerPlex® Fusion 6C Amplification Worksheet - 5 µl Input to calculate the required amount of each component of the PCR master mix. Multiply the volume per reaction by the total number of reactions to obtain the final volume.

<table>
<thead>
<tr>
<th>PCR Master Mix Component</th>
<th>Volume per Reaction (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Grade H₂O</td>
<td>10</td>
</tr>
<tr>
<td>PowerPlex® Fusion 6C 5X Master Mix</td>
<td>5</td>
</tr>
<tr>
<td>PowerPlex® Fusion 6C 5X Primer Pair Mix</td>
<td>5</td>
</tr>
<tr>
<td>Total Volume</td>
<td>20</td>
</tr>
</tbody>
</table>

2.8.13.2.6 Combine the calculated volume of each component into a 1.5 ml tube and vortex ~5 seconds.

2.8.13.2.7 Pipette 20 µl of the PCR master mix to each sample tube or well.

2.8.13.2.8 Add 5 µl of sample, reagent blank, positive amplification control, or negative amplification control to the appropriate tube or well.

2.8.13.2.8.1 For the positive amplification control, dilute the 2800M DNA standard supplied with the PowerPlex® Fusion 6C kit, or other approved DNA standard, to 0.2-0.4 ng/µl and record the final concentration on the amplification worksheet. A positive control shall be included in each thermal cycler. The diluted positive control should be stored at 2-10°C.
2.8.13.2.8.2 Amplification Grade H₂O or NF H₂O shall be used as a negative amplification control included with each thermal cycler.

2.8.13.2.9 For samples requiring more than 5 µl of template DNA, use the PowerPlex® Fusion 6C Amplification – Variable Input worksheet to calculate the required amount of water and template DNA for individual samples. Prepare the PCR Master Mix without water. Multiply the volume per reaction by the total number of reactions to obtain the final volume.

<table>
<thead>
<tr>
<th>PCR Master Mix Component</th>
<th>Volume per Reaction (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex® Fusion 6C 5X Master Mix</td>
<td>5</td>
</tr>
<tr>
<td>PowerPlex® Fusion 6C 5X Primer Pair Mix</td>
<td>5</td>
</tr>
<tr>
<td>Total Volume</td>
<td>10</td>
</tr>
</tbody>
</table>

2.8.13.2.10 Combine the calculated volume of each component into a 1.5 ml tube and vortex ~5 seconds.

2.8.13.2.11 Pipette 10 µl of the PCR master mix to each sample tube or well.

2.8.13.2.12 Add the calculated volume of Amplification Grade H₂O or NF H₂O (0-10 µl) to each sample tube or well.

2.8.13.2.13 Add the calculated volume of sample, reagent blank, positive amplification control, or negative amplification control (5-15 µl) to each sample tube or well.

2.8.13.2.13.1 If the template DNA is stored in TE⁻⁴ buffer, the volume of the DNA sample added should not exceed 20% of the final reaction volume. PCR amplification efficiency and quality can be greatly altered by changes in pH (due to added Tris-HCl) or available magnesium concentration (due to chelation by EDTA). DNA samples stored (or diluted) in NF H₂O are not subject to this caution, but may contain other PCR inhibitors at low concentrations depending on the source of the template DNA and the extraction procedure employed.

2.8.13.2.14 For samples amplified in a 96-well plate, seal the plate with adhesive foil. Press the foil well using a roller tool.

2.8.13.3 PowerPlex® Fusion 6C Amplification

2.8.13.3.1 Place the tubes or 96-well plate in a GeneAmp® 9700 Thermal Cycler.

2.8.13.3.2 Select the Fusion 6C protocol with the following amplification procedure. Approximately 1 hour cycling time.
2.8.13.3 Enter **25 µl** for reaction volume and **Max** mode for ramp speed, then press **Start**.

2.8.13.4 Remove samples after the amplification process is completed and proceed with capillary electrophoresis or store the amplified samples at -10°C to -30°C. Alternatively, amplified samples may be stored at 2-10°C if they are to be used within 2 days.

2.8.13.4.1 Any remaining amplification products shall be discarded after the case has been administratively reviewed.

2.8.14 Instrument setup for Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0 see Appendix 3.

2.8.14 Applied Biosystems® 3500 Series Genetic Analyzer - Data Collection Software version 2.0 - PowerPlex® Fusion 6C Electrophoresis

2.8.14.1 Sample Preparation

2.8.14.1.1 **Note:** The quality of formamide is critical for the successful detection of a DNA profile. Deionized formamide shall be used that has a conductivity of less than 100µS/cm, such as Hi-Di™ Formamide. The formamide shall be frozen in aliquots at -20°C and the remainder of each aliquot shall be discarded after it is thawed. Multiple freeze-thaw cycles or long-term storage at 4°C may cause breakdown of the formamide which can create ions that compete with DNA during injection. This will cause lower peak heights and decreased sensitivity.

2.8.14.1.2 **Caution:** Formamide is an irritant and teratogen; therefore, universal precautions and a fume hood shall be utilized when manually working with formamide to avoid inhalation and contact with the skin.

2.8.14.1.3 For initial use, thaw the WEN ILS 500, PowerPlex® Fusion 6C allelic ladder, and an aliquot of Hi-Di™ Formamide. When thawed, centrifuge briefly to bring contents to the bottom, then vortex to mix. The ILS and allelic ladder shall be stored at 2-10°C after first use.

2.8.14.1.4 Determine the number of samples to be injected, including allelic ladders and controls (reagent blanks, positive control, and amplification blank). Add ~3 reactions to compensate for the loss that occurs during pipetting.
2.8.14.1.5 Prepare a loading cocktail by combining 0.5-1.0 µl ILS with 9.5-9.0 µl formamide for a total volume of 10 µl per sample.

2.8.14.1.5.1 The volume of ILS used in the loading cocktail may be adjusted between 0.5 to 1.0 µl per sample to optimize size standard peaks. The amount of formamide shall be adjusted so that the total amount of loading cocktail for each well is 10 µl.

2.8.14.1.6 Vortex to mix.

2.8.14.1.7 Pipette 10 µl of the formamide/ILS mixture into each well containing sample, allelic ladder, or control. Add formamide or formamide/ILS mixture into empty wells to complete an injection set. Liquid must be present in every well in which an injection will occur.

2.8.14.1.8 Add 1 µl of amplified sample or allelic ladder to the appropriate wells. It is recommended that a minimum of one allelic ladder is present with every 24 samples injected (i.e. every three injections on the 8-capillary 3500 and within every injection on the 24-capillary 3500xL).

2.8.14.1.8.1 If amplified sample is in a 96-well plate, seal the amplification plate with a new aluminum foil seal for storage.

2.8.14.1.9 Cover the wells with the plate septa and briefly centrifuge to remove air bubbles.

2.8.14.1.10 Denature the samples at 95°C for 3 minutes, then immediately chill on crushed ice or frozen plate block for ~3 minutes. Denature the samples just prior to loading the instrument. Avoid denaturing the samples for longer than 3 minutes as extended heat denaturing can lead to the appearance of artifacts.

2.8.14.2 Create a Plate Record

2.8.14.2.1 Open the 3500 Data Collection Software. The Dashboard screen will launch. Ensure that the Consumable Information and Maintenance Notifications are acceptable. The oven temperature should be set to 60°C.

2.8.14.2.2 Select Start Pre-Heat. This should be done at least 30 minutes prior to the first injection.
2.8.14.2.3 Select Create New Plate or Create Plate from Template.

2.8.14.2.3.1 Assign the plate name with the laboratory case number of the first case on the plate, the date, and the injection number of the plate (ex. 00A1234_01Jan16_01).

2.8.14.2.3.1.1 If the plate is re-injected the “01” number shall increase sequentially (00A1234_01Jan16_02).

2.8.14.2.3.1.2 If the plate is re-injected on a different day, the original date should still be used from when the plate was prepared.

2.8.14.2.3.1.3 If a second preparation of a plate is made on the same date as the first, it shall be designated with a “-2” after the date (00A1234_01Jan16-2_01).

2.8.14.2.4 Select “96” for Number of Wells.

2.8.14.2.5 Select “HID” for Plate Type.

2.8.14.2.6 Select “36”cm for Capillary Length.
2.8.14.2.7 Select “POP4” for Polymer.

Create A Plate:

2.8.14.2.8 Click “Assign Plate Contents”.

2.8.14.2.9 Enter sample information or import a plate record.

2.8.14.2.9.1 The sample name shall include the sample item/sub-item as well as the laboratory case number (ex. 1A1_00A1234) if more than one case is included on the plate. If only one case is present on the plate then only the sub-item number is required.

2.8.14.2.9.2 In order to aid in GeneMapper® ID-X sample analysis, it is recommended to place a “z” in front of the sample name for known standards (ex. z1A1_00A1234”) here or in GeneMapper® ID-X.

2.8.14.2.10 Under Assays, click “Add from Library” and select the appropriate Fusion6C assay. Double-click or click “Add to Plate” then “Close”.

2.8.14.2.11 Under File Name Convention, click “Add from Library” and select “Fusion6C_FNC”. Double-click or click “Add to Plate” then “Close”.

2.8.14.2.12 Under Results Groups, click “Add from Library” and select “Fusion6C_RG”. Double-click or click “Add to Plate” then “Close”.
Assign Plate Contents:

2.8.14.2.13 On the bottom-right side of the screen expand the **Customize Sample Info** window so it appears as shown above.

2.8.14.2.13.1 Use the drop-down box to select a sample type for each sample (ex. Ladder, Sample, Positive Control and Negative Control). For imported plates, this may be done automatically.

2.8.14.2.14 Highlight the sample wells and then select the appropriate boxes under **Assays**, **File Name Conventions**, and **Results Groups**.

2.8.14.2.15 Place the plate on the instrument in position A. Select “Link Plate for Run”. Click “OK”. The instrument automatically senses the plate and assigns the information to the Plate A field. Click “OK”.

2.8.14.2.16 To add a second plate, follow steps 2.8.14.2.3 through 2.8.14.2.14. Place the plate in position B. Select the “Link Plate for Run” and click “OK”. Assign the information to the Plate B field. Click “OK”.

2.8.14.3 **Start a Plate Run**

2.8.14.3.1 A unique run name is automatically generated by the instrument for each plate.

2.8.14.3.2 To re-organize injections, click “Create Injection List” and use the arrows to arrange in the desired order.

2.8.14.3.3 Click “Start Run”.

2.8.14.3.4 After the run is complete, click “Unlink Plate” and remove it from the instrument. The plate may be discarded or labeled with the same title as the plate record and
stored at -10°C to -30°C. The plate shall be destroyed after the case has been administratively reviewed.

2.8.14.3.4.1 If the CE plate requires re-injection after frozen storage, thaw and centrifuge to remove any air bubbles. Denature the plate at 95°C for 3 minutes, then immediately chill on crushed ice or frozen plate block for ~3 minutes prior to loading on the 3500 Genetic Analyzer.

2.8.14.3.5 A copy of the CE Plate Record Worksheet shall be maintained with each case record.

2.8.15 Setting Up GeneMapper® ID-X Version 1.4 Software User Accounts and Security System
See Appendix 4.

2.8.16 GeneMapper® ID-X Version 1.4 Software - PowerPlex® Fusion 6C Data Analysis

2.8.16.1 Processing Sample Data

2.8.16.1.1 Import the sample files to be interpreted from a single run folder by selecting “Add Samples to Project”.

2.8.16.1.2 Navigate to the run folder that contains the sample files. If the entire run folder is to be imported, click on the folder to highlight it, then click the “Add to List” button at the bottom of the window. If only a portion of samples need to be selected, expand the folder to view the samples. Highlight the appropriate samples, ensuring that the allelic ladder and all desired samples are selected. Once all the samples are selected click the “Add to List” button at the bottom of the window.

2.8.16.1.2.1 A run folder shall not be created manually by manipulating sample files.

2.8.16.1.3 Ensure that the necessary files are now located in the “Samples to Add” window by double-clicking on the folder in the right pane, then click “Add”.

2.8.16.1.4 After the samples have been added to the project, first briefly scan the raw data to ensure that a bad injection did not occur.

2.8.16.1.4.1 To check the raw data, first expand the project folder in the left navigation pane, click on a sample file, then click on the “Raw Data” tab in the right GeneMapper® ID-X window. To return to the “Samples” window, click on the project folder at the top of the left navigation pane.

2.8.16.1.5 The GeneMapper® ID-X project shall contain at least one allelic ladder from each run folder included in the project for proper genotyping. Multiple allelic ladders within a run folder will be averaged by the software to calculate the allelic bins. If a ladder injection is of low quality, delete the ladder or change the sample type from “Allelic Ladder” to “Sample” to remove it from consideration in calculating the bins.

2.8.16.1.6 Set the Table Setting at the top of the screen to “STRmix_Fusion6C”.

2.8.16.1.7 In the Sample Type column, verify that the correct sample types are displayed (i.e. Allelic Ladder, Sample, Positive Control, and Negative Control). Should a sample type need altered, use the drop-down menu to select the appropriate type.

2.8.16.1.8 In the Analysis Method column,
2.8.16.1.8.1 For unknown profiles: select “STRmix_Fusion6C_v2” from the drop-down menu in row 1. Click the column header cell to highlight the entire column and press Ctrl+D or select Edit → Fill Down.

2.8.16.1.8.2 For reference profiles: select “Fusion 6C_v2” from the drop-down menu in row 1. Click the column header cell to highlight the entire column and press Ctrl+D or select Edit → Fill Down.

2.8.16.1.8.3 Positive and negative controls can be analyzed with either analysis method; however stutter will need to be manually deleted from positive control profiles.

2.8.16.1.8.4 A project may contain samples with different analysis methods. The project shall contain a separate ladder for each analysis method used.

2.8.16.1.8.5 A project does not need to be created for standards if no items of evidence in that case are amplified or demonstrate conclusive results.

2.8.16.1.9 In the Panel column,

2.8.16.1.9.1 For unknown profiles: select “STRmix_v2_PowerPlex_Fusion_6C_ISP_IDX_v1.1” from the drop-down menu in row 1. Click the column header cell to highlight the entire column and press Ctrl+D or select Edit → Fill Down.

2.8.16.1.9.2 For reference profiles: select “PowerPlex_Fusion_6C_v2_Panels_ISP_IDX_v1.1” from the drop-down menu in row 1. Click the column header cell to highlight the entire column and press Ctrl+D or select Edit → Fill Down.

2.8.16.1.9.3 Ladders, positive and negative controls shall utilize the panel that corresponds to the analysis method used.

2.8.16.1.10 In the Size Standard column, select “WEN ILS 500” from the drop-down menu in row 1. Click the column header cell to highlight the entire column and press Ctrl+D or select Edit → Fill Down.

2.8.16.1.11 The Analysis Method, Size Standard, and Panel can be set as defaults when a GeneMapper® ID-X project is opened. Select File → Project Options. Under the Add Samples tab select appropriate settings as the default in the drop-down menus for Analysis Method, Size Standard, and Panel. Click “OK”.

2.8.16.1.12 Select the green Analyze arrow button to start data analysis. A pop-up window will ask for a project name to save. The project name shall contain the date the run was started on the instrument at a minimum. The case number is recommended but not required. Select the “ISP Casework Security Group”. Click “OK”.

2.8.16.2 Evaluating Sample Data

2.8.16.2.1 The Sizing Quality for unknown samples and allelic ladders shall be at least 0.75 for a sample to pass. The Sizing Quality for reference samples, negative controls and positive controls shall be at least 0.25 for a sample to pass. All appropriate ILS peaks shall be present and labeled correctly.

2.8.16.2.2 Highlight all sample rows containing Allelic Ladders and click “Display Plots”. In the Samples Plot screen, change the “Plot Setting” drop-down box to “Fusion6C”. Magnify the area from about 50 to 500 bp and verify that the correct allele calls are made for each peak. Print the electropherograms.
2.8.16.2.3 Highlight all sample rows containing **Negative Controls** and click “Display Plots”. Verify the Plot Setting is set to “Fusion6C” and check the negative controls to ensure that no peaks above analytical threshold are present. Print the electropherograms ensuring that the primer peak is visible.

2.8.16.2.4 Highlight all remaining sample rows and click “Display Plots”. Magnify the area from about 50 to 500 bp. Verify the Plot Setting is set to “Fusion6C”, evaluate all allele calls, and print the electropherograms. Optionally, the remaining sample rows may be viewed, evaluated, and printed with the Allelic Ladders.

2.8.16.2.5 After all analysis is complete, select the **Genotypes** tab. Click “File”, then select “Export Table”. Export the genotypes table as a .txt file to be utilized for STRmix™ analysis and the generation of allele summary tables in the STRlite excel program. The .txt file name shall be the same as the project name with the automatic extension “Genotypes Table” added during export.

2.8.16.2.6 The 3500 Data Collection run folder containing the sample files, associated GeneMapper® ID-X projects, and exported genotypes table .txt file shall be saved under each associated laboratory case number and request folder located in the analyst’s folders on the server. Projects should be deleted monthly from the “GeneMapper Manager” to maintain database space.

2.8.16.2.7 When exporting the GeneMapper® ID-X project, ensure that the “Export with analysis settings” box is checked.

**2.8.17 General Rules For PowerPlex® Fusion 6C Analysis On The Applied Biosystems® 3500 Genetic Analyzer**

2.8.17.1 At least one allelic ladder shall be present within each run folder. It is recommended that an allelic ladder be run within each set of 3 columns. This will help account for possible migration shifts due to external environmental factors. If a single injection contains both unknown and reference samples, it is recommended that two allelic ladders are run for GeneMapper® ID-X analysis.

2.8.17.2 Samples in the 96-well plate should be oriented to allow for the injection of unknown samples prior to the injection of any reference samples for that case.

2.8.17.3 A signal range of 5,000 to 20,000 RFU will produce optimal results.

2.8.17.4 If multiple amplifications are analyzed for a sample, the analyst shall use the amplification which he or she determines sufficiently represents the sample based on peak heights, artifacts, and noise levels. Analysts shall interpret data that most clearly represents the sample and try to achieve better resolution if a sample has peak heights that are too high (resulting in artifacts, increased instrument noise, and pull-up) or too low (resulting in allelic drop out and loss of data).

2.8.17.5 Only the data used for interpretation needs to be printed for the case record. However, other runs shall be noted in the case record and all data shall be saved under each associated laboratory case number and request folder located in the analyst’s folder on the server.

**2.8.18 Archiving Applied Biosystems® 3500 and GeneMapper® ID-X Projects**

2.8.18.1 The 3500 run folders containing all sample files for a case as well as the GeneMapper® ID-X project and export files shall be saved under each associated laboratory case number and request folder located in the analyst’s folder on the server and deleted from
the hard drive of the instrument and/or analysis computer. The data stored on the server shall be routinely backed up to ensure security of data.

2.8.18.2 A copy of all electropherograms used in interpretation as well as a printout of the plate record shall be placed in the case record.

2.8.18.3 All processed plate records shall be deleted from the Data Collection Software database weekly. Run folders containing the sample files and the GeneMapper® ID-X projects shall be deleted on or after the 15th of each month on the instrument computers. It shall be each analyst’s responsibility to ensure that all data is backed up prior to the 15th of the month.

2.8.19 STRmix™ Installation and Set-up: See Appendix 5

2.8.20 Interpretation Guidelines For PowerPlex® Fusion 6C and STRmix™ Deconvolutions

2.8.20.1 Scope

2.8.20.1.1 The following interpretation guidelines shall aid in peak/true allele determinations and profile interpretations.

2.8.20.1.2 It shall be at the analyst’s discretion, based on experience and training, as to which peaks are suitable for interpretation and input into STRmix™.

2.8.20.1.3 If an analyst has determined that a peak that has been labeled by the GeneMapper® ID-X software is not a true allele peak, the analyst shall rename or delete the allele call label in GeneMapper® ID-X.

2.8.20.1.4 Final allele calls shall be documented on the STRlite printout.

2.8.20.1.4.1 For unknown profiles, the STRlite excel program utilizes a filter to display peaks in the allele table that fall below the mean + 3SD stutter value from the PowerPlex® Fusion 6C validation for backward (n-3/n-4/n-5) and forward (n+3/n+4/n+5) stutter. This is only to aid in the analyst’s ability to determine what are possibly true alleles for the determination of the number of contributors in the sample. STRmix™ analysis will make the official interpretative evaluations of these peaks.

2.8.20.1.5 STRmix™ is a probabilistic genotyping software program for the interpretation of autosomal STR DNA profiling results. STRmix™ can deconvolute (break down into individual contributors) a DNA mixture, and attach a statistical weighting to comparisons of evidence sample profiles to reference profiles.

2.8.20.1.5.1 The ISP Laboratory has validated STRmix™ v2.5.11 for casework.

2.8.20.2 DNA Profile Interpretation

2.8.20.2.1 Assumptions used in the interpretation of mixtures and interpretation decisions shall be documented in the case record.

2.8.20.2.2 Analysts shall consider the additive effects of allele sharing during interpretation.

2.8.20.2.3 The flow of interpretation generally follows the steps listed below (Clayton, et al., 1998):

- Identify the presence of a mixture.
- Designate the allele peaks.
- Identify the number of contributors.
- Estimate the relative ratio of the individual contributors to the mixture.
- Consider all genotype combinations.
Compare reference samples.
Statistical analysis (if necessary).

2.8.20.2.4 STRmix™ is utilized to perform the interpretation steps following the identification of the number of contributors. The general approach to profile interpretation with STRmix™ is outlined here:

A DNA profile or mixture previously analyzed in GeneMapper® ID-X is assessed for suitability for STRmix™ analysis.

If suitable, the profile/mixture is interpreted/deconvoluted within STRmix™.

Reference samples are compared to the completed interpretation/deconvolution, and statistical calculations are performed reflecting that comparison (if necessary).

STRmix™ outputs are reviewed for quality and all appropriate results are reported.

2.8.20.2.5 Identify If The Profile Is A Mixture

2.8.20.2.5.1 Single Contributor DNA Profile Determination

2.8.20.2.5.1.1 Generally, a single source profile should contain no more than two alleles at each autosomal locus and no more than one allele at each Y-STR locus. However, three-peak allele patterns have been reported at autosomal loci for single-source stains and two-peak patterns have been reported at Y-STR loci, but these instances are rare. A profile where only one autosomal locus demonstrates three alleles or one Y-STR locus demonstrates two alleles could be an indication of:

2.8.20.2.5.1.1.1 A tri-allelic pattern for an autosomal locus. If a tri-allelic pattern is indicated, it should be confirmed by concordance to at least one additional sample contained within the case and/or re-amplification.

2.8.20.2.5.1.1.1.1 Any locus with a confirmed tri-allelic pattern shall not be used for statistical evaluation.

2.8.20.2.5.1.1.2 A duplication event for a Y-STR locus. If a duplication is indicated, the profile should be confirmed by concordance to at least one additional sample contained within the case and/or re-amplification and documented notification to the Technical Leader. Alternatively, the sample may be amplified with PowerPlex® Y23 to confirm the profile with documented approval from a Biology unit supervisor and notification to the Technical Leader.

2.8.20.2.5.1.2 For single source profiles, the peak height ratio (the smallest peak divided by the largest peak) of heterozygous individuals at a locus should be within 0.65.

2.8.20.2.5.1.2.1 Samples may display peak height ratios less than expected when the sample is of poor quality or the amplification target is below the ideal input of template DNA.

2.8.20.2.5.1.3 Conclusions shall be reported for all results in which the assumption of a single contributor is made.
2.8.20.2.5.2 Mixed DNA Profile Determination

2.8.20.2.5.2.1 A profile is defined as a mixture of two or more individuals when a locus demonstrates an additional allele, with the exception of a tri-allelic pattern at an autosomal locus or duplication event at a Y-STR locus.

2.8.20.2.5.2.2 A peak height ratio less than 0.65 at a locus may indicate a mixed profile and that allele sharing may be occurring.

2.8.20.2.5.2.2.1 Samples may display peak height ratios less than expected when the sample is of poor quality or the amplification target is below the ideal input of template DNA.

2.8.20.2.5.2.3 Peaks in stutter position that exceed the mean +3 SD stutter percentage may indicate the presence of a mixture.

2.8.20.2.5.2.4 All loci shall be considered when determining the presence of a mixture.

2.8.20.2.5.3 Profiles In Which A Single Additional Allele is Detected (not tri-allelic)

2.8.20.2.5.3.1 If an additional allele is present at Amelogenin or the Y-STR (and therefore cannot be modeled by STRmix™), the sample shall be reported with the additional allele wording outlined in the Report Writing Guidelines (Appendix 7).

2.8.20.2.5.3.2 If the additional allele is possible drop-in at an autosomal locus (<250 RFU), the assumed number of contributors should not be increased and STRmix™ shall be allowed to model the peak.

2.8.20.2.5.3.3 If the additional allele is >250 RFU, this shall be considered an indication of an additional contributor. The profile shall be deconvoluted in STRmix™ with the assumed number of contributors increased to account for that additional contributor.

2.8.20.3 Preliminary Evaluation of Allele Peaks

2.8.20.3.1 An analyst is required to visually confirm that all allelic ladders used for allele designation performed correctly.

2.8.20.3.2 The internally validated analytical threshold is 150 RFU.

2.8.20.3.2.1 Peaks below analytical threshold shall not be interpreted, but may be considered when deciding if the possible number of contributors can be reasonably assumed.

2.8.20.3.3 There is no static stochastic threshold used for STRmix™ interpretation. However, a stochastic threshold value of 750 RFU will be utilized to evaluate reference samples for completeness when a single allele is detected at a locus.

2.8.20.3.3.1 If a reference sample has a locus with a single peak present <750 RFU, the locus shall be ignored in the STRmix™ deconvolution (if the reference sample is being utilized for conditioning) or likelihood ratio calculation (if the reference sample is being utilized for comparison). Technical Leader approval is not necessary for ignoring more than one locus due to possible allelic drop-out of reference sample.

2.8.20.3.4 All interpretable autosomal peaks in unknown samples shall not exceed 28,000 RFU. Exceptions may be allowed with Technical Leader approval documented in the case record.
2.8.20.3.4.1 Unknown profiles with autosomal peaks over 28,000 RFU should be interpreted with caution, as modeling parameters utilized in STRmix™ may not model profiles with saturated peaks optimally.

2.8.20.3.4.2 Reference samples and positive control profiles may have up to two autosomal loci with peaks over 28,000 RFU. These profiles should be interpreted with caution.

2.8.20.3.5 An initial interpretation of the data shall be made to distinguish non-allelic artifact peaks (e.g., pull-up, spikes, dye blobs, etc.) from true allelic data.

2.8.20.3.5.1 Artifacts have been observed and documented utilizing the PowerPlex® Fusion 6C amplification kit. Any artifact peaks called as alleles by the GeneMapper® ID-X software shall be deleted or renamed in the software as an artifact. The printed electropherogram should indicate the reason for deletion, either manually or labeled in the software. Examples of documented artifacts are listed below. A complete list of artifacts, including nonhuman cross-reactivity, can be found in the PowerPlex® Fusion 6C Technical Manual. Some examples of artifacts that may be observed are:

- Amelogenin, D1S1656, DYS391, FGA – n-1
- D13S317, D18S51, vWA, D7S820, D5S818, D19S433, FGA – n-2
- Other DNA-independent artifacts have been documented in the following dyes:
  - FL-6C (Blue) - ~65-75 bp, ~113 – 120 bp, ~137 – 145 bp
  - JOE-6C (Green) - ~60 – 66 bp
  - TMR-5C (Yellow) - ~57-62 bp

2.8.20.3.5.2 Pull-up or bleed through peaks can occur if signal intensity of sample or ILS peaks are too high or if a new spectral calibration needs to be run. Any pull-up peaks called as alleles by the GeneMapper® ID-X software shall be deleted or renamed in the software as pull-up or artifact. The printed electropherogram should indicate the reason for deletion, either manually or labeled in the software. The sample should be re-run if a pull-up peak interferes with the analyst’s ability to evaluate the profile based on their experience and training.

2.8.20.3.5.3 Spikes are peaks that generally appear in all colors and are sharper than regular peaks; however, they can occur predominantly in one color. Spikes are a natural consequence of capillary electrophoresis and can be caused by dust present in the system as well as urea crystals in the system. It is essential that the instrumentation be maintained and cleaned regularly to minimize the appearance of spikes. All spikes called as alleles by the GeneMapper® ID-X software shall be deleted or renamed in the software as spikes or artifacts. The printed electropherogram should indicate the reason for deletion, either manually or labeled in the software. A sample should be re-injected when a spike interferes with the analyst’s ability to evaluate the profile based on their experience and training.

2.8.20.3.6 Stutter peaks are artifacts of the amplification process and display less intensity than the true parent peak. Stutter peaks will typically be observed one repeat unit shorter than the parent peak (ex. n-4 at a tetranucleotide STR), but may also occur two repeats less (ex. n-8 at a tetranucleotide STR), or one repeat more (n+4 at a tetranucleotide STR). Additionally, n-2 artifact peaks have been
reported at several loci amplified with PowerPlex® Fusion 6C. Mean and mean + 3SD backward, forward, and double-backward stutter values and a figure indicating observed backward stutter per allele from the PowerPlex® Fusion 6C validation can be found in Appendix 6.

2.8.20.3.6.1 Stutter peaks in the backward (n-3/n-4/n-5) and forward (n+3/n+4/n+5) positions at the autosomal loci are modeled by STRmix™ and shall not be removed from GeneMapper® ID-X data of unknown profiles destined for STRmix™ analysis.

2.8.20.3.6.2 The stutter peaks listed below are not modeled by STRmix™ and shall be removed from GeneMapper® ID-X data of unknown profiles destined for STRmix™ analysis. GMID-X stutter filters can aid in the removal of these stutter peaks below the mean + 3SD values. Peaks above the stutter filter, but determined to be stutter shall be deleted or renamed in the software as stutter or artifact. The printed electropherogram should indicate the reason for deletion, either manually or labeled in the software.

2.8.20.3.6.2.1 Stutter peaks in the double-backward position (n-6/n-8/n-10).

2.8.20.3.6.2.2 Partial repeat (n-2/n+2) stutter peaks for D1S1656, D19S433, SE33 and FGA.

2.8.20.3.6.2.3 All stutter peaks at the Y-STR loci.

2.8.20.3.6.3 For reference profiles, all stutter peaks shall be deleted.

2.8.20.3.7 Rare variants (microvariants) have been described in the literature. These peaks will have a similar intensity to the other allelic peaks for that locus but will not line up with the allelic ladder and will fall outside of established bins.

2.8.20.3.7.1 Any allele peak that is not present in the allelic ladder and does not have an associated “bin” in the GeneMapper® ID-X analysis software is labeled “OL” (Off-Ladder) and shall be renamed by the analyst in the software.

2.8.20.3.7.1.1 Alleles which are located between two alleles on the ladder shall be described as the short repeat followed by the number of base pairs it is larger (e.g., 0.1, 0.2, 0.3, or 0.4). Therefore, if a peak is 1 base pair larger than the 5 allele it shall be designated as 5.1. A microvariant 3 base pairs larger for than an allele on the ladder for a tri-nucleotide, 4 base pairs larger for a tetranucleotide, or 5 base pairs for a pentanucleotide may be designated with the full repeat number (e.g., A peak 4 base pairs larger than the 5 allele could be designated a 6; 5 base pairs larger a 6.1).

2.8.20.3.7.1.2 Alleles which are located outside the range of the ladder or bin set but within the designated marker range of the locus shall be evaluated to determine the appropriate repeat number that should be assigned to the allele.

2.8.20.3.7.1.2.1 Any allele recognized by the CODIS software to fall outside of the allelic ladder shall be renamed during CODIS entry as “<” the smallest allele or “>” the largest allele for the locus.

2.8.20.3.7.1.3 Alleles which are labeled “OMR” (Outside Marker Range) by the GeneMapper® ID-X analysis software shall be evaluated to determine which locus the allele likely belongs to. If the analyst can reasonably
determine which locus the allele belongs to, the allele can be assigned to that locus in GeneMapper® ID-X and the allele call can be made. If the analyst cannot reasonably determine which locus the allele belongs to, both loci surrounding the allele shall be ignored from the STRmix™ deconvolution.

2.8.20.3.7.1.4 In instances where non-numeric alleles (e.g., OL and/or OMR) are marked and retained in the GeneMapper® ID-X data, the resulting STRmix™ run must be analyzed with that locus ignored from analysis.

2.8.20.4 Evaluation of Controls

2.8.20.4.1 Failed controls require the documented notification to the Technical leader with appropriate documentation in the case record.

2.8.20.4.2 The appearance of pull-up or known artifact peaks does not render the following controls inconclusive.

2.8.20.4.3 Reagent Blank:

2.8.20.4.3.1 The purpose of the reagent blank is to determine if the reagents used to extract the associated samples were contaminated by human DNA. Therefore no signal should be detected in this sample well other than the internal lane standard. If a signal is detected in the reagent blank, all results of samples associated with that reagent blank shall be considered inconclusive.

2.8.20.4.3.2 A reagent blank with peaks below the Analytical Threshold shall not prevent associated samples from being interpreted.

2.8.20.4.3.3 A reagent blank with peaks above the Analytical Threshold shall be considered a failed negative control. All associated samples shall be inconclusive. All of the samples shall be repeated when appropriate.

2.8.20.4.4 Positive Control:

2.8.20.4.4.1 The 2800M DNA is used as a positive control to demonstrate that the kit is performing properly. If the expected alleles are not detected in the positive control well, then the test is considered inconclusive.

Positive Control 2800M (PowerPlex® Fusion 6C):

<table>
<thead>
<tr>
<th>X, Y</th>
<th>17, 18</th>
<th>12, 13</th>
<th>10, 14</th>
<th>13, 15</th>
<th>9, 11</th>
<th>7, 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amelogenin</td>
<td>D3S1358</td>
<td>D1S1656</td>
<td>D2S441</td>
<td>D10S1248</td>
<td>D13S317</td>
<td>Penta E</td>
</tr>
<tr>
<td>D16S539</td>
<td>D18S51</td>
<td>D2S1338</td>
<td>CSF1PO</td>
<td>Penta D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6, 9.3</td>
<td>16, 19</td>
<td>29, 31.2</td>
<td>8, 11</td>
<td>12</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>TH01</td>
<td>vWA</td>
<td>D21S11</td>
<td>D7S820</td>
<td>D5S818</td>
<td>TPOX</td>
<td></td>
</tr>
<tr>
<td>14, 15</td>
<td>18, 23</td>
<td>13, 14</td>
<td>15, 16</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D8S1179</td>
<td>D12S391</td>
<td>D19S433</td>
<td>SE33</td>
<td>D22S1045</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>20, 23</td>
<td>18</td>
<td>17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DYS391</td>
<td>FGA</td>
<td>DYS576</td>
<td>DYS570</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2.8.20.4.5 Amplification Blank:

2.8.20.4.5.1 The purpose of the amplification blank is to determine if human DNA contaminated the samples at the amplification step. Because no template DNA was placed in the reaction, the sample should be blank except for the internal lane standard peaks.

2.8.20.4.5.2 An amplification blank with peaks below the Analytical Threshold shall not prevent associated samples from being interpreted.

2.8.20.4.5.3 An amplification blank with peaks above the Analytical Threshold shall be considered a failed negative control. All associated samples shall be inconclusive. All of the samples shall be repeated when appropriate.

2.8.20.5 Determination of the Assumed Number of Contributors

2.8.20.5.1 The assignment of the number of contributors to a profile should be made by the analyst prior to the comparison of the profile to any reference samples. Reference sample profiles from individuals who are assumed to be present in a sample and will be used to condition on in the STRmix™ deconvolution may be used to aid in the determination of number of contributors for that sample.

2.8.20.5.1.1 The profile from the corresponding fraction of a differential extraction may also be used to aid in the determination of the number of contributors.

2.8.20.5.2 Determination of the number of contributors shall be done at the analyst’s discretion, based on experience and training, and should take into account peak height ratios and possible genotype pairings, as well as sub-analytical threshold and high stutter peaks.

2.8.20.5.3 Depending on sample data, an analyst may assign the number of contributors to a sample as one, two, three, four, or at least five.

2.8.20.5.4 In circumstances when the number of contributors cannot be determined, the profile is reported as too complex to interpret (inconclusive). Such profiles include:

- 5 person or greater mixtures
- Sample results with data at less than two autosomal loci
- Sample results with poor quality data in which peak number, peaks below analytical threshold, peak height ratios and other qualitative factors prevent the reasonable determination of the number of contributors

2.8.20.5.5 The following steps should be followed in assigning the number of contributors to a profile:

2.8.20.5.5.1 Review the profile as a whole, assessing the level of degradation, presence of low level peaks, noisy or clean baseline and the general quality of the profile.

2.8.20.5.5.2 If replicate amplifications have been undertaken, all qualifying replicate profiles should be reviewed when determining the number of contributors.

2.8.20.5.5.3 Identify possible stutter peaks (both forward and backward) by reference to stutter table (see Appendix 6).
2.8.20.5.5.4 Find the locus with the highest number of unambiguous allelic peaks to determine the minimum number of contributors. Peak height imbalance between alleles may mean the presence of an additional contributor(s) above that indicated by allele count alone.

2.8.20.5.5.5 If one or more contributors at this locus is a clear major, check that this pattern is represented at other loci.

2.8.20.5.5.6 Apply the general pattern of contributors (e.g., number of alleles, peak height ratios) to other loci in the profile.

2.8.20.5.5.7 Discriminating loci such as FGA and SE33 are likely to be the most informative when determining the number of likely contributors.

2.8.20.5.5.8 The presence of a single minor peak or elevated stutter may indicate the presence of drop-in and not an additional contributor.

2.8.20.5.5.9 After initial assignment of the number of contributors and subsequent STRmix™ analysis, and prior to comparison with the person of interest reference profiles, analysis may determine that the deconvolution did not conform to scientific expectation and may be re-run under a different number of contributors or with increased MCMC iteration accepts. In this case the course of action shall be detailed on the STRmix™ output and the electronic file of the first deconvolution shall be maintained in the case record.

2.8.20.6 General Interpretation Considerations for STRmix™

2.8.20.6.1 STRmix™ should be used to deconvolute all qualifying samples, where a qualifying sample is defined as:

2.8.20.6.1.1 All evidence DNA samples where the number of contributors can be assumed (up to four contributors) unless the profile is completely accounted for by conditioning.

2.8.20.6.1.1.1 A sample demonstrating a partial profile may be interpreted if the number of contributors can be reasonably assumed. STRmix™ requires a minimum of two autosomal loci for interpretation.

2.8.20.6.2 Evidence samples with identical profiles shall be analyzed independently with STRmix™.

2.8.20.6.3 Y-STR loci present in PowerPlex® Fusion 6C shall only be used for interpretation purposes and not for statistical evaluations. The Y-STR loci are not evaluated within the STRmix™ software.

2.8.20.6.4 The basis of STRmix™ is that, given a set of mass parameters (e.g., DNA amount, degradation, and amplification efficiency), the software can determine the expected height of a peak of a certain size at a given locus. If there are reasons for the expected peak height to be incorrect or for issues with allele designation, STRmix™ is unable to handle loci with these effects. Examples include:

2.8.20.6.4.1 Tri-allelic loci
2.8.20.6.4.2 Somatic and primer binding site mutations
2.8.20.6.4.3 Technical issues (saturated or poorly-resolved GeneMapper® ID-X data)

2.8.20.6.5 Non numeric values such as OL, <, or > are not permitted within the STRmix™ input files.

2.8.20.6.6 The Ignore Locus function within STRmix™ may be used to ignore an affected locus within an interpretation. A locus with this option selected will be removed from the subsequent deconvolution or LR from Previous calculation.

2.8.20.6.6.1 Analyst discretion may be used to ignore a single locus within the STRmix™ deconvolution or LR from Previous calculation with reasoning documented in the case record. Ignoring more than one locus requires Technical Leader approval with documentation in the case record, except in the situation where ignoring multiple loci is necessary due to possible allele drop-out in a reference sample.

2.8.20.6.6.2 If a locus has been ignored due to the inability of STRmix™ to handle a biological effect (e.g. a tri-allelic locus), an analyst may document their manual interpretation for CODIS entry purposes only.

2.8.20.6.7 A replicate is defined as a repeat amplification of the same extract and may be analyzed together in STRmix™ to aid sample interpretation, including determination of the number of contributors.

2.8.20.6.7.1 Replicates may only be analyzed together through STRmix™ with Technical Leader approval documented in the case record.

2.8.20.6.7.2 Replicates shall be performed under identical conditions (e.g., template amount) for joint analysis in STRmix™.

2.8.20.6.8 If it has been determined that a sample is unsuitable for interpretation, an explanation as to why the sample is un-interpretable should be given. Examples include:

2.8.20.6.8.1 No results: No peaks were detected in the electropherogram.

2.8.20.6.8.2 Inconclusive: Peaks were observed at one or more loci; however no conclusive results could be drawn due to an inability to reasonably determine the number of contributors.

2.8.20.6.9 Test results from an unknown sample that are suitable for comparison to a reference sample may have the following conclusions reported:

2.8.20.6.9.1 Included: The STRmix™ calculated HPD (Highest Posterior Density) Likelihood Ratio favors inclusion.

2.8.20.6.9.2 Excluded: The profile obtained from the unknown stain had discrepant genotypes as compared to the profile of the reference sample (i.e. was not the same) and can be visually excluded or the STRmix™ calculated HPD Likelihood Ratio favors exclusion.

2.8.20.6.9.3 Uninformative: The profile obtained from the unknown stain has sufficient ambiguity when compared to the profile of the reference sample and the HPD Likelihood Ratio falls in the uninformative range.

2.8.20.6.10 If conclusive results are obtained from a sample, appropriate CODIS eligible profiles which do not match the victim shall be entered into CODIS for searching.
2.8.20.7 Setting Up Propositions for Calculating the Likelihood Ratio (LR)

2.8.20.7.1 The Likelihood Ratio (LR) assesses the probability of the evidence given two alternate propositions or hypotheses; one that aligns with the prosecution ($H_1$ or $H_p$) and one that aligns with the defense ($H_2$ or $H_d$). $H_1$ is typically inclusionary of the person(s) of interest. The defense proposition aligns with exclusion of the person(s) of interest.

2.8.20.7.2 Analysts will need to review all case information in order to determine which likelihood ratio calculations should be calculated and reported. Multiple propositions may need to be considered.

2.8.20.7.2.1 Examples:

2.8.20.7.2.1.1 Two-person mixture from intimate swab collected from victim. The victim and the Person of Interest (POI) cannot be excluded as possible contributors to the sample.

- $H_1$: DNA originates from victim and POI
- $H_2$: DNA originates from victim and unknown contributor

2.8.20.7.2.1.2 Three-person mixture from firearm located at scene. The POI cannot be excluded as a possible contributor to the sample.

- $H_1$: DNA originates from POI and two unknown contributors
- $H_2$: DNA originates from three unknown contributors

2.8.20.7.2.1.3 Three-person mixture from firearm located at scene. POI1 and POI2 both cannot be excluded as possible contributors to the sample. Three separate LRs may be calculated:

- $H_{1-1}$: DNA originates from POI1 and two unknown contributors
- Or-
- $H_{1-2}$: DNA originates from POI2 and two unknown contributors
- Or-
- $H_{1-3}$: DNA originates from POI1, POI2 and one unknown contributor
- $H_2$: DNA originates from three unknown contributors

2.8.20.7.3 Conditioning is defined as a DNA profile that is present in both propositions ($H_1$ and $H_2$) because it is reasonable to concede the presence of the individual’s DNA. Conditioning where appropriate provides a more accurate likelihood ratio for the person of interest’s possible contribution to that profile.

2.8.20.7.3.1 At this time, only DNA reference samples may be used for conditioning, except as indicated for CODIS purposes only.

2.8.20.7.3.2 The reference profiles shall have at least 20 autosomal complete loci (loci with no possible allelic drop-out).

2.8.20.7.3.3 If a reference profile being used for conditioning is a partial profile or has loci with possible allelic drop-out (a single allele ≤ 750 RFU), the loci with incomplete allelic information shall be ignored from the STRmix™ deconvolution.
2.8.20.7.3.4 Intimate samples should be conditioned on the owner, unless a single source foreign profile is obtained (e.g., sperm fractions or blood of another on one’s person).

2.8.20.7.3.5 Non-intimate samples may be conditioned on elimination standards, depending on the profile and case information (e.g., steering wheel profile conditioned on owner or clothing profile conditioned on wearer).

2.8.20.8 Initial STRmix™ Analysis for Evidentiary Sample Data (Deconvolution)

2.8.20.8.1 To start a new STRmix™ deconvolution, from the STRmix™ main menu select Start Analysis.

2.8.20.8.2 In the Configure Analysis window, enter the case number in the “Case Number” box. The deconvolution number should be entered after the item number in the “Sample ID” box. For subsequent deconvolutions of the same item number, increase “Decon#” sequentially (e.g., 001A_Decon1, 001A_Decon2). If additional characters are added to the “Sample ID” designation, those characters shall be added after the specified naming convention.

2.8.20.8.3 Ensure that the number of burn-in accepts per chain is set to 100,000, and the number of post burn-in accepts per chain is set to 50,000. No changes should be made to Run Settings.

2.8.20.8.3.1 For four person mixture interpretation, increase the number of burn-in accepts per chain to 1,000,000, and the number of post burn-in accepts per chain to 500,000.

2.8.20.8.3.2 For troubleshooting purposes for samples with less than four contributors, an analyst may increase the number of burn-in accepts per chain to 1,000,000, and the number of post burn-in accepts per chain to 500,000 with notification to the Technical Leader documented in the case record.

2.8.20.8.4 Enter the proposed number of contributors for the sample (1, 2, 3, or 4), and select Confirm.

2.8.20.8.5 In the Add Profile Data window, verify that ISP_Fusion6C is the selected DNA kit used.

2.8.20.8.6 Add a new profile to the box marked Add Evidence Profile Data. This may be done by selecting Add Profile and navigating the file tree, or by dragging and dropping the appropriate GeneMapper® ID-X export file into the box. If multiple samples are present in the file, select the desired sample for analysis.

2.8.20.8.7 If conditioning on a reference sample, add a new profile to the box marked Add Reference Profile Data. This may be done by selecting Add Reference and navigating the file tree, or by dragging and dropping the appropriate GeneMapper® ID-X export file or previous STRmix Evidence file into the box. Multiple reference profiles may be added if you are conditioning on multiple individuals.

2.8.20.8.8 After the reference profile is added, select Change Hd to reflect the proper proposition associated with that profile. The reflected portion of the propositions will be visible in the Contributor to: Hp and Hd boxes. For conditioning, the reference should be selected in both the Hp and Hd boxes.

2.8.20.8.9 Select Confirm Settings.
2.8.20.8.10 In the Population Settings window, select Start & Search. This will begin a deconvolution analysis of the chosen sample and search the results against the ISP personnel database.

2.8.20.8.11 When the deconvolution is complete, STRmix™ will generate several data files and save them to the STRmix™ Results folder on the C: drive.

2.8.20.8.12 Save each deconvolution folder to the DNA server for the appropriate case.

2.8.20.9 Review of Run Diagnostics

2.8.20.9.1 Upon completion, the Deconvolution Report shall be reviewed for quality by assessing the deconvolution diagnostics. Skewed diagnostics may indicate that the sample is in need to further scrutiny (e.g., inclusion of inappropriate artifacts in import file or incorrect contributor number), that the deconvolution has not reached the appropriate sample space and additional accepts may be needed, or that the sample is of poor quality.

2.8.20.9.1.1 The weights of the genotype combinations generated by STRmix™ should be assessed at each locus for their intuitiveness when compared visually to the accompanying sample electropherogram. These may be found under the Genotype Probability Distribution section of the Deconvolution report (example below).

2.8.20.9.1.1.1 Rarely, due to limitations in stutter modeling for loci with complex repeat structures, STRmix™ may not model stutter peaks as expected (ex. 14 allele at vWA). If an analyst finds that a peak has not modeled as expected, they may refer to the STRbase website (http://strbase.nist.gov/str_fact.htm) to investigate if the allele is one that may contain variations in the Longest Uninterrupted Sequence (LUS) value. This would provide weight to the decision to ignore the locus in the STRmix™ deconvolution.
2.8.20.9.1.2 Total Iterations and Acceptance Rate

2.8.20.9.1.2.1 The Total Iterations value displayed in the Post Burn-In Summary indicates the total number of post burn-in MCMC iterations. This value, along with the number of accepts chosen for the analysis can inform the user as to how often a new proposed set of parameters was accepted. This is referred to as the acceptance rate.

2.8.20.9.1.2.2 A very low acceptance rate (e.g., 1 in thousands to millions) may, in combination with the other diagnostics, indicate that the analysis may benefit from a run with additional iterations. On its own (and without any other indication of sub-optimal results) a low acceptance rate is not an indication that rework is required.

2.8.20.9.1.3 The Effective Sample Size (ESS) value displayed in the Post Burn-In Summary is the number of independent samples the MCMC has taken from the posterior distribution of all parameters. A low ESS in relation to the total number of iterations suggests that the MCMC has not moved very far with each step or has had a low acceptance rate. A low absolute value of ESS (e.g., 10s or 100s) will mean that there is potential for a large difference in weights if the analysis was run again. On its own (and without any other indication of sub-optimal results) a small ESS is not an indication that rework is required.

2.8.20.9.1.4 The log(likelihood) value displayed in the Post Burn-In Summary is the log of the average likelihood (or probability) value created at each of the post burn-in MCMC iterations. The larger this value the better STRmix™ has been able to describe the observed data. A negative value suggests that STRmix™ has not been able to describe the data very well given the information it has been provided. Reasons why this value may be low or negative are:

- The profile is simply very low level and there is very little data making up the likelihood.

- The proposed number of contributors does not model well (and may be incorrect), forcing an interpretation of large stochastic events (e.g., large heterozygote peak imbalances or variation in mixture proportions across the profile) in the STRmix™ run.

- Data has been removed that was real, (e.g., stutter peaks), forcing an interpretation of dropout by STRmix™.

- Artifacts have been left labelled (not removed) in the imported data, forcing an interpretation of drop-in by STRmix™.
2.8.20.9.1.4.1 A low or negative value for the average log(likelihood) may indicate to users that the analysis requires additional scrutiny.

2.8.20.9.1.4.2 Good quality mixed DNA profiles are likely to give higher average log(likelihood) values than good quality single source profiles.

2.8.20.9.1.4.3 Low average log(likelihood) values alone are not necessarily an indicator of an issue, especially if the profile is single source.

2.8.20.9.1.5 The Gelman-Rubin Convergence Diagnostic (GR) value displayed in the Post Burn-In Summary informs the user whether the MCMC analysis has likely converged. STRmix™ uses multiple MCMC chains to carry out the deconvolution, and ideally each chain will be sampling in the same space after burn-in. Too few accepts may result in a failure to converge. If the chains spend their time in different spaces then it is likely that the analysis has not run for sufficient iterations. Whether or not the chains have spent time in the same space can be gauged by the within-chain and between-chain variances. These two variances are used to calculate the variance of what is called the ‘stationary distribution’. If all chains have sampled the same space then the within chain variance and the variance of the stationary distribution will be approximately equal. If chains have spent time in different spaces then the variation between the chains is likely to be larger than the variation within the chains. The GR is the ratio of the stationary distribution and within-chain variances. For a perfectly converged analysis, GR = 1.

2.8.20.9.1.5.1 If the GR is above 1.2 then there exists the possibility that the analysis hasn’t converged. If the GR value is above 1.2, STRmix™ will automatically run an additional 50,000 post burn-in accepts. This may decrease the GR to below 1.2, yielding a clearer deconvolution.

2.8.20.9.1.5.2 If the GR continues to remain above 1.2 after the additional post burn-in accepts, this may be an indicator that the sample requires rework.

2.8.20.9.1.6 The allele and stutter variance data depicted in the Variance Charts (see below) can be used as a guide as to the level of stochastic variation in peak heights that is present in the profile. The values listed in the Post Burn-In Summary of the report include the average value for allele variance and stutter variance constants across the entire post burn-in MCMC analysis.
2.8.20.9.1.6.1 If the variance constant has increased markedly from the mode of the prior distribution, then this may indicate that the DNA profile is sub-optimal or that the number of contributors is incorrect.

2.8.20.9.1.6.2 Used in conjunction with the average log(likelihood), a large allele variance or stutter variance constant can indicate poor PCR.

2.8.20.9.1.6.2.1 A low-level sample may result in a low average log(likelihood) and an average variance constant.

2.8.20.9.1.6.2.2 Data with missing information, extra information (e.g., artifact peaks), or misinterpreted data may result in a low average log(likelihood) and high variances.

2.8.20.10 Database Search Review

2.8.20.10.1 In the Database Search Report, verify that no positive associations with LR \( \geq 10,000 \) have occurred.

2.8.20.10.2 Any database matches with a LR \( \geq 10,000 \) should be evaluated for the likelihood of potential contamination. The Technical Leader shall be notified, with documentation in the case file. Appropriate report wording shall be utilized if contamination is suspected.

2.8.20.10.2.1 Any samples with database matches (LR \( \geq 10,000 \)) corresponding to an individual working inside the Evansville, Ft. Wayne, Indianapolis, or Lowell regional laboratories shall be reported as inconclusive.

2.8.20.10.2.2 Other (e.g., law enforcement, ISP CSI, etc.) database matches (LR \( \geq 10,000 \)) may be interpreted with caution and acknowledged in the report wording.

2.8.20.11 Comparing Sample Deconvolutions to Reference Standards (LR From Previous)

2.8.20.11.1 A reference standard may be visually excluded without STRmix™ analysis.

2.8.20.11.2 To compare reference STR profiles to a previously-run STRmix™ deconvolution, from the STRmix™ main menu, select LR From Previous.

2.8.20.11.3 In the Choose Previous Analysis window, select Select File and navigate to the .xml file for the appropriate STRmix™ deconvolution or drag and drop the deconvolution folder into the window, and select OK.
2.8.20.11.4 In the Configure Analysis box, leave the Case Number as it is carried over. In the “Sample ID” box the appropriate LR number should be added behind LRPrev (e.g., 001A_Decon1_LRPrev1). Each LR calculated from a deconvolution shall have a unique identifier. If additional characters are added to the “Sample ID” designation at this step, those characters shall be added after the specified naming convention.

2.8.20.11.5 The number of contributors, number of burn-in accepts per chain, and number of post burn-in accepts per chain will be grayed out and cannot be changed. No changes should be made to Run Settings.

2.8.20.11.6 Add a new profile to the box marked Add Reference Profile Data. This may be done by selecting Add Reference and navigating the file tree, or by dragging and dropping the appropriate GeneMapper® ID-X export file or previous STRmix™ evidence file into the box. Multiple reference profiles may be added, one at a time or highlight and add multiple profiles at one time.

2.8.20.11.6.1 If a locus in the reference profile has potential allelic drop-out (a single allele ≤ 750 RFU), the locus shall be omitted from the LR from Previous calculation.

2.8.20.11.7 Select Confirm Settings.

2.8.20.11.8 In the Population Settings box, verify that the NIST_2017 population databases for African American, Asian, Caucasian, and Hispanic Populations are listed for analysis, HPD iterations is set to 1,000, that Quantile is set to 99, that Sides is set to 1, and that the Factor of N! LR, Calculate HPD, and Include MCMC uncertainty boxes are checked.

2.8.20.11.9 Select Start. This will begin the LR calculation of the chosen sample.

2.8.20.11.10 When the analysis is complete, STRmix™ will generate several data files and save them to the Results folder on the C: drive.

2.8.20.11.11 Save the results folder for the LR calculation containing all appropriate STRmix™ files to the corresponding deconvolution master folder located on the DNA server for the appropriate case.

2.8.20.12 LR Calculations

2.8.20.12.1 Each analyzed proposition (and therefore each LR From Previous report) will contain a generated set of calculations including a Likelihood Ratio (LR) Total, Factor of N! LR, a 99% 1-Sided Lower HPD Interval, and a Stratified LR.

2.8.20.12.2 The LR Total is a ratio between the probability of the evidence given two competing propositions or hypotheses, and forms the basis for subsequent statistical calculations.

2.8.20.12.2.1 Calculations for LR Total utilize the National Research Council recommendation 4.2, equations 4.10, more commonly referred to as the Balding & Nichols formulae.

\[
\text{Homozygous } \frac{[2θ + (1-θ)p][3θ + (1-θ)p]}{[1+θ][1+2θ]}
\]

\[
\text{Heterozygous } \frac{2[θ + (1-θ)p][θ + (1-θ)q]}{[1+θ][1+2θ]}
\]
2.8.20.12.2.1.3 Each locus LR shall be multiplied together to form the multi-locus LR for the profile.

2.8.20.3 The Factor of N! LR is a calculation that uses the LR Total with additional consideration for the number of ways to combine the different contributor probabilities in a mixture.

2.8.20.4 The HPD calculation uses the Factor of N! with additional consideration for the uncertainty in the allele frequencies and deconvolution process. HPD is the most conservative of the three calculations and will be used for reporting the significance of a comparison.

2.8.20.5 The Stratified LR utilizes the HPD calculations and population settings to produce a single LR that samples across all the calculated populations.

2.8.20.6 Additionally, a Unified LR may be calculated under propositions that consider only a single person of interest. The unified LR takes into account that the unknown contributor(s) are made up of both unrelated people and relatives of the person of interest. These calculations may be most useful when the alternate proposition is that the true donor of the evidence sample is a relative of the person tested.

2.8.20.13 Troubleshooting STRmix™ Results

2.8.20.13.1 After a STRmix™ analysis has completed, the results are interpreted by examining the weightings of various genotypes and the DNA results observed. There are instances when the results obtained do not intuitively seem correct. Examples of this are:

- Large LRs (greater than 1) are obtained for each locus, except one where the LR is 0.
- The mixture proportions do not reflect what is observed.
- The interpreted contributor genotypes are not intuitively correct.

2.8.20.13.2 Possible causes for these issues include:

- The MCMC has not run for enough iterations.
- The number of contributors has not been correctly chosen.
- An artifact was left in the GeneMapper® ID-X interpretation.

2.8.20.13.3 Should the weights and/or the diagnostics highlight to the user that further scrutiny is necessary then a number of rework options are available, if required. For example a review of the proposed number of contributors could be considered. Further analytical work such as a re-electrophoresis, a re-amplification, or a clean up to strengthen the number of contributors assumption or assist with allele designation/sub optimal PCR performance. Extended total iterations (x10) may be considered, if the acceptance rate is low, the ESS is low and/or the GR value is significantly above 1.2. If extended iterations are manually utilized, the Technical Leader shall be notified with documentation included in the case record.

2.8.20.13.3.1 Additional troubleshooting options may be available after consultation with the Technical Leader (documented in the case record). This may
include utilizing informed priors to designate the mixture proportions utilized in the deconvolution.

2.8.20.13.4 If after comparison to a reference sample from a person of interest, an analyst suspects an error was made during the interpretation of the sample (e.g., determining the wrong number of contributors or an artifact was not deleted), independent analysis and interpretation of the profile by the Technical Leader or his designee shall be performed. A referee analysis is not required if the error determined after comparison to a reference profile of an individual who may be assumed present in the sample. If the error is caught during technical review of the case, and the reviewer has not examined the profiles of the person(s) of interest, the referee analysis is not required.

2.8.20.13.4.1 The analyst shall only provide the .hid files for the unknown sample of concern and the allelic ladder to the Technical Leader. If a reference standard may be assumed, the .hid file for that reference may also be included. No additional case information or information regarding the interpretation issue shall be given. The Technical Leader may request limited additional information only if it is needed for analysis.

2.8.20.13.5 In a single source sample, if an error is discovered that did not affect the STRmix deconvolution of the sample (ex. a pull-up peak was not deleted, but it was modeled as drop-in), a second deconvolution does not need to be performed. The error shall be documented in the case record with an explanation why it did not affect the interpretation.

2.8.20.13.5.1 An error of this type requires a new deconvolution in a mixed sample.

2.8.20.14 Use of STRmix™ to aid in deconvolution of mixtures for CODIS entry

2.8.20.14.1 Additional STRmix™ deconvolutions utilizing conditioning may be performed to aid in the deconvolution of a mixture for improved CODIS entry.

2.8.20.14.1.1 If a mixture includes support for inclusion of a suspect reference profile (an LR has been calculated in support for H₁), the mixture may be deconvoluted conditioning on that reference profile to provide improved genotype weightings of an additional contributor to be entered into the database.

2.8.20.14.1.1.1 The case documentation of this deconvolution shall be clearly marked as for CODIS purposes only.

2.8.20.14.1.1.2 The analyst shall ensure all alleles to be entered in CODIS are present in the original mixture.

2.8.20.14.1.1.3 The original deconvolution should generally be utilized for comparison if an evidentiary reference standard is submitted at a later date.

2.8.20.14.1.2 If a mixture indicates that an additional single source unknown profile in the case cannot be excluded as a contributor, that unknown profile may be utilized to improve genotype weightings of an additional contributor for CODIS entry.

2.8.20.14.1.2.1 The single source unknown profile may be reanalyzed in GeneMapper® ID-X utilizing reference profile settings.
2.8.20.14.1.2.1 The mixture may be deconvoluted conditioning on the reanalyzed single source unknown profile.

2.8.20.14.1.2.3 The analyst shall ensure all alleles to be entered in CODIS are present in the original mixture.

2.8.20.14.1.2.4 The case documentation of the reanalysis and the deconvolution shall be clearly marked as for CODIS purposes only.

2.8.20.14.1.2.5 The original deconvolution with no conditioning on the unknown profile shall be utilized for all LR calculations.

2.8.20.15 Use of the STRlite Excel program

2.8.20.15.1 The ISP STRlite Excel program shall be utilized to provide a summary of GeneMapper® ID-X allele calls for reference and unknown samples; as well as information collated from the STRmix™ deconvolution, database search and LR from Previous reports for sample analysis utilized in the interpretation of the profile.

2.8.20.15.1.1 STRlite v1.3 (or most current version as approved by the Technical Leader) shall be utilized.

2.8.20.15.1.2 Printed worksheets, as appropriate, from the five tabs (Pre-STRmix, Deconvolution, Likelihood Ratios, Standards and CODIS) of the STRlite program shall be maintained in the case record. An electronic copy of STRlite containing results shall not be maintained on the DNA server to avoid duplication of items between LIMS and the server.

2.8.20.15.1.2.1 The STRlite Deconvolution page shall be printed for all deconvolutions that represent a valid interpretation of the profile.

2.8.20.15.1.2.1.1 If an analyst error is made during a deconvolution run (e.g. An unintended number of contributors was entered, a pull-up peak was not deleted etc.), the Deconvolution page does not need to be printed for that run, but the STRmix™ deconvolution files shall be maintained electronically and the case record shall document why the run was not used.

2.8.20.15.1.2.2 For single source profiles, the analyst shall manually add results for Amelogenin to the CODIS worksheet. The Y-STR loci should be added to the CODIS worksheet when applicable.

2.8.20.15.1.2.3 For mixed profiles, the analyst may manually add results for Amelogenin and the Y-STR loci to the CODIS worksheet if they feel the data supports the determination.

2.8.20.15.1.3 The electronic STRmix™ reports saved to the case folder on the DNA server shall be referenced for further troubleshooting as needed.

2.9 Records:

2.9.1 The appropriate worksheets as contained in the Worksheet Manual, STRlite, or the equivalent workbooks shall be used to record all procedures.

2.9.2 All data sheets, notes, photographs, and other information generated from the laboratory examination shall be kept in the case record.
2.9.3 The technical review of the case record shall be recorded on the technical review worksheet.

2.9.4 Electronic records shall be retained as indicated in Appendix 9.

2.10 Interpretations of Results:

2.10.1 Interpretation guidelines are located within the Procedures Section 2.8.

2.11 Report Writing for DNA Analysis:

2.11.1 Reporting and Statistics Rules (see 1.11 for report formatting)

2.11.1.1 When a subitem is reported it shall be bolded if the original item is not present and was previously reported.

2.11.1.2 When a person or a group of people are excluded from a sample, they do not have to be mentioned at every sample from which they are excluded.

2.11.1.3 A unique unknown individual may be determined and reported if there are twelve or more complete autosomal loci with > 99% weighting in a single source sample or a single profile determined from a mixture.

2.11.1.3.1 A unique individual shall be identified in the report as male or female if an unambiguous determination can be made from Amelogenin and the Y-STR loci results.

2.11.1.3.2 A unique unknown individual can be reported as being included/excluded from other single source or mixed samples in the case record at the analyst's discretion. Care should be taken to ensure that this conclusion is unambiguous as the comparison within STRmix™ will not take place until a standard is submitted.

2.11.1.4 Specific genotypes shall not be reported.

2.11.1.5 When differential extractions are employed, the terminology “sperm [cell] fraction” and “non-sperm [cell] fraction” shall be used in the report.

2.11.1.5.1 When both fractions of a differential extraction exhibit the same testing result, the results may be reported as a single result referring to the item only and not the individual fractions.

2.11.1.5.1.1 If both fractions of the same extract have different results regarding insufficient male DNA or no male DNA, the results may be reported as a single result using the appropriate insufficient male DNA wording.

2.11.1.6 When reporting a mixture, the assumed number of contributors shall be stated.

2.11.1.7 All swabs in an item (excluding standards) not tested shall be referenced as not tested in the report using the appropriate wording.

2.11.1.8 When two or more samples are combined at any point in the analysis process, the report shall refer to the samples as “combined”. The analyst's notes shall clearly describe which samples and at which stage of the process the samples were combined.

2.11.1.8.1 If all subitems or samples within the item are not combined into one extract, the report shall indicate which subitems/samples are combined.

2.11.1.9 When a cross-case comparison is performed, the Indiana State Police Laboratory item XXX, case XXX-XXXXXX, and Agency case XXXX shall be used to identify the appropriate item.
2.11.1.9.1 If the comparison is performed to a different agency’s case implicating an individual, additional identifiers for the individual should be included whenever possible. (i.e. birth date or Department of Correction number).

2.11.1.9.2 Individual items from another case should not be listed in the item descriptions or as separate items in the body of the report.

2.11.1.10 The appropriate CODIS statement shall be included for every report detailing a new unknown DNA profile. When profiles are entered into CODIS, the statement will be included with the results for that item. Otherwise, the CODIS statement may be at the end of the report.

2.11.1.11 In a sample with insufficient (male) DNA for amplification, where it is valuable to identify a male contributor from a female contributor (i.e. sexual assault cases), the Quantifiler® Trio Y Target results shall be reported.

2.11.1.12 Report wording may be altered with the approval of a Biology Unit Supervisor.

2.11.1.13 All positive associations shall utilize a STRmix™ deconvolution and have a statistical evaluation applied and reported. The only exceptions being the following:

2.11.1.13.1 The owner on an intimate sample or an elimination standard reasonably assumed to be present on an item. Report wording shall include a statement indicating that the assumption was made. Report wording is provided to be used with standards assumed to be present on an item.

2.11.1.13.1.1 A profile may be reported as being consistent with an assumed individual with no conclusions drawn on the remainder of the sample due to the inability to determine a number of contributors utilizing the specified report wording.

2.11.1.13.2 A profile from one fraction of a differential extraction that is consistent with a conditioned individual and a profile from the corresponding fraction.

2.11.1.13.2.1 The profile from the corresponding fraction may be utilized if it is single source or a single source profile determined by conditioning.

2.11.1.14 Statistical evaluations in which a likelihood ratio favors the defense proposition shall be reported.

2.11.1.15 DNA mixtures in which multiple reference profiles indicate inclusion (LR support for $H_1$) shall have multiple LR propositions calculated. The reference profile LRs shall be run individually to indicate individual weight in the mixture. Additionally, LRs shall be calculated to indicate the weight of all included individuals combined together in the mixture.

2.11.1.15.1 There may be scenarios when multiple individuals (possibly even more individuals than present in the mixture) have a LR supporting $H_1$ when compared to an evidence profile in isolation; however, the LR could favor exclusion when the individuals are compared to the evidence profile in combination with each other. In this scenario, the evidence profile could not have come from that combination of individuals. Such groups are termed ‘incompatible’ as, combined, they are incompatible with the evidence profile. This scenario is not unexpected when related individuals are compared to minor or low level DNA profiles. When appropriate, an analyst can attempt to test different combinations to provide further information. However, it is not always possible to test or list all incompatible groups.
2.11.1.16 When multiple LR propositions are calculated, it is recommended that the analyst report
the single proposition that most reasonably explains the evidence based on the case
information available, if possible. Case circumstances will dictate which of these
calculations are most appropriate for the report and multiple propositions may need to be
reported.

2.11.1.16.1 Reporting individual LRs is required when the LR favoring inclusion of one
individual falls in a different level of the verbal scale than the other individual.
However, if each individual LR falls in the same level of the verbal scale (i.e. all
individuals indicate very strong support for \( H_1 \)), it is appropriate to only report the
combined LR.

2.11.1.16.2 The combined LR shall be reported when the calculated LR of all individuals
combined equals 0 (no support for the individuals making up the mixture
together).

2.11.1.16.2.1 The appropriate inclusionary individual LRs shall be reported along with
the additional report wording statement indicating the individuals cannot
make up the mixture together.

2.11.1.17 Analysts have the discretion to report unambiguous exclusions without using STRmix™
to calculate a LR. Exclusions without a calculated LR value are not required to be
reported; however, where appropriate, the following statement may be reported within
the item description (after appropriate inclusionary LRs):

2.11.1.17.1 John Doe is excluded as a possible contributor to this profile/mixture.

2.11.1.18 If the analyst cannot clearly exclude an individual, STRmix™ may be used to assist in
the comparison. If STRmix™ is utilized to determine an exclusion, the appropriate
exclusion statement shall be included in the report for that individual.

2.11.1.18.1 LR values less than 1 favor the defense proposition (\( H_2 \)). LR values less than 1
will be evaluated for the verbal equivalent as 1/LR.

2.11.1.18.1.1 1/LR values between 2 and 99 will be reported as limited support for
exclusion and will include the hypotheses and calculated 1/LR value in
the report as stated in the report wording guidelines.

2.11.1.18.1.2 1/LR values above 99 shall use the general exclusion statement as stated
in the report wording guidelines.

2.11.1.18.1.3 An LR value of zero indicates no scientific support for the prosecution
proposition (\( H_1 \)) and shall use the general exclusion statement as stated
in the report wording guidelines.

2.11.1.19 99% 1-sided lower HPD LR values will be calculated for the four subpopulations (African
American, Asian, Caucasian and Hispanic).

2.11.1.19.1 When all four LR values are in the support of \( H_1 \), the lowest LR of the four
calculated populations will be reported, rounded down to two significant figures.

2.11.1.19.1.1 If the lowest LR in support of \( H_1 \) is less than 2, it shall be rounded down to
1.0 (uninformative).

2.11.1.19.2 If any of the four LR values is in support of \( H_2 \), the highest 1/LR value favoring
\( H_2 \) will be reported, rounded up to two significant figures.
2.11.1.19.2.1 If the highest LR in support of H₂ is less than 2, it shall be rounded up to 2.0 (limited support for exclusion).

2.11.1.19.3 If any of the four calculated populations have a LR of zero, the LR shall be reported as zero.

2.11.1.20 When reporting out the Likelihood Ratio, it can be reported numerically or in word form, (i.e. 1,000,000 versus 1 million).

2.11.1.21 A reporting ceiling of 1 trillion will be utilized. When a calculated LR is more than 1 trillion times more likely for all four population groups the phrase “at least 1 trillion” shall be utilized in place of the calculated LR number.

A verbal scale shall accompany the LR result in an effort to provide additional explanation of the weight of the evidence.

<table>
<thead>
<tr>
<th>HPD Likelihood Ratio (or 1/LR)</th>
<th>Support of H₁ Verbal equivalent</th>
<th>Support of H₂ Verbal equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>uninformative</td>
<td>uninformative</td>
</tr>
<tr>
<td>2 ≤ HPDₐ₁LR &lt; 100</td>
<td>provides limited support</td>
<td>provides limited support</td>
</tr>
<tr>
<td>100 ≤ HPDₐ₁LR &lt; 10,000</td>
<td>provides moderate support</td>
<td>exclusion</td>
</tr>
<tr>
<td>10,000 ≤ HPDₐ₁LR &lt; 1,000,000</td>
<td>provides strong support</td>
<td>exclusion</td>
</tr>
<tr>
<td>1,000,000 ≤ HPDₐ₁LR</td>
<td>provides very strong support</td>
<td>exclusion</td>
</tr>
</tbody>
</table>

2.11.1.22 Additional LR calculations performed by request after the initial report has been released shall be reported in a Supplemental Certificate of Analysis.

2.11.1.23 Reports issued with a verbal equivalent statement prior to September 24, 2018 shall not be reissued unless new statistical comparisons are made. If new comparisons are made, the verbal equivalents shall be updated as appropriate and appropriate wording shall be added to the report to indicate the change.

2.11.1.24 Any statistical result for analysis reported prior to July 13, 2015 shall be recalculated with the original statistical method used and appropriate updated allele frequencies utilizing IndySTR v2.2_04-01-2016 if:

2.11.1.24.1 Additional evidence is submitted in the case;

2.11.1.24.2 The case is going to court; or

2.11.1.24.3 Upon request;

2.11.1.24.4 If the reported statistical results change, a new (2.11.1.23.1) or amended (2.11.1.23.2 and .3) Certificate of Analysis shall be issued with notification included in the report and the statistical worksheets uploaded under the associated request number. If the reported statistical results do not change, the new statistical worksheets shall be uploaded under the original request number as v2.

2.11.1.25 See Appendix 7 for specific wording examples.

2.12 References:


2.12.8 Promega Corporation. DNA IQ™ Casework Sample Kit for Maxwell® 16. Part No. TB 354. 2009 or most current issue.

2.12.9 Promega Corporation. Tissue and Hair Extraction Kit (for use with the DNA IQ™). Part No. TB307. 2006 or most current issue.


2.12.21 Institute of Environmental Science and Research Limited. STRmix™ V2.5 Operation Manual. 30 June 2017 or most current version.


3. Forensic Relationship Comparison Methods:

3.1. Scope:

3.1.1. Forensic relationship comparisons may be requested as part of some criminal investigation cases. Types of relationship comparisons that can be performed include paternity, maternity, reverse paternity, sibling relationship (sibship), etc. These comparisons may establish potential relationships among individuals and/or aid in the identification of human remains and missing persons. Samples for forensic relationship testing shall be processed in accordance to the test methods outlined in the DNA methods section of this document.

3.2. Precautions/Limitations:

3.2.1. Cases submitted for relationship comparisons should be evaluated by a member of the relationship comparison team before any testing is performed. It may be necessary to outsource some types of cases to a vendor laboratory for analysis. Cases shall be refused when they do not meet the requirements of forensic relationship comparison analysis.

3.3. Related Information:

3.3.1. See Relationship Comparison Statistical Reference Sheet (Appendix 10)

3.4. Instruments:

3.4.1. See DNA Test Methods Section 2.4

3.5. Reagents/Materials:

3.5.1. See DNA Test Methods Section 2.5

3.6. Hazards/Safety:

3.6.1. See DNA Test Methods Section 2.6

3.7. Reference Materials/Controls/Calibration Checks:

3.7.1. See DNA Test Methods Section 2.7

3.8. Procedures/Instructions:

3.8.1. See DNA Test Methods Section 2.8

3.9. Interpretations of Relationship Testing Results:

3.9.1. Possible Outcomes of Relationship Comparisons

3.9.1.1. The genetic profiles from standards and samples are compared to evaluate relationship. The following conclusions may be reported:

3.9.1.2. For parentage relationship cases:

3.9.1.2.1. The genetic results strongly support the hypothesis of the alleged relationship; therefore, the alleged individual cannot be excluded from the relationship. [Combined Parentage Index (CPI) >100]

3.9.1.2.2. The genetic results do not strongly support the hypothesis of the alleged relationship nor does it indicate no relationship; therefore, it is deemed inconclusive. An inconclusive result may also be derived if a genetic profile cannot be interpreted or is of poor quality. [100 > Combined Parentage Index (CPI) > 1]
3.9.1.2.3. The genetic results support the hypothesis of no relationship; therefore, the alleged individual can be excluded from the relationship. [Combined Parentage Index (CPI) <1]

3.9.1.3. For non-parentage relationship cases:

3.9.1.3.1. The genetic results support the hypothesis of the alleged relationship. [Combined Relationship Index (CRI) >10]

3.9.1.3.2. The genetic results do not strongly support the hypothesis of the alleged relationship nor does it indicate no relationship; therefore, it is deemed inconclusive. [10 > CRI > 0.05]

3.9.1.3.3. The genetic results support the hypothesis of no relationship. [CRI <0.05]

3.9.2. Inconsistent Profiles In Parentage Relationship Cases

3.9.2.1. If the alleged father’s profile is inconsistent with the child’s obligate paternal alleles at more than three loci with PowerPlex® Fusion 6C, then no relationship/exclusion shall be concluded.

3.9.2.2. If the alleged father’s profile is inconsistent with the child’s obligate paternal alleles at fewer than four loci with PowerPlex® Fusion 6C, then other alternatives may be evaluated for these inconsistencies. Other alternatives may include possible mutation, null allele, first degree relative, or true exclusion. If it is determined that a possible mutation could account for the inconsistencies, then the mutation shall be included into the statistical calculations.

3.9.3. Mixtures

3.9.3.1. With product of conception/fetal samples, it is necessary to have a standard from the mother. Only loci where the obligate paternal allele can be determined shall be used for statistical purposes.

3.9.3.1.1. The obligate paternal alleles may be deduced when appropriate.

3.9.3.2. With personal effects believed to belong to a missing person, the degree of the mixture shall be evaluated to determine whether conclusive results can be obtained. Additional standards may be requested to aid in interpretation.

3.10. Rules for Relationship Statistical Calculations:

3.10.1. Calculations shall be performed using the most current available version of Popstats (the version shall be documented in the case record), a computer software program designed by the FBI for statistical calculations.

3.10.2. Statistical calculations shall be calculated and reported in forensic relationship comparison cases where Results/Opinions/Interpretations are being given in regards to relationship. However, statistical calculations shall not be performed in parentage cases with conclusions of no relationship/exclusion.

3.10.3. D12S391 and vWA may demonstrate linkage disequilibrium for some relationships (i.e. sibships and incestuous parentage) and may not be eligible for incorporation into the Combined Relationship Index using the product rule. When genetic information is available from both loci, only D12S391 shall be used for statistical evaluation; unless a possible mutation has occurred at vWA, in which case only the mutation calculation for vWA shall be used; or in the case of sibship where at least one allele is shared at D12S391 but no allele sharing occurs at vWA, then vWA shall be used.
3.10.4. The addition of Y-STR loci (DYS391, DYS576, and DYS570) into the PowerPlex® Fusion 6C system is intended to assist with interpretation of the number of male contributors in a sample and with samples demonstrating a possible null Y allele at Amelogenin. Therefore, statistical evaluation of the Y-STR loci shall not be performed or incorporated in the Combined Relationship Index unless a mutation is suspected.

3.10.5. See Relationship Comparison Statistical Reference Sheet (Appendix 10) for a list of formulas for calculations.

3.10.6. If more than one standard/sample is available for comparison, the most representative standard/sample or the standard/sample where the most obligate paternal alleles can be determined shall be used for statistical calculations.

3.10.7. Relationship statistical calculations utilize the race of the alleged individual. The calculations shall be performed with the appropriate population data using the racial information provided by the contributing agency. If racial information is unknown or unobtainable, calculations shall be performed using each population group.

3.10.8. Manual calculations performed by an analyst shall be verified by a qualified technical reviewer and/or a qualified unit supervisor.

3.10.9. A Prior Probability (Pr) of 0.5 shall be used for all relationship calculations.

3.10.10. The Paternity Index for a locus demonstrating a possible mutation shall be calculated using the average locus mutation rate (µ) and the Probability of Exclusion (PE) determined by the obligate paternal allele. See Appendix 10 for a list of mutation rates and PE formulae.

3.10.10.1. In the event that a mutation is suspected at one Y-STR locus, a mutation factor of 0.001 shall be used as a haplotype Relationship Index and incorporated into the Combined Relationship Index. If a mutation is suspected at more than one Y-STR locus, the analyst may recommend additional genetic testing with consultation from the Technical Leader.

3.10.11. Mutation rates for historical loci (PowerPlex® 16 HS and SE33) have been reported in the AABB (American Association of Blood Banks) Annual Summary. For any locus without a published mutation rate, the rate shall be calculated by averaging the available tetranucleotide STR mutation rates (excluding SE33).

3.11. Report Writing for Relationship Comparisons General Guidelines:

3.11.1. The DNA profiles shall be reported in table format in the Results/Opinions/Interpretations area of the Certificate of Analysis. The Paternity Index for each locus, the Combined Paternity Index, and the Probability of Paternity shall be reported in the table when applicable.

3.11.2. All reports shall include the required loci analyzed/kit utilized statement and retention statement listed in the report wording section (Appendix 7).

3.11.3. The items used for comparison will be reported in the format listed in the report wording section (Appendix 7).

3.11.4. Alternate report wording may be used depending on the type of relationship and calculation performed.

3.11.5. Terminology of Parentage, Paternity, Maternity, Relationship, Kinship, and Sibling Relationship (Sibship) may be used interchangeably where applicable.
3.11.6. The Combined Paternity Index and the Paternity Index shall be reported as calculated by Popstats. However, any Popstats calculation of the Combined Paternity Index with a decimal value shall be rounded down to the nearest whole number.

3.11.7. The Probability of Paternity shall be reported to four decimal places. Paternity Index calculations shall be truncated to four significant figures for manual calculations.

3.11.8. Wording of Relationship Comparisons for Results/Opinions/Interpretations are located in Appendix 7.

3.12. Definitions:

3.12.1. Random Man Not Excluded (RMNE) – The frequency of selecting a random man from the population that could not be excluded as the biological father.

3.12.2. Probability of Exclusion/Power of Exclusion (PE) – The probability of excluding a random man from the population as being the biological father; is dependent on the genotypes of the child and mother and the race of the alleged father.

3.12.3. Parentage Index (PI)/Relatedness Index (RI) – A likelihood ratio based on two different conditional probabilities; PI/RI is calculated for each locus in a system.

3.12.4. Combined Parentage Index (CPI)/Combined Relatedness Index (CRI) – CPI/CRI is the product of all PIs/RIs for the loci in a system; a measure of the strength of the genetic evidence.

3.12.5. Probability of Parentage (W) – Also known as the probability of relatedness. It is the measure of the strength of the genetic evidence and the non-genetic evidence that an individual is a biological relative as compared to an unrelated, random individual in the same population.

3.12.6. Prior Probability (Pr) – The strength of the non-genetic evidence that the alleged individual is a biological relative.
4. Y-STR Test Methods:

4.1. **Scope**: Y-STR analysis may be performed in situations where male DNA needs to be differentiated from female DNA. DNA analysis performed prior to Y-STR analysis shall be in accordance to the test methods outlined in the DNA Methods section of this document.

4.2. **Precautions/Limitations**: Samples that may be suitable for Y-STR analysis should be evaluated by a member of the Y-STR team to determine the most appropriate sample(s) to analyze in a case. The following should be considered:

4.2.1.1. Cases that have not provided meaningful autosomal results should be considered for analysis.

4.2.1.2. Cases from sexual assault/misconduct should be considered for analysis.

4.2.1.2.1. Due to the limitations of the technology, property crimes generally will not be considered for analysis.

4.3. **Related Information**:

4.3.1. Worksheet Manual

4.4. **Instruments**:

4.4.1. See DNA Test Methods Section 2.4

4.5. **Reagents/Materials**:

4.5.1. See DNA Test Methods Section 2.5

4.6. **Hazards/Safety**:

4.6.1. See DNA Test Methods Section 2.6

4.7. **Reference Materials/Controls/Calibration Checks**:

4.7.1. See DNA Test Methods Section 2.7

4.8. **Procedures/Instructions**:

4.8.1. See DNA Test Methods Section 2.8 for extraction procedures

4.8.1.1. Performing Y-STR analysis before or after autosomal STR analysis will be evaluated on a case by case basis.

4.8.1.2. Y-STR analysis may be performed on extracts previously used for autosomal STR testing or may require re-extraction of a sample.

4.8.1.3. The male quantification value using Quantifiler® Trio shall be used for amplification of the sample.

4.8.2. **PowerPlex® Y23 (Applied Biosystems® 3500 Genetic Analyzer)**

4.8.2.1. **Introduction**

4.8.2.1.1. Short tandem repeat (STR) markers on the Y chromosome (Y-STR) have qualities that are distinct from autosomal markers and are useful for human male identification. The Promega PowerPlex® Y23 System allows co-amplification and four-color detection of twenty-three loci. The amplification occurs in a single reaction tube and detection occurs by a single capillary electrophoresis injection.

4.8.2.1.2. The Applied Biosystems® 3500 Genetic Analyzer utilizes electrokinetic injection of DNA molecules into polymer-filled capillaries which separates the DNA fragments.
by size. The fluorescent tag labeled primers incorporated into the PowerPlex® Y23 amplification products are responsive to the frequency of the 20 mW solid state laser. Upon excitation, the fluorophores are raised to a higher energy level. When the fluorophores return to their normal energy level, a fluorescent signal is emitted. This signal is then detected by a camera within the 3500 capillary electrophoresis instrument which converts the signal to a computer image where it is visualized in an electropherogram as a peak.

4.8.2.1.3. The data produced by the Applied Biosystems® 3500 Genetic Analyzer is analyzed with GeneMapper® ID-X Software which results in peaks labeled with their allele designation. The Internal Lane Standard (WEN ILS 500) is injected with each sample and it contains 21 fragments of 60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500 bases in length. Each fragment is labeled with WEN dye and can be detected separately (as a fifth color) in the presence of PowerPlex® Y23 amplified material. The Internal Lane Standard determines the base pair size of the fragments in the sample and the software compares the sizes to an allelic ladder to determine the allele designation.
## The PowerPlex® Y23 System Locus-Specific and Allelic Ladder Information:

<table>
<thead>
<tr>
<th>STR Locus</th>
<th>Chromosomal Location</th>
<th>Repeat Sequence&lt;sup&gt;2&lt;/sup&gt;</th>
<th>Label</th>
<th>Size Range of Allelic Ladder Components&lt;sup&gt;3,4&lt;/sup&gt; (bases)</th>
<th>Repeat Numbers of Allelic Ladder Components&lt;sup&gt;5&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS576</td>
<td>Y</td>
<td>AAAG</td>
<td>Fluorescein</td>
<td>97-145</td>
<td>11-23</td>
</tr>
<tr>
<td>DYS389 I</td>
<td>Y</td>
<td>(TCTG) (TCTA)</td>
<td>Fluorescein</td>
<td>147-179</td>
<td>9-17</td>
</tr>
<tr>
<td>DYS448</td>
<td>Y</td>
<td>AGAGAT</td>
<td>Fluorescein</td>
<td>196-256</td>
<td>14-24</td>
</tr>
<tr>
<td>DYS389 II</td>
<td>Y</td>
<td>(TCTG) (TCTA)</td>
<td>Fluorescein</td>
<td>259-303</td>
<td>24-35</td>
</tr>
<tr>
<td>DYS19</td>
<td>Y</td>
<td>TAGA</td>
<td>Fluorescein</td>
<td>312-352</td>
<td>9-19</td>
</tr>
<tr>
<td>DYS391</td>
<td>Y</td>
<td>TCTA</td>
<td>JOE</td>
<td>86-130</td>
<td>5-16</td>
</tr>
<tr>
<td>DYS481</td>
<td>Y</td>
<td>CTT</td>
<td>JOE</td>
<td>139-184</td>
<td>17-32</td>
</tr>
<tr>
<td>DYS549</td>
<td>Y</td>
<td>GATA</td>
<td>JOE</td>
<td>198-238</td>
<td>7-17</td>
</tr>
<tr>
<td>DYS533</td>
<td>Y</td>
<td>ATCT</td>
<td>JOE</td>
<td>245-285</td>
<td>7-17</td>
</tr>
<tr>
<td>DYS438</td>
<td>Y</td>
<td>TTTTC</td>
<td>JOE</td>
<td>293-343</td>
<td>6-16</td>
</tr>
<tr>
<td>DYS437</td>
<td>Y</td>
<td>TCTA</td>
<td>JOE</td>
<td>344-380</td>
<td>11-18</td>
</tr>
<tr>
<td>DYS570</td>
<td>Y</td>
<td>TTTTC</td>
<td>TMR-ET</td>
<td>90-150</td>
<td>10-25</td>
</tr>
<tr>
<td>DYS635</td>
<td>Y</td>
<td>TSTA compound</td>
<td>TMR-ET</td>
<td>150-202</td>
<td>15-28</td>
</tr>
<tr>
<td>DYS390</td>
<td>Y</td>
<td>(TCTA) (TCTG)</td>
<td>TMR-ET</td>
<td>207-255</td>
<td>17-29</td>
</tr>
<tr>
<td>DYS439</td>
<td>Y</td>
<td>AGAT</td>
<td>TMR-ET</td>
<td>263-307</td>
<td>6-17</td>
</tr>
<tr>
<td>DYS392</td>
<td>Y</td>
<td>TAT</td>
<td>TMR-ET</td>
<td>314-362</td>
<td>4-20</td>
</tr>
<tr>
<td>DYS643</td>
<td>Y</td>
<td>CTITTT</td>
<td>TMR-ET</td>
<td>368-423</td>
<td>6-17</td>
</tr>
<tr>
<td>DYS393</td>
<td>Y</td>
<td>AGAT</td>
<td>CXR-ET</td>
<td>101-145</td>
<td>7-18</td>
</tr>
<tr>
<td>DYS485</td>
<td>Y</td>
<td>GAAA</td>
<td>CXR-ET</td>
<td>159-215</td>
<td>10-24</td>
</tr>
<tr>
<td>DYS385 a/b</td>
<td>Y</td>
<td>GAAA</td>
<td>CXR-ET</td>
<td>223-307</td>
<td>7-28</td>
</tr>
<tr>
<td>DYS456</td>
<td>Y</td>
<td>AGAT</td>
<td>CXR-ET</td>
<td>316-364</td>
<td>11-23</td>
</tr>
<tr>
<td>Y-GATA-H4</td>
<td>Y</td>
<td>TAGA</td>
<td>CXR-ET</td>
<td>374-414</td>
<td>8-18</td>
</tr>
</tbody>
</table>

<sup>1</sup>Information about most of these loci can be found at: [www.cstl.nist.gov/biotech/strbase/chrom.htm](http://www.cstl.nist.gov/biotech/strbase/chrom.htm)

<sup>2</sup>The August 1997 report (30,31) of the DNA Commission of the International Society for Forensic Haemogenetics (ISFH) states, “1) for STR loci within coding genes, the coding strand shall be used and the repeat sequence motif defined using the first possible 5’ nucleotide of a repeat motif; and 2) for STR loci not associated with a coding gene, the first database entry or original literature description shall be used”.

<sup>3</sup>The length of each allele in the allelic ladder has been confirmed by sequence analysis.

<sup>4</sup>When using an internal lane standard, such as the CC5 Internal Lane Standard 500 Y23, the calculated sizes of allelic ladder components may differ from those listed. This occurs because different sequences in allelic ladder and ILS components may cause differences in migration. The dye label also affects migration of alleles.

<sup>5</sup>For a current list of microvariants, see the Variant Allele Report published at the U.S. National Institute of Standards and Technology (NIST) web site at: [www.cstl.nist.gov/div831/strbase/](http://www.cstl.nist.gov/div831/strbase/) and the Y Chromosome Haplotype Reference Database at: [www.yhrd.org](http://www.yhrd.org)
4.8.2.2. **PowerPlex® Y23 Amplification Set-Up** (Note: The following steps shall be performed in the PCR amplification set-up area.)

4.8.2.2.1. Thaw the Amplification Grade Water, PowerPlex® Y23 5X Master Mix, and PowerPlex® Y23 10X Primer Pair Mix. When thawed, it is important to vortex the PowerPlex® Y23 5X Master Mix and PowerPlex® Y23 10X Primer Pair Mix tubes for 5 to 10 seconds. (Do not centrifuge after vortexing as this may cause the primers/dNTPs to be concentrated at the bottom of the tube.) The Amplification Grade Water may be stored at 2-10° C or at room temperature for extended periods.

4.8.2.2.2. Determine the number of samples to be amplified, including controls (reagent blank, a positive control [PC], and an amplification blank [AB]). Add 2 to 4 reactions to this number to compensate for the loss that occurs during reagent transfers.

4.8.2.2.3. Place one 0.2 ml PCR reaction tube for each sample into a rack and label appropriately. A 96-well plate may be used.

4.8.2.2.3.1. If utilizing a 96-well plate for amplification, well locations where allelic ladder will be utilized for capillary electrophoresis shall be left empty during amplification.

4.8.2.2.4. 0.05 ng to 0.5 ng of template DNA is recommended. Amplification of greater than 0.5 ng of template DNA should not be used due to off-scale peak heights and may result in increased artifacts and interfere with interpretation. Targeting less than 0.5 ng of template DNA should be used only with samples whose concentration falls between 0.003 ng/µl and 0.029 ng/µl. Such samples shall be interpreted with caution. Samples with concentrations greater than 0.029 ng/µl should target 0.5 ng but shall not exceed 1.0 ng for amplification.

4.8.2.2.5. Using the Master Mix worksheet, calculate the required amount of each component of the PCR master mix. Multiply the volume (µl) per sample by the total number of reactions to obtain the final volume (µl).

**Components of Master Mix/sample:**
- 12.5 µl Nuclease Free or Amplification Grade Water
- 5.0 µl PowerPlex® Y23 5X Master Mix
- 2.5 µl PowerPlex® Y23 10X Primer Pair Mix
- 20 µl Total Volume (w/o sample)

4.8.2.2.6. Add the calculated volume of each component to a 1.5 ml tube. Mix gently.

4.8.2.2.7. Add 20 µl of PCR master mix to each sample tube.

4.8.2.2.8. Pipette 5 µl of sample, reagent blank, positive amplification control, or negative amplification control into the respective tube containing Master Mix.

4.8.2.2.8.1. For the positive amplification control, dilute the 2800M or other approved positive DNA standard supplied with the PowerPlex® Y23 kit to 0.02 ng/µl to 0.1 ng/µl. Pipette 5.0 µl (0.1 ng to 0.5 ng) of diluted male DNA into a 0.2 µl reaction tube containing 20 µl of PCR master mix. A positive control shall be included in each thermal cycler. (NOTE: The diluted positive control should be stored at 2-10°C.)

4.8.2.2.8.2. Amplification grade H2O or NF H2O shall be used as a negative amplification control included with each thermal cycler.
4.8.2.2.9. For samples requiring more than 5 µl of sample volume, use the variable PPY23 Amplification Worksheet to calculate the required amount for each component of the PCR master mix. Sample volumes above 5 µl shall be subtracted from the volume of water in the master mix.

**Components of the Master Mix/sample:**
- Up to 12.5 µl Nuclease Free or Amplification Grade Water
- 5.0 µl PowerPlex® Y23 5X Master Mix
- 2.5 µl PowerPlex® Y23 10X Primer Pair Mix
- Between 7.5 and 20 µl Total Volume (without sample)

4.8.2.2.10. Add the calculated volume of each component to a 1.5 ml tube. Mix gently.

4.8.2.2.11. Add up to 20 µl of PCR master mix to each sample tube or well.

4.8.2.2.12. Pipette the appropriate amount of each sample (up to 17.5 µl) into the respective tube containing master mix. For organic extractions if the template DNA is stored in TE buffer, the volume of the DNA sample added should not exceed 20% of the final reaction volume. PCR amplification efficiency and quality can be greatly altered by changes in pH (due to added Tris-HCl) or available magnesium concentration (due to chelation by EDTA). DNA samples stored (or diluted) in NH₄H₂O are not subject to this caution, but may contain other PCR inhibitors at low concentrations depending on the source of the template DNA and the extraction procedure employed.

4.8.2.3. **PowerPlex® Y23 Amplification**

4.8.2.3.1. Assemble the tubes in a thermal cycler.

4.8.2.3.2. Select and run the thermal cycling protocol below:

4.8.2.3.3. **Applied Biosystems® GeneAmp® 9700 Thermal Cycler:**

<table>
<thead>
<tr>
<th>1 Cycle</th>
<th>30 Cycles</th>
<th>1 Cycle</th>
<th>Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>96°C</td>
<td>94°C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 minutes</td>
<td>10 sec</td>
<td>72°C</td>
<td></td>
</tr>
<tr>
<td>61°C</td>
<td>30 sec</td>
<td>60°C</td>
<td></td>
</tr>
<tr>
<td>1 minute</td>
<td></td>
<td>20 minutes</td>
<td></td>
</tr>
<tr>
<td>4°C</td>
<td></td>
<td>∞</td>
<td></td>
</tr>
</tbody>
</table>

4.8.2.3.3.1. Select 25 µl for the volume in the amp tubes.

4.8.2.3.3.2. Select Max mode for the ramp speed.

4.8.2.3.3.3. Remove samples after the amplification process is completed and proceed with capillary electrophoresis or store the amplified samples at -10°C to -30°C. Alternatively, amplified samples may be stored at 2-10°C if they are to be used within 2 days.

4.8.2.3.3.4. Any remaining amplified products shall be discarded after the case is administratively reviewed.
4.8.2.4. **PowerPlex® Y23 Direct Amplification Sampling for Standards**

4.8.2.4.1. (Oral swabs only) Place the head of one swab in a deep well plate.

4.8.2.4.2. Using a fresh pipette tip every time, place 1ml SwabSolution™ into each well containing a swab head.

4.8.2.4.3. For the reagent blank, place solution only into an empty well.

4.8.2.4.4. Incubate at 70°C for approximately 1 hour.

4.8.2.4.5. Store the samples in the refrigerator at 2-10°C. Samples may be stored for up to three weeks prior to direct amplification.

4.8.2.5. **PowerPlex® Y23 Direct Amplification Set-Up for Standards**  (Note: The following steps shall be performed in the PCR amplification set-up area.)

4.8.2.5.1. Thaw the Amplification Grade Water, PowerPlex® Y23 5X Master Mix, and PowerPlex® Y23 10X Primer Pair Mix. When thawed, it is important to vortex the PowerPlex® Y23 5X Master Mix and PowerPlex® Y23 10X Primer Pair Mix tubes for 5 to 10 seconds. (Do not centrifuge after vortexing as this may cause the primers/dNTPs to be concentrated at the bottom of the tube.) The Amplification Grade Water may be stored at 2-10°C or at room temperature for extended periods.

4.8.2.5.2. Determine the number of samples to be amplified, including controls (reagent blank, a positive control [PC], and an amplification blank [AB]). Add 2 to 4 reactions to this number to compensate for the loss that occurs during reagent transfers.

4.8.2.5.3. Place one 0.2 ml PCR reaction tube for each sample into a rack and label appropriately. A 96-well plate may be used.

4.8.2.5.3.1. If utilizing a 96-well plate for amplification, well locations where allelic ladder will be utilized for capillary electrophoresis shall be left empty during amplification.

4.8.2.5.4. For samples and controls, calculate the required amount of each component of the PCR master mix. Multiply the volume (µl) per sample by the total number of reactions (from 4.8.2.5.2) to obtain the final volume (µl).

**Components of Master Mix/sample:**
- 15.5 µl Nuclease Free or Amplification Grade Water
- 5.0 µl PowerPlex® Y23 5X Master Mix
- 2.5 µl PowerPlex® Y23 10X Primer Pair Mix
- 23 µl Total Volume (w/o sample)

4.8.2.5.5. Add the calculated volume of each component to a 1.5 ml tube. Mix gently.

4.8.2.5.6. Add 23 µl of PCR master mix to each sample tube/well.

4.8.2.5.7. Pipette 2 µl of sample, reagent blank, positive amplification control, or negative amplification control into the respective tube/well containing Master Mix.

4.8.2.5.7.1. For the positive amplification control, dilute the 2800M or other approved positive DNA standard supplied with the PowerPlex® Y23 kit to 1 ng/µl to 1.5 ng/µl. Pipette 2 µl (2 ng to 3 ng) of diluted male DNA into a 0.2 µl reaction tube containing 23 µl of PCR master mix. A positive control shall
be included in each thermal cycler. (NOTE: The diluted positive control should be stored at 2-10°C.)

4.8.2.5.7.2. Amplification grade H₂O or NF H₂O shall be used as a negative amplification control included with each thermal cycler.

4.8.2.6. **PowerPlex® Y23 Direct Amplification for Standards**

4.8.2.6.1. Assemble the tubes in a thermal cycler.

4.8.2.6.2. Select and run the thermal cycling protocol below:

4.8.2.6.3. **Applied Biosystems® GeneAmp® 9700 Thermal Cycler:**

<table>
<thead>
<tr>
<th>1 Cycle</th>
<th>25 Cycles</th>
<th>1 Cycle</th>
<th>Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>96°C 2 minutes</td>
<td>94°C 10 sec</td>
<td>72°C 30 sec</td>
<td>60°C 20 minutes</td>
</tr>
<tr>
<td>1 minute</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4°C</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4.8.2.6.3.1. Select 25 µl for the volume in the amp tubes.

4.8.2.6.3.2. Select Max mode for the ramp speed.

4.8.2.6.3.3. Remove samples after the amplification process is completed and proceed with capillary electrophoresis or store the amplified samples at -10°C to -30°C. Alternatively, amplified samples may be stored at 2-10°C if they are to be used within 2 days.

4.8.2.6.3.4. Any remaining amplified products shall be discarded after the case is administratively reviewed.

4.8.3. **Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0 – Instrument Set-up. See Appendix 11**

4.8.4. **Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0 - PowerPlex® Y23 Electrophoresis**

4.8.4.1. **Sample Preparation**

4.8.4.1.1. **Note:** The quality of formamide is critical for the successful detection of a DNA profile. Deionized formamide shall be used that has a conductivity of less than 100µS/cm, such as Hi-Di™ Formamide. The formamide shall be frozen in aliquots at -20°C and the remainder of each aliquot shall be discarded after it is thawed. Multiple freeze-thaw cycles or long-term storage at 4°C may cause breakdown of the formamide which can create ions that compete with DNA during injection. This will cause lower peak heights and decreased sensitivity.

4.8.4.1.2. **Caution:** Formamide is an irritant and teratogen; therefore universal precautions and a fume hood shall be utilized when manually working with formamide to avoid inhalation and contact with the skin.
4.8.4.1.3. Thaw the ILS (WEN ILS 500), the allelic ladder, and an aliquot of Hi-Di™ Formamide. When thawed, centrifuge briefly then vortex to mix (do not centrifuge the ILS after vortexing).

4.8.4.1.4. Determine the number of samples to be injected, including controls (reagent blanks, positive control and amplification blank) and allelic ladders. Add 2 to 4 reactions to this number to compensate for the loss that occurs during reagent transfers.

4.8.4.1.5. Prepare a loading cocktail by combining 0.5-1.0 µl ILS with 9.5-9.0 µl Hi-Di™ Formamide for a total volume of 10 µl.

4.8.4.1.5.1. The volume of ILS used in the loading cocktail may be adjusted between 0.5 to 1.0 µl per sample to optimize size standard peaks. The amount of formamide shall be adjusted so that the total amount of loading cocktail for each well is 10 µl.

4.8.4.1.6. Vortex to mix.

4.8.4.1.7. Pipette 10 µl of the formamide/ILS mixture into each well. (Add formamide or formamide/ILS mixture into empty wells to complete an injection set of eight. Every well in which an injection is occurring must contain liquid.)

4.8.4.1.8. Add 1 µl of amplified sample or 1 µl of the allelic ladder to each well. It is recommended that one allelic ladder is injected within each set of 3 injections on the 8 capillary Applied Biosystems® 3500 instruments to ensure that a usable ladder injection occurs. At least one allelic ladder is required within each run folder.

4.8.4.1.9. Cover the wells with the plate septa and briefly spin down to remove air bubbles.

4.8.4.1.10. Denature the samples at 95°C for ~3 minutes, then immediately chill on crushed ice or a frozen plate block for ~3 minutes. Denature the samples just prior to loading the instrument. Avoid denaturing the samples for longer than 3 minutes as extended heat denaturing can lead to the appearance of artifacts.
4.8.4.2. Creating a Plate Record

4.8.4.2.1. Open the 3500 Data Collection Software. The Dashboard screen will launch. Ensure that the Consumable Information and Maintenance Notifications are acceptable. The oven temperature should be set to 60ºC.

4.8.4.2.2. Select Start Pre-Heat. This should be done at least 30 minutes prior to the first injection.

Dashboard:

4.8.4.2.3. Select Create New Plate. Alternatively, Create Plate from Template may be used.

4.8.4.2.3.1. Assign the plate name with the laboratory case number, the date and the injection number of the plate (ex. 00A1234_01Jan13_01).

4.8.4.2.3.1.1. If the plate is re-injected the “01” number shall increase sequentially (00A1234_01Jan13_02).

4.8.4.2.3.1.2. If the plate is re-injected on a different day, the original date should still be used from when the plate was prepared.

4.8.4.2.3.1.3. If a second preparation of a plate is made on the same date as the first, it shall be designated with a “-2” after the date (00A1234_01Jan13-2_01).

4.8.4.2.4. Select “96” for Number of Wells.
4.8.4.2.5. Select “HID” for Plate Type.
4.8.4.2.6. Select “36” for Capillary Length.
4.8.4.2.7. Select “POP4” for Polymer.

Create A Plate:

4.8.4.2.8. Click on “Assign Plate Contents”.
4.8.4.2.9. Enter sample information or import a plate record.

4.8.4.2.9.1. The sample name shall include the sample item/subitem as well as the laboratory case number (ex. 1A1_00A1234) if more than one case is included on the plate. If only one case is present on the plate then only the item/subitem number is required.

4.8.4.2.9.2. In order to aid in GeneMapper® ID-X sample analysis, it is recommended to place a “z” in front of the sample name for reference standards (ex. z1A1_00A1234”) here or in GeneMapper® ID-X under sample name.

4.8.4.2.10. Under Assays click “Add from Library” and select the appropriate assay. Click “Add to Plate” then “Close”.

4.8.4.2.11. To add an additional assay to the plate, click the “Actions” arrow, select “Add from Library” and select the appropriate assay.
4.8.4.2.12. Under **File Name Convention**, click “Add from Library” and select “PPY23_FNC”. Click “Add to Plate” then “Close”.

4.8.4.2.13. Under **Results Groups**, click “Add from Library” and select “PPY_ResultsGroup”. Click “Add to Plate” then “Close”.

**Assign Plate Contents:**

4.8.4.2.14. On the bottom-right side of the screen expand the **Customize Sample Info** window so it appears as shown above.

4.8.4.2.14.1. Use the drop-down box to select a sample type for each sample (ex. Ladder, Sample, Positive Control and Negative Control). For imported plates, this will be done automatically.

4.8.4.2.14.2. Minimize the “Customize Sample Info” window.

4.8.4.2.15. Highlight the sample wells and then select the boxes in the **Assays, File Name Conventions**, and **Results Groups** that pertain to those samples.

4.8.4.2.16. Place plate on instrument in position A. Select “Link Plate for Run”. Click “OK”. The instrument automatically senses the plate and puts the information in the Plate A field. Click “OK”.

4.8.4.2.17. To add a second plate, follow steps 4.8.4.2.3 through 4.8.4.2.15. Place the plate in position B. Select the “Link Plate for Run” and click “OK”. Assign the information to the Plate B field. Click “OK”.

4.8.4.3. **Start a Plate Run**

4.8.4.3.1. A unique run name is automatically generated by the instrument for each plate.
4.8.4.3.2. To re-organize injections, click “Create Injection List” and use the arrows to re-order the injections.

4.8.4.3.3. Click “Start Run”.

4.8.4.3.4. After the run is complete, click “Unlink Plate” and remove it from the instrument. The plate may be discarded or labeled with the same title as the plate record and stored at -10°C to -30°C. The plate shall be destroyed after the case has been administratively reviewed.

4.8.4.3.4.1. If the CE plate requires re-injection after frozen storage, thaw and centrifuge to remove any air bubbles. Denature the plate at 95°C for 3 minutes, then immediately chill on crushed ice or frozen plate block for ~3 minutes prior to loading on the 3500 Genetic Analyzer.

4.8.4.3.5. A copy of the CE Plate Record Worksheet shall be maintained with each case record.


4.8.6. GeneMapper® ID-X Version 1.4 Software - PowerPlex® Y23 Software Settings See Appendix 12

4.8.7. GeneMapper® ID-X Version 1.4 Software - PowerPlex® Y23 Data Analysis

4.8.7.1. Processing Sample Data

4.8.7.1.1. Import the sample files from a single run folder by “Edit”, then selecting “Add Samples to Project”.

4.8.7.1.2. In the “Add Samples to Project” screen, navigate to the run folder that contains the sample files. If the entire run folder is to be imported, click on the folder to highlight it; then click the “Add to List” button at the bottom of the window. If the run folder was shared between multiple cases, expand the folder to view the samples. Highlight the appropriate samples, ensuring that the allelic ladder and all the desired samples are selected. Once all the samples are selected click the “Add to List” button at the bottom of the window.

4.8.7.1.3. Only one injection parameter shall be used per project. A run folder shall not be created manually by manipulating sample files.

4.8.7.1.4. Ensure that the necessary files are now located in the “Samples to Add” window by double-clicking on the folder in the right pane, then click “Add”.

4.8.7.1.5. After the samples have been added to the project, first briefly scan the raw data to ensure that a bad injection did not occur. To check the raw data, first expand the project folder in the left navigation pane, then click on a sample file, then click on the “Raw Data” tab in the right GeneMapper® ID-X window. To return to the “Samples” window, click on the project folder at the top of the left navigation pane.

4.8.7.1.6. The GeneMapper® ID-X project shall contain at least one allelic ladder from each run folder included in the project for proper genotyping. Multiple allelic ladders within a run folder will be averaged by the software to calculate the allelic bins. If a ladder injection is of low quality, delete the ladder or change the sample type from “Allelic Ladder” to “Sample” to remove it from consideration in calculating the bins.

4.8.7.1.7. Ensure that the Table Setting at the top of the screen is set to “PPY23”.
4.8.7.1.8. In the **Sample Type** column, verify that the correct sample types are displayed (i.e. Allelic Ladder, Sample, Positive Control, and Negative Control). Should a sample type need altered, use the drop-down menu to select the appropriate type.

4.8.7.1.9. In the **Analysis Method** column, select the appropriate method from the drop-down menu: "PowerPlex Y23 WEN". Click the column header cell to highlight the entire column, then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D).

4.8.7.1.10. In the **Panel** column, select the appropriate panel file: Open the “PowerPlexY23_Panels_IDX_v2.0” folder then select “PowerPlexY23_IDX_v2.0”. Click the column header cell to highlight the entire column, then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D).

4.8.7.1.11. In the **Size Standard** column, select the appropriate ILS from the drop-down menu: “WEN ILS 500”. Click the column header cell to highlight the entire column, then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D).

4.8.7.1.12. The Analysis Method, Size Standard, and Panel can be set as defaults when a GeneMapper® ID-X project is opened. Select **File → Project Options**. Under the “Add Samples” tab select the above settings as the default in the drop-down menus for Analysis Method, Size Standard and Panel. Click “OK”.

4.8.7.1.13. Select the green **Analyze** arrow button to start the data analysis. At the Project name prompt, save the project. At a minimum the project name shall contain the injection parameters for the project and date the sample run was started on the instrument. The case number is recommended but not required. Select the “ISP Casework Security Group”.

4.8.7.2. **Evaluating Sample Data**

4.8.7.2.1. The **Sizing Quality** shall be at least 0.75 for WEN ILS 500 data. All appropriate ILS peaks shall be present and labeled correctly.

4.8.7.2.2. Highlight all sample rows containing **Allelic Ladders**. Then click “View”, then “Display Plots”. In the Samples Plot screen, change the “Plot Setting” drop-down box to “PPY23”. Magnify the area from approximately 50 bp to 500 bp and verify the correct allele calls are made for each peak. Print the electropherograms.

4.8.7.2.3. Highlight all sample rows containing **Negative Controls** (ex. amplification blanks and reagent blanks). Then click “View”, then “Display Plots”. In the Samples Plot screen, change the “Plot Setting” drop-down box to “PPY23”. Check the negative controls to ensure that no peaks above analytical threshold are present. Print the electropherograms ensuring that the primer peak is visible.

4.8.7.2.4. Highlight all remaining sample rows. Then click “View”, then “Display Plots”. In the Samples Plot screen, change the “Plot Setting” drop-down box to “PPY23”. Magnify the area from approximately 50 bp to 500 bp. After evaluating all allele calls, click “File”->”Print”->”Print” to print off all sample electropherograms. Optionally, the remaining sample rows may be viewed, evaluated, and printed with the Allelic Ladders.

4.8.7.2.5. After all analysis is complete, save the 3500 Data Collection Run Folder and associated GeneMapper® ID-X projects under each associated laboratory case number and request folder located in the analysts’ folders on the server. Projects should be deleted monthly from the “GeneMapper Manager” to maintain database space.
4.8.7.2.5.1. When exporting the GeneMapper® ID-X project, ensure that the “Export with analysis settings” box is checked.

4.8.7.2.6. The number of audit records on the GeneMapper® ID-X database should be routinely checked. Audit records should be backed-up, saved to the DNA server, and then deleted from the GeneMapper® ID-X database monthly or if the number of records exceeds 40,000. If the number of audit records exceeds 60,000, the performance of the software may be affected.

4.8.7.2.7. The amount of database space in the GeneMapper® ID-X software should be routinely checked. If the occupied space exceeds 80%, additional disk space should be allocated.

4.8.8. Interpretation Guidelines For PowerPlex® Y23

4.8.8.1. Once a determination has been made whether a peak is to be considered a true allele, the following interpretation guidelines shall be used. The minimum peak height threshold is established at 75 relative fluorescent units (RFU) for GeneMapper® ID-X software. The analytical threshold for data interpretation is 75 RFU. The stochastic threshold for data interpretation of the DYS385 a/b locus is 250 RFU.

4.8.8.2. Peaks below 75 RFU shall not be interpreted or marked on the STR summary sheet.

4.8.8.3. Interpretation of peaks with RFU from 75 to 250 RFU at the DYS385 a/b locus is a qualitative assessment. It shall be interpreted with care. If the DYS385 a/b locus demonstrates a single allele that is above 75 RFU and below 250 RFU, true homogygosity cannot be determined due to possible stochastic effects and it will be reported with a bracket (ex. [13]) on the Y-STR summary sheet. If the DYS385 a/b locus demonstrates two alleles in which one or both alleles are above 75 RFU and below 250 RFU, and the sample appears to be single source, the allele(s) below 250 RFU will be reported with a bracket. Both alleles are interpretable and may be used in a Y-STR database search.

4.8.8.4. Peaks at the remaining loci with RFU of 75 and above are reportable based on both qualitative and quantitative assessment of data.

4.8.8.5. Controls:

4.8.8.5.1. The appearance of pull-up or known artifact peaks does not render the following controls inconclusive.

4.8.8.5.2. Reagent Blank: The purpose of the reagent blank is to determine if the reagents used to extract the associated samples were contaminated by male DNA. Therefore no signal should be detected in this sample well other than the internal lane standard.

4.8.8.5.2.1. A reagent blank with peaks below 75 RFU shall not prevent associated samples from being interpreted.

4.8.8.5.2.2. A reagent blank with peaks of 75 RFU and above shall be considered a failed negative control. All associated samples shall be inconclusive. All the samples shall be repeated when reasonable and appropriate.

4.8.8.5.3. Positive Control:

4.8.8.5.3.1. The 2800M or other appropriate male DNA standard supplied with the PowerPlex® Y23 kit is used as a positive control to demonstrate that the kit is performing properly. If the expected alleles are not detected in the positive control well, then the test is considered inconclusive.
4.8.8.5.4. **Amplification blank:**

4.8.8.5.4.1. The purpose of the amplification blank is to determine if male DNA contaminated the samples at the amplification step. Because no template DNA was placed in the reaction tube, the sample well should be blank except for the internal lane standard peaks. If amplified product is detected in the amplification blank well, the test is considered inconclusive.

4.8.8.5.4.2. An amplification blank with peaks below 75 RFU shall not prevent associated samples from being interpreted.

4.8.8.5.4.3. An amplification blank with peaks of 75 RFU and above shall be considered failed negative controls. All associated samples shall be inconclusive. All the samples shall be repeated when reasonable and appropriate.

4.8.8.6. The analytical threshold shall be determined during validation. If an analyst has determined that a peak that has been labeled by the GeneMapper® ID-X software is not a true allele peak, the analyst can delete the allele call label in either the software file or manually on the printed electropherograms. The GeneMapper® ID-X software is set to display all allele changes. Therefore, any change or deletion in an allele call shall be visible on the electropherogram print-out.

4.8.8.7. An analyst is required to visually confirm all allelic ladders used for allele designation and the allele calls for all positive controls.
4.8.8.8. Stutter peaks are artifacts of the amplification process. These peaks will typically be observed in the n-4 position of major peaks for tetranucleotide repeat loci, in the n-5 position of major peaks for the pentanucleotide repeat locus, in the n-6 position of major peaks for the hexanucleotide repeat locus, or in the n-3 position of the major peaks for the trinucleotide repeat loci. The peak heights of stutter peaks will be less intense than that of the major peak. The average observed percent stutter for each locus and the mean + 3 SD values are listed in the table in Appendix 13. The mean stutter value for each locus is used as the stutter cut-off value in the marker stutter file “PowerPlexY23_IDX_v1.2” for GeneMapper® ID-X analysis. Therefore, any peaks in the n-4 (for tetranucleotide repeats), the n-3 (for trinucleotide repeats), the n-5 (for pentanucleotide repeats), or the n-6 (for hexanucleotide repeats); and n-2/n+2 associated with the DYS19 locus stutter positions that are below these values when compared to the major peak will be automatically filtered out by the software and will not be labeled. However, these values may vary slightly. There are also stutter-like peaks at the n-9 and n-2 positions and are also listed on the table below. This column may be used as a guideline to the analyst for determining stutter peaks that were not filtered out by the software. It is the analyst’s discretion to determine which allele calls may be renamed as stutter in GeneMapper® ID-X analysis. For samples which have been over-loaded, the percent stutter calculation will not be accurate due to the saturation effect of the major peak. In addition to stutter peaks, several other stutter-like peaks can be observed at some PowerPlex® Y23 loci, especially when samples are amplified at high concentrations.

4.8.8.8.1. Note: Stutter peaks have also been observed during the validation process at the n+4 (tetranucleotide) and n+3 (trinucleotide) positions as well as the n-8 (tetranucleotide) and n-6 (trinucleotide) positions. These values are listed in Appendix 13. Other artifacts of less intensity have been reported which may not line up with the ladder. The interpretation of these peaks, similar to the other artifact peaks, shall be at the discretion of the analyst based on their training and experience.

Stutter Table: See Appendix 13

4.8.8.9. Artifacts have been observed utilizing the PowerPlex® Y23 amplification kit. The intensity of these peaks is directly related to signal intensity; therefore, reducing the signal intensity to less than 15,000 RFU should minimize the appearance of these types of artifacts. If an analyst renames the allele call of any artifact in GeneMapper® ID-X, it shall be labeled appropriately. Artifact peaks have been documented at 66-69 base pairs in the Fluorescein dye channel and at 58-60 base pairs in the JOE dye channel. The following artifacts have been observed: DYS448 in the n-9 to n-15 position; DYS635 at 160 bases; DYS481 at 164 bases; DYS549 at 187 bases; DYS458 at 201 bases; DYS533 at 253 bases and at 272 bases; and DYS643 at 427 bases and 440 bases.

4.8.8.10. Pull-up or bleed through peaks can occur if signal intensity of sample or ILS peaks is too high or if a new spectral calibration needs to be run. Any pull-up peaks called as alleles by the GeneMapper® ID-X software should be labeled on the electropherogram as pull-up. The sample should be re-run if a pull-up peak interferes with the analyst’s ability to evaluate the profile based on their experience and training.

4.8.8.11. Spikes are peaks that generally appear in all colors and are sharper than regular peaks; however, they can occur predominantly in one color. Spikes are a natural consequence of capillary electrophoresis and can be caused by dust present in the system as well as urea crystals in the system. It is essential that the instrumentation be maintained and cleaned regularly to minimize the appearance of spikes. All spikes called as alleles by the
GeneMapper® ID-X software should be clearly labeled as spikes on the electropherogram printout. A sample should be re-injected when a spike interferes with the analyst's ability to evaluate the profile based on their experience and training.

4.8.8.12. Rare variants have been described in the literature. The causes of these rare variants are microvariants or chromosomal mutations (duplication or deletion).

4.8.8.12.1. Microvariants: alleles one, two or three nucleotides shorter than the common four base repeat alleles (one or two nucleotides shorter in the case of three base repeat alleles, up to four nucleotides shorter in the case of five base repeat alleles, and up to five nucleotides shorter in the case of six base repeat alleles) which are located between two alleles on the ladder shall be described as the short repeat followed by the number of base pairs it is larger (e.g., a 0.1, 0.2, 0.3, or 0.4 in the case of a pentanucleotide repeat). Therefore, if a peak is 1 base pair larger than the 5 allele it shall be designated as 5.1. The precision of sizing at a 99.7% confidence level is less than 0.25 bp which is precise enough to be confident in the sizing of microvariants. A microvariant 4 base pairs larger than an allele (or 5 base pairs for a pentanucleotide) on the ladder may be designated with the full repeat number (A peak 4 base pairs larger than the 5 allele could be designated a 6; 5 base pairs larger a 6.1). A current list of microvariants is available on the “Variant Allele Report” published at the U.S. National Institute of Standards and Technology (NIST) website: http://www.cstl.nist.gov/div831/strbase and on the Y Chromosome Haplotype Reference Database at http://www.yhrd.org

4.8.8.12.2. Alleles which are located outside the range of the ladder or bin set (above or below) shall be described as “<” or “>” the largest or smallest allele for that locus with a set of ( ) placed around the off ladder allele. For example, if a band is located above the largest allele for the DYS19 locus, it would be designated as “(>19)”. This should be clear when used and can be verified with a locus review of the electropherogram.

4.8.8.12.3. A duplication occurs when multiple alleles are present at a locus/loci. Duplications have been documented with the PowerPlex® Y23 amplification kit. Instances of multiple duplications within a sample have been documented as well. Most duplications have a one repeat difference; however two, three, and four repeat unit differences have been observed.

4.8.8.12.3.1. Steps to distinguish between a mixture and a duplication: determine the number of loci containing more than one peak; consider the position on the Y-chromosome if multiple loci have two peaks; determine if the repeat spread is >1 repeat unit; examine DYS385 a/b for the presence of >2 peaks; and consider autosomal testing to confirm single-source sample.

4.8.8.12.4. A deletion occurs when there is a lack of a peak at a single locus/loci. A deletion has been reported at the DYS448 locus. Samples with this deletion will show two peaks (duplication) in DYS576 and a null allele in DYS448.

4.8.8.13. Mixed DNA Samples. All loci shall be taken into consideration when interpreting a mixture. A two-peak pattern at two or more loci (except for DYS385 a/b; this locus may exhibit three or more peaks) may be an indication of a mixture. However, two-peak patterns have been reported for single-source samples, but these instances are extremely rare. If a two-peak pattern is observed for a single-source unknown sample and is believed to be a rare variant or duplication, the profile should be re-amplified and re-analyzed to confirm the profile.
4.8.8.14. The “phenotype” of each profile shall be recorded.

4.8.8.15. All interpretation decisions shall be documented prior to comparison of reference profiles. If an interpretation error is discovered after comparison to a reference profile, the Technical Leader shall be consulted to determine the appropriate action. The error and Technical Leader consultation shall be documented in the case record.

4.8.8.16. During interpretation, the analyst and technical reviewer shall each compare all single source and major Y-STR profiles to available staff profiles to ensure that samples have not been contaminated. All instances of profiles consistent with a staff member shall be reported to the Technical Leader.

4.8.8.17. There are four possible outcomes of Y-STR analysis:

   4.8.8.17.1. No results: No peaks were detected on the electropherogram.
   4.8.8.17.2. Inconclusive: Peaks were observed at one or more loci; however no conclusive results can be drawn from them.
   4.8.8.17.3. Inclusion: The profile obtained from the unknown sample had no discrepant alleles as compared to the profile of the reference standard. Allelic drop-out may occur in low concentrations or mixtures. At least twelve loci eligible for statistical calculations shall be needed to draw this conclusion.
   4.8.8.17.4. Exclusion: The profile obtained from the unknown sample was not the same as the reference sample.

4.8.9. General Rules For PowerPlex® Y23 Analysis On The Applied Biosystems® 3500 Genetic Analyzer

   4.8.9.1. It is required that at least one allelic ladder is present within a run folder. However, it is recommended that an allelic ladder is run within each set of 3 injections on the 8 capillary 3500 (one ladder per 24 capillaries). External environmental factors during a plate run can cause a shift in the migration of DNA fragments within the capillary which may cause a small difference in the base pair length determined for an allele. If an allelic ladder sample was not run within a reasonable time as the sample, this may cause an allele to be called off ladder.

   4.8.9.2. If a sample is to be re-injected at higher injection parameters, the reagent blank and the amplification blank associated with that sample shall also be re-injected at the higher parameters. The positive control need not be injected at the same parameters as the samples associated with it.

   4.8.9.3. Only the injection(s) used for interpretation need to be printed for the case record. However, other injection runs have to be noted in the case record and all data shall be saved under each associated laboratory case number and request folder located in the analysts’ folders on the server. If individual samples in a case use different injection parameters, it shall be noted in the case record which injection was used for interpretation for each sample.

   4.8.9.4. The placement of unknown samples in the 96-well plate should be done so that the orientation allows for the injection of unknown samples prior to the injection of any reference samples for that case.

   4.8.9.5. Peak heights of analyzed samples should not exceed 28,000 RFU. This level of peak height is approaching saturation and will lead to the appearance of artifacts. Reducing the signal to approximately 2,000-10,000 RFU will produce optimal results. The reduction of
signal can be obtained by decreasing the injection parameters. The allowable injection parameters are 3kV 8 seconds or 3 kV 3 seconds. Use of data with more than two peaks >28,000 RFU may be allowed with the approval of a Supervisor and notification to the Technical Leader documented in the case record.

4.8.10. Archiving Applied Biosystems® 3500 and GeneMapper® ID-X Projects

4.8.10.1. The 3500 run folders containing all sample files for a case as well as the GeneMapper® ID-X project file shall be saved under each associated laboratory case number and request folder located in the analysts’ folders on the server and deleted from the hard drive of the instrument and/or analysis computer. The data stored on the server shall be routinely backed up to ensure security of data.

4.8.10.2. A hard copy of all electropherograms used in interpretation as well as a print-out of the plate record shall be placed in the case record.

4.8.10.3. All processed plate records shall be deleted from the Data Collection Software database weekly. Run folders containing the sample files and the GeneMapper® ID-X projects shall be deleted on or after the 15th of each month on the instrument computers. It shall be each analyst’s responsibility to ensure that all data is backed up prior to the 15th of the month.

4.8.11. Mixture Interpretation

4.8.11.1. A profile is defined as a mixture between two or more males when two or more loci demonstrate two or more alleles, except DYS385 a/b. A profile where only one locus demonstrates two alleles could be an indication of:

4.8.11.1.1. A mixture where only one allele from a minor contributor is detected above analytical threshold;

4.8.11.1.2. Extraneous DNA;

4.8.11.1.3. A duplication.

4.8.11.2. In situations 1 and 2 above, report wording to the affect that one lone allele was detected and no conclusion can be reached is appropriate. In situation 3, no mention is required in the Certificate of Analysis.

4.8.11.3. If the profile is determined to be a mixture, each locus should be evaluated and classified as below:

4.8.11.3.1. Indistinguishable mixture between two or more males; in this case, since no statistical interpretations can be made, no conclusions will be made for these samples.

4.8.11.3.2. Mixture demonstrating a major contributor.

4.8.11.3.3. Demonstrates the potential for allelic drop-out.

4.8.11.4. For mixtures of two male individuals, a profile demonstrating twelve or more loci classified as a mixture demonstrating major and minor components shall have a major single source profile calculated based on the following criteria:

4.8.11.4.1. If the peak height ratio between the peaks is less than 25%, then the highest peak can be called a major at that locus.

4.8.11.4.2. If there is only one peak at a particular locus (and a major can be determined at one or more loci with more than one peak), this peak can be called a major. All loci must be considered in making this determination.
4.8.11.4.3. A mixture threshold of 300 RFU shall be used to interpret single peaks and major peaks at a locus. Peaks below 300 RFU shall not be used for interpretation of the mixture.

4.8.11.4.4. When evaluating DYS385 a/b, a major consisting of two peaks should have a peak height ratio of 65% and the tallest of the minor peak shall have a peak height ratio of less than 25% of the shortest major peak.

4.8.11.4.5. If the sample does not meet these criteria, do not call a major at this locus.

4.8.11.4.6. Mixtures of three males which meet the above criteria should be interpreted with caution.

4.8.11.4.7. Mixtures of four or more males shall be evaluated based on the following criteria. These samples should be interpreted with caution and only with approval of the Technical Leader.

4.8.11.4.7.1. If the peak height ratio between the highest peak and tallest minor peak is less than 15%, the highest peak can be called a major at that locus.

4.8.11.4.7.2. A mixture threshold of 1000 RFU shall be used to interpret single peaks and major peaks at a locus.

4.8.11.4.7.3. When evaluating DYS385 a/b, a major consisting of two peaks should have a peak height ratio of 65% and the tallest of the minor peaks shall have a peak height ratio of less than 15% of the shortest major peak.

4.8.12. Y-STR Database Searching

4.8.12.1. A Y-STR profile is treated as a single locus because it is a haplotype.

4.8.12.2. Once a comparison between a reference sample(s) and an unknown sample is completed and an inclusion for a single source or major Y-STR profile is reported, the significance of that inclusion shall be estimated. It shall be reported that all paternally related males will share the same Y-STR profile.

4.8.12.3. The unknown haplotype developed for the evidence profile shall be searched against the U.S. Y-STR Database, found online at www.usystrdatabase.org. After June 30, 2019, the unknown haplotype developed shall be searched against the Y-Chromosome Haplotype Reference Database (YHRD), found online at http://yhrd.org.

4.8.12.4. The unknown haplotype shall be searched using loci from the PowerPlex® Y kit (DYS391, DYS389 I, DYS439, DYS389 II, DYS438, DYS437, DYS19, DYS392, DYS393, DYS390, and DYS385 a/b) and using loci from the PowerPlex® Y23 kit (DYS576, DYS389 I, DYS448, DYS389 II, DYS19, DYS391, DYS481, DYS549, DYS533, DYS438, DYS437, DYS570, DYS635, DYS390, DYS439, DYS392, DYS643, DYS393, DYS458, DYS385 a/b, DYS456, and Y-GATA-H4).

4.8.12.5. The statistic result sheet for both searches shall be printed out for every sample.

4.8.12.6. The number of occurrences (matching samples) found in the database from the search (counting method) shall be included in the Certificate of Analysis as a frequency estimate with the application of the 95% confidence interval. The statistic providing the most genetic information and/or the highest discrimination potential should be reported. If both the PowerPlex® Y and PowerPlex® Y23 statistics are similar, the PowerPlex® Y23...
statistics shall be reported. The Certificate of Analysis shall also acknowledge that the search results given were accurate on the date of the search.

4.9. Records:

4.9.1. The appropriate worksheets or the equivalent workbooks shall be used to record all procedures. These will be found in the Worksheet Manual.

4.9.2. All data sheets, notes and other information generated from the laboratory examination shall be kept in the case record.

4.9.3. The technical review of the case record shall be recorded on the technical review worksheet.

4.9.4. Electronic records shall be retained as indicated in Appendix 9.

4.10. Interpretation of Results:

4.10.1. When test results from an unknown sample are compared with a reference standard the following conclusions may be reported:

4.10.1.1. The unknown sample and the reference sample may have common origin. If this is indicated, it shall be reported that all paternally related males will share the same profile and a frequency of occurrence in the U. S. Y-STR Database or the Y-Chromosome Haplotype Reference Database shall be calculated and reported out at a 95% confidence interval.

4.10.1.2. The reference sample may be excluded as a possible source of the unknown sample.

4.10.1.3. No conclusion may be reached with regard to the unknown sample and the reference sample.

4.10.2. If test results from a sample cannot be clearly interpreted, the results shall be reported as inconclusive.

4.10.3. See Y-STR Interpretation guidelines.

4.11. Reporting of Y-STR Analysis (See 1.11 for formatting):

4.11.1. See Appendix 7 for Y-STR reporting for specific examples

4.12. References:


5. DNA Sample Processing using the Biomek NX\textsuperscript{P} and Biomek 3000 Automated Workstations:

5.1. Scope: This test method is designed for the direction of laboratory personnel who will operate the Biomek NX\textsuperscript{P} and Biomek 3000 automation workstations to process DNA samples from extraction/purification through CE (capillary electrophoresis) setup. The Biomek NX\textsuperscript{P} workstation is capable of extracting up to 87 samples and blanks in two hours, setting up quantification plates, normalizing samples and setting up amplification. The Biomek 3000 workstation then transfers amplified product to a CE plate to be run on a genetic analyzer. This test method may be expanded or altered as techniques and/or new genetic analyses are found applicable and validated.

5.2. Precautions/Limitations:

5.2.1. Due to the hands-off nature of automated processing, it is vital that submitted samples be prepared following procedures determined by the automation validation and that the ordered flow of data throughout the process be maintained.

5.2.2. Customization or modification of sample processing procedures will not be allowed without consultation with the automation team and documented approval of the Technical Leader.

5.3. Related Information:

5.3.1. N/A

5.4. Instruments:

5.4.1. Biomek NX\textsuperscript{P} Automated Laboratory Workstation—robotic DNA processing system.

5.4.2. Biomek 3000—robotic DNA processing system.

5.5. Reagents/Materials:

5.5.1. Digest/Wash Buffer
5.5.2. Isopropyl Alcohol
5.5.3. Nuclease Free Water (NFH\textsubscript{2}O)
5.5.4. DTT 1M
5.5.5. Proteinase K (10 mg/ml)
5.5.6. Proteinase K (18 mg/ml)
5.5.7. Ethanol
5.5.8. Sarkosyl 20\% w/v
5.5.9. Stain Extraction Buffer for Automation
5.5.10. TRIS/EDTA/NaCl Solution
5.5.11. DNA IQ™ Extraction Kit
   5.5.11.1. Lysis Buffer
   5.5.11.2. Elution Buffer
   5.5.11.3. Magnetic Resin
   5.5.11.4. Wash Buffer

5.6. Hazards/Safety:
5.6.1. All chemicals shall be handled in a safe method as referenced in the specific Safety Data Sheets (SDS).

5.6.2. Universal Precautions shall be observed whenever biological materials are being handled.

5.6.3. Biological waste shall be disposed of in the appropriate waste receptacle.

5.6.4. On the Biomek NXp, a light curtain prevents interaction with the deck or the robotic arm while a procedure is running.

5.6.5. There is an emergency stop button on the front of the Biomek 3000.

5.7. Reference Materials/Calibration Checks:

5.7.1. DNA processing using the automated workstation does not require any additional controls to those used in manual DNA processing.

5.7.2. Annual calibration of the pipetting accuracy will be performed by Beckman Coulter Operational Qualification 3 (OQ3).

5.8. Procedures/Instructions:

5.8.1. General Rules

5.8.1.1. Batch ID numbers shall be named sequentially “year-run number” (ex. 2011-001).

5.8.1.2. Each case shall contain at least one reagent blank for unknowns when processed on the automated workstation.

5.8.1.3. Each group of reference samples (per analyst) processed on the automated workstation shall contain at least one reagent blank. On the pre-extraction worksheet (submission form), the case number for the grouped reagent blank shall be the first case number in the batch it is associated with.

5.8.1.4. Reagent blanks shall contain “RB” in the name on the pre-extraction worksheet.

5.8.1.5. Within 24 hours of incubation, analysts shall deliver samples to be processed to the automation room. An e-mail shall be sent to the automation team at DAutomation@ISP.IN.gov with the completed pre-extraction worksheet attached. The worksheet filename shall include the analyst’s initials, PE number, and the date the samples were submitted (ex. AB1234_01Jan11). The tube rack containing the samples shall be labeled to include the same information.

5.8.1.6. To maximize efficiency of each run, the automation team may process samples up to 14 days from their submission date.

5.8.1.7. In addition to the documentation of data as described in the Forensic Biology Section Test Method (DNA Test Methods, section 2), the associated automation documents to be printed and retained in the case record are: the pre-extraction worksheet, the extraction/quantification plate record, the Samples Not Amplified summary and/or the
5.8.2. Sample Triage with Automated Sample Processing

5.8.2.1. General Triage Rules

5.8.2.1.1. The Automation Workbook will triage samples based on their quantification data, their letter code(s) as assigned on the “Samples” tab (initially provided by the analyst on the Pre-Extraction Worksheet), and their context within a case as defined by their case number.

5.8.2.1.2. No samples containing less than 0.01 ng/uL small autosomal DNA will be amplified, regardless of sample code or “locked” status.

5.8.2.1.3. Whenever comparisons between code M samples are made (Differential Triage or Priority System Triage), the “better” or “winning” sample is defined as the one with more actual male DNA input into the amplification reaction.

5.8.2.1.3.1. This calculation prioritizes maximum male DNA input rather than only the F:M ratio or only the Y quantification value.

5.8.2.1.3.2. The calculation takes into account the normalization of the small autosomal DNA amount (i.e. normalizing a high autosomal value requires dilution, which also lowers the amount of total male DNA input).

5.8.2.1.3.3. Example: SampleA has 0.018 ng/uL of autosomal DNA and 0.008 ng/uL of male DNA, for an F:M ratio of 1.25 and 0.12 ng of total male input in a 15 uL reaction. SampleB has 0.072 ng/uL of autosomal DNA and 0.02 ng/uL of male DNA, for an F:M ratio of 2.6 and 0.3 ng of total male input in a 15 uL reaction. SampleB “wins” despite having a higher F:M ratio than sample A.

5.8.2.1.4. Case numbers, item numbers, and sample codes will be read as-is. Typos in any of these may result in extra samples being amplified beyond the triage process.

5.8.2.2. Sample Codes

5.8.2.2.1. Sample codes are specific letters or combinations of letters entered by the analyst in the “Code” column of the Pre-Extraction Worksheet. These codes determine certain properties of the sample and how it will be processed on the Automation platform. Code letters may be entered in any order and are case-insensitive.

5.8.2.2.2. Code T (Tube): Code T merely indicates that the extract will be returned to a tube after processing; it does not affect any other analysis. It can be combined with other codes.

5.8.2.2.3. Code S (Standard): Code S indicates that the sample is a standard, or a reagent blank associated with a standard. Standards are “freed” from their case numbers;
they do not undergo case-level triage and are assigned to extraction sets differently. If a sample is marked S, an M or L code will not affect it.

5.8.2.2.3.1. This allows one reagent blank to be associated with standards from multiple cases.

5.8.2.2.4. **Code M (Male DNA):** Code M is the equivalent of “stop if no male,” used formerly. It indicates that the sample must be Priority 3 or greater to amplify. The sample will also undergo case-level triage, which includes the Priority system ratings, comparison between differential fractions (Differential Triage), and selection of the three best samples to amplify based on total male DNA input (Priority System Triage). The function of code M is not affected by code T, but code S will cancel the functionality of code M.

5.8.2.2.4.1. Code M samples will not be amplified if the F:M ratio is greater than 50, regardless of whether they are locked.

5.8.2.2.5. **Code L (Locked):** Code L is combined with code M to “lock” a sample for amplification. It is a way of bypassing the case-level triage while still requiring sufficient male DNA for amplification (i.e. Priority 3 or greater, and sufficient autosomal DNA). Code L does not affect any other code except M.

5.8.2.2.5.1. Locked samples will not affect the triage of other samples within the same case. In other words, locking samples that turn out to be poorer quality will not prevent better quality, “unlocked” samples from being amplified. Locked samples will be amplified in addition to better quality unlocked samples.

5.8.2.3. **Differential Triage**

5.8.2.3.1. This section only applies to code M samples designated as sperm or non-sperm fractions as described below.

5.8.2.3.1.1. Non-sperm fraction samples are designated by the presence of “ns” in the item name. Note that this includes either “ns” or “nsf” (e.g. “1C1_nsf” or “1C1_ns”).

5.8.2.3.1.2. Sperm fraction samples are designated by the presence of “sf” and not “ns” in the item name (e.g. “1C1-sf” or “1F2sf_2”).

5.8.2.3.2. A pair of samples with identical case numbers and item numbers, except for the “ns/sf” designations, will be detected as a differential set.

5.8.2.3.2.1. Example: “99F9999_1Cnsf” and “99F9999_1Csf” will be detected as a differential set.

5.8.2.3.2.2. Example: “99F9999_1C-ns” and “99F9999_1Csf” will not be detected as a differential set because of the dash in the non-sperm sample name.
5.8.2.3.3. If a differential set is detected, the two fractions will be compared to each other and only the better fraction (see General Triage Rules, above) will proceed to Priority System Triage.

5.8.2.3.3.1. The “losing” fraction will not be amplified unless it is locked.

5.8.2.4. Priority System Triage

5.8.2.4.1. This section only applies to code M samples.

5.8.2.4.2. Non-differential samples and the “winning” fractions of differential sets (see Differential Triage section) are sorted by their F:M ratio into Priority 1, 2, or 3 categories (P1, P2, or P3).

5.8.2.4.3. The best three samples within a case will be amplified.

5.8.2.4.3.1. These samples are chosen by Priority level (P1>P2>P3) and then by total male DNA amplified (see General Triage Rules, above).

5.8.2.4.3.2. Example: A case contains five samples marked code M. Of these, one is P1, three are P2, and one is P3. The P1 sample is amplified, and the P2 samples are compared to find the best two. The remaining P2 sample and the P3 sample are not amplified.

5.8.2.4.4. After the best three samples are chosen, any remaining locked (code L) samples will also be amplified if eligible.

5.8.3. Sample Preparation

5.8.3.1. Preparation of Samples For Blood, Hair, Saliva, Epithelial Cell Samples And Blood Or Buccal Swab Standards

5.8.3.1.1. For each sample, combine 350 µl Stain Extraction Buffer for Automation (SEBA) with 10 µl Pro K (18 mg/ml) and 40 µl DTT (1M). Example: for 16 samples, combine 5,600 µl Incubation Buffer (or SEBA) with 160 µl Pro K and 640 µl DTT.

5.8.3.1.2. Place sample at the bottom in a 1.5 ml microcentrifuge tube (See sampling protocols in 2.8.3.3). Each group of samples being extracted shall include a reagent blank as the last sample in the batch.

5.8.3.1.2.1. For extraction on the Biomek NX® workstation, samples shall be loaded specifically into Eppendorf (Hamburg, Germany) Safe-Lock 1.5 ml Tubes (Cat. no. 022363212) or Promega (Madison, WI) ClickFit 1.5 ml microtubes (Cat. no. V4741). Do not use “dolphin-style” or other microcentrifuge tubes.

5.8.3.1.3. To the sample add 400 µl Buffer/Pro K/DTT Master Mix. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid.

5.8.3.1.3.1. Do NOT add more than 400 µl of liquid per sample.
5.8.3.1.4. Incubate the sample at 56°C for at least one hour. Alternatively, samples may be incubated overnight.

5.8.3.1.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube. (For hairs it may be preferable to transfer supernatant to a clean microcentrifuge tube before proceeding).

5.8.3.1.6. Using a wooden applicator stick, remove the cutting and proceed to 5.8.2.1.8 or:

5.8.3.1.7. Transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Spin in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the basket insert.

5.8.3.1.8. Close the lid of the sample tube and cut the hinge.

5.8.3.1.9. Save the extract until ready for automated DNA extraction. Do not refrigerate or freeze sample. Prior to submission to the automation team, processed samples may be left at room temperature (22-25°C) up to 24 hours, if necessary.

5.8.3.2. Preparation of Samples For Differential Extraction

5.8.3.2.1. For each sample, combine 240 µl Tris/EDTA/NaCl, 6 µl 20% Sarkosyl, 54 µl NFH₂O and 3 µl Proteinase K (10 mg/ml). Example: for 16 samples, combine 3840 µl Tris/EDTA/NaCl, 96 µl 20% Sarkosyl, 864 µl NFH₂O, and 48 µl Pro K.

5.8.3.2.2. Place the sample in 1.5 ml microcentrifuge tube (See sampling protocols in 2.8.3.4). Each group of samples being extracted shall include reagent blanks (sperm and non-sperm fraction) as the last samples in the batch.

5.8.3.2.2.1. For extraction on the Biomek NX® workstation, samples shall be loaded specifically into Eppendorf Safe-Lock 1.5 ml Tubes or Promega ClickFit 1.5 ml microtubes. Do not use “dolphin-style” or other microcentrifuge tubes.

5.8.3.2.3. To the sample add 300 µl of the Master Mix. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the extraction fluid.

5.8.3.2.4. Incubate the sample at 37°C for 2 hours.

5.8.3.2.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube.

5.8.3.2.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge for about 5 minutes at approximately 14,000 rcf.

5.8.3.2.7. Alternately transfer the cutting into a spin basket insert. Place the basket insert into the tube containing the stain extract. Spin in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the basket insert.

5.8.3.2.8. While being very careful to not disturb any pelleted material, remove the supernatant to a clean, labeled 1.5 ml microcentrifuge tube. This is the non-
sperm fraction. Analysis of the non-sperm fraction resumes at 5.8.2.2.11. The pellet remaining in the tube is the sperm fraction.

5.8.3.2.9. Wash the sperm fraction by resuspending it in 500 µl digest/wash buffer, vortexing the suspension briefly, and spinning the tube in a microcentrifuge at approximately 14,000 rcf for about 5 minutes. Remove and discard the supernatant fluid, being careful not to disturb the cell pellet.

5.8.3.2.10. Repeat step 5.8.3.2.9 two times for a total of three washes.

5.8.3.2.11. Lysis buffer step:

5.8.3.2.11.1. For each sample pair (sperm and non-sperm fraction) combine 600 µl of Lysis Buffer with 6 µl of 1M DTT.

5.8.3.2.11.2. Add 400 µl of the Lysis Buffer master mix to each sperm fraction sample and 200 µl to each non-sperm fraction sample.

5.8.3.2.12. Vortex sample and spin down briefly. Cut the hinge of the sample tube.

5.8.3.2.13. Save until ready for automated DNA extraction. Do not refrigerate or freeze sample. Prior to submission to the automation team, processed samples may be left at room temperature (22–25°C) overnight, if necessary.

5.8.4. Biomek NX® Preparation

5.8.4.1. Wipe down the deck with 70% ethanol or 10% bleach.

5.8.4.2. Ensure that the workstation trash is not full.

5.8.4.3. Ensure that the waste carboy is not full.

5.8.4.4. Ensure that there is enough distilled water in the intake carboy (the valve must be underwater).

5.8.4.5. Ensure that the software is connected to the instrument and not in Simulate mode:

5.8.4.5.1. “Instrument” menu → “Hardware Setup”.

5.8.4.5.2. Set Port option to “COM1”.

5.8.4.5.3. Click “Reconnect” and then “Accept”.

5.8.4.6. Run “Home All Axes” under the Instrument menu.

5.8.4.6.1. Let the tips flush until there are no bubbles created when the pistons move.

5.8.4.6.2. There may be a large bubble stationary at the tops of the syringes; this is normal.

5.8.4.7. Ensure that ethanol and isopropyl alcohol have been added to the alcohol wash buffer in the DNA IQ™ kit.
5.8.5. Initial Tube Transfer

5.8.5.1. Place sample tubes in the tube racks (4x6 with white adapters), arranging the tubes according to the order shown in the Automation Workbook. Do not skip columns or spaces between samples.

5.8.5.2. Ensure that the sample tube lid hinges have been cut.

5.8.5.3. Spin down the tube racks (containing the sample tubes) in the centrifuge. Carefully remove the sample tube lids and discard.

5.8.5.3.1. CAUTION: Once the lids are removed, the Automation Workbook is the only record of the order and identity of each sample.

5.8.5.4. Arrange the deck layout as shown in the figure below:

5.8.5.4.1. Place sample tube racks on positions P8, P9, P11, and P12, again paying attention to sample order according to the Automation Workbook.

5.8.5.4.2. Place a new Promega (Madison, WI) 2.2 ml Square-Well Deep Well Plate (Cat. no. V6781) on position P5. Orient the plate so that the clipped corner is on the bottom left.

5.8.5.4.3. Place a new box of Beckman Coulter (Fullerton, CA) Biomek P250 Span-8 Barrier Tips (Cat. no. 379503) on the Rapid-Shuck module (top left).
5.8.5.5. Open the “Initial Tube Transfer” method contained in the Promega project.

5.8.5.6. Click the green “Run” button at the top of the screen.

5.8.5.7. The method will prompt for two values:

5.8.5.7.1. SampleColumns = the number of full or partial columns of sample on the extraction plate.

5.8.5.7.1.1. Example: 20 samples/blanks will use two full columns and half of a third. Enter “SampleColumns” as 3.

5.8.5.7.2. SampleVolume = the approximate volume of liquid in the sample tubes, in microliters. Round to the next highest hundred microliters, to a maximum of 400 µl.

5.8.5.7.2.1. Example: Most of the sample tubes contain 300 µl, but one tube contains 340 µl. Enter “SampleVolume” as 400.

5.8.5.8. When the instrument has finished transferring sample from the tubes to the sample plate, remove the tube racks from the deck and discard the empty sample tubes.
5.8.5.9. Leave the used P250 Span-8 Barrier Tips on the Rapid-Shuck module for subsequent use in DNA IQ™ automated extraction. Each tip is now associated with a single sample and will only be used to pipet that sample.

5.8.5.10. Remove the 2.2 ml Square-Well Deep Well Plate [containing sample transferred during Initial Tube Transfer (5.8.4)] and cover with a temporary seal. Spin the plate using either a centrifuge or a salad spinner to remove any bubbles and force samples into the bottom of each well.

5.8.6. DNA IQ™ Automated Extraction Procedure

5.8.6.1. Instrument Deck Setup

5.8.6.1.1. Turn on the heating block via the switch to the right of the Biomek NX®, and ensure that temperature is set to 85°C.

5.8.6.1.2. Place the 2.2 ml Square-Well Deep Well Plate sample plate [containing sample transferred during Initial Tube Transfer (5.8.4)] on position P5.

5.8.6.1.3. The box of P250 Span-8 Barrier Tips used in the Initial Tube Transfer (5.8.4) should be unchanged on the Rapid-Shuck module. DO NOT change the orientation of this box.

5.8.6.1.4. Place the following labware on the deck as shown in the figure below:

   5.8.6.1.4.1. Box of Beckman Coulter Biomek P1000 Span-8 Tips (Cat. no. 987925) on position P1. If there are fewer than five columns of tips available, the program will prompt for a full box of P1000 tips on position P3, otherwise, a partial box may be used.

   5.8.6.1.4.2. Box of new P250 Span-8 Barrier Tips on position P11.

   5.8.6.1.4.3. Promega 1.2 ml Round-Bottom Deep Well Plates (Cat. no. V6771) on positions P6 and P4 (aligned on top of the MagnaBot module in P4). Orient each plate so that the clipped corner is on the bottom left.

   5.8.6.1.4.4. Promega 1.1 ml Square-Well V-Bottom Deep Well Plate (Cat. no. V6821) on position P12. Orient the plate so that the clipped corner is on the bottom left.
5.8.6.2. Reagent Setup

5.8.6.2.1. Open the Automation Workbook from the “Robot Team” network folder.

5.8.6.2.2. The “Reagents” tab has a description of the reagents and supplies needed to run automated DNA IQ™ extraction.

5.8.6.2.2.1. Enter the number of samples on the plate, including reagent blanks.

5.8.6.2.2.2. Enter the desired elution volume (between 50-100 µl per sample).

5.8.6.2.2.3. Do not count the No Template Control (NTC) or quantification standards.

5.8.6.2.2.4. Do not add extra samples for excess volume; it is already calculated into the program.

5.8.6.2.3. In a reservoir holder, place the following clean reservoirs in order from left to right: one Quarter Module reservoir (Beckman Coulter, Fullerton CA, cat. no. 372790) divided by height, one additional Quarter Module reservoir, and one Half Module reservoir (Beckman Coulter, cat. no 372786).
5.8.6.2.4. Load reagents in each reservoir as indicated in the “Reagents” tab, adding elution buffer last.

5.8.6.2.5. Place the reservoir holder on deck position P2.

5.8.6.3. **Running the DNA IQ™ Method**

5.8.6.3.1. Open the “Extraction_v2.0.0.ISP” method, contained in the Promega project.

5.8.6.3.2. Click the “Run” button at the top of the screen.

5.8.6.3.3. The method will prompt for two values:

5.8.6.3.3.1. **UsedP1000TipCols** = the number of used full or partial columns in the 1000 µl tip box on position P1. For a new box, enter 0.

5.8.6.3.3.1.1. **Example**: If two and a half columns of P1000 tips have been used, enter “UsedP1000TipCols” as 3.

5.8.6.3.3.2. **UsedP200TipCols** = the number of used full or partial columns in the 250 µl tip box on the Rapid-Shuck module. Assuming a new box was used during the Initial Tube Transfer (5.8.4), the value should be 0.

5.8.6.3.4. A plate map interface will appear.

5.8.6.3.4.1. Enter the approximate sample volume.

5.8.6.3.4.1.1. If a previously-extracted lysate plate is to be re-extracted/purified, increase the sample volume accordingly.

5.8.6.3.4.2. Enter the desired elution volume between 50 and 100 µl (should match the elution volume entered in the Automation Workbook, above).

5.8.6.3.4.3. Set “Sample Type” to “Aqueous”.

5.8.6.3.4.3.1. If a previously-extracted lysate plate is to be re-extracted/purified, set “Sample Type” to “Lysis”.

5.8.6.3.4.4. Set “Perform Lysis Wash?” to “Yes”.

5.8.6.3.4.5. Select the wells to be processed.

5.8.6.3.4.5.1. Click on any well in a column to select the entire column.

5.8.6.3.4.5.2. Click/hold on any well and drag the cursor out of the well to select that well only.

5.8.6.3.4.5.3. Hold “Ctrl” to select separate wells/columns and “Shift” to select consecutive wells/columns.

5.8.6.3.4.5.4. Do not select the last column (#12). This will always be used for quantification standard.
5.8.6.3.4.5.5. Click “Enter”. The wells you selected will change color.

5.8.6.3.4.6. Step 5.8.5.3.4.5 may be repeated to specify different sample volumes or elution volumes, but doing so will change the amount of reagents required for the run (see Reagent Preparation section and step 5.8.5.3.5.1, below).

5.8.6.3.4.7. When all samples have been selected and specified, click “Finished”.

5.8.6.3.5. A map of the reagent reservoir will appear.

5.8.6.3.5.1. Unless the sample volumes have been altered, the reagent volumes should match what the Biomek Workbook displayed in the Reagent Setup section above.

5.8.6.3.5.2. Click “Close Window”.

5.8.6.3.6. The protocol will run for approximately 1 hour 45 minutes, depending on how many samples are being processed.

5.8.6.3.7. When the run is finished, reservoirs may be carefully rinsed, labeled, and reused. Discard partial tip box from position P11. Remaining partial tip boxes may be used again. Discard processing plates (both 1.2 ml Round-Bottom Deep Well Plates). Turn off the heating block.

5.8.6.3.8. Label and retain the original sample plate (2.2 ml Square-Well Deep Well Plate) containing the lysate, as back-up until the samples have been completely processed. Cover and store at room temperature.

5.8.6.3.9. Cover the elution plate (1.1 ml Square-Well V-Bottom Deep Well Plate) containing the extracted samples with a temporary seal, and refrigerate if the plate is not to be quantified immediately.

5.8.7. REAL-TIME PCR QUANTIFICATION USING QUANTIFILER® TRIO Prepared on the Biomek NX® Laboratory Automation Workstation

5.8.7.1. Instrument Deck Setup

5.8.7.1.1. In the Biomek Software, open the “Trio Quant” method contained in the ABI project.

5.8.7.1.2. Click on the “User Interface” line within the method.

5.8.7.1.2.1. To the right, check that “Quantifiler Trio” is selected.

5.8.7.1.2.2. Enter the number of samples to process (equal to the number of elution plate wells that contain extract).

5.8.7.1.2.3. Do not count the NTC or quantification standards.

5.8.7.1.2.4. Do not add extra samples for excess volume; it is already calculated into the program.

5.8.7.1.3. Place the following labware on the deck as shown in the figure below:
5.8.7.1.3.1. New box of Beckman Coulter Biomek P50 Barrier Tips (Cat. no. A21586) on position P2. Alternatively, a partial box may be used by selecting the number and position of remaining tips in the box under the “Properties” tab of the “Instrument Setup” step.

5.8.7.1.3.2. Box of P250 Span-8 Barrier Tips on position P1. A partial box may be used (as above) if at least two columns are available.

5.8.7.1.3.3. New Applied Biosystems (Foster City, CA) MicroAmp® Optical 96-Well reaction plate (Cat. no. N801-0560) on position P11.

5.8.7.1.3.4. The elution plate containing extracted samples on position P12. This plate must be centrifuged prior to quantification to prevent bubbles in the sample wells.

5.8.7.2. Reagent Preparation

5.8.7.2.1. Open the Automation Workbook from the “Robot Team” network folder.

5.8.7.2.2. The “Reagents” tab has a description of the reagents and supplies needed to run automated quantification setup.

5.8.7.2.2.1. Enter the number of samples on the plate, the same as entered into the “User Interface” above.

5.8.7.2.3. When a new Quantifiler® Trio kit is opened, Quantification Enhancer may be added to the reaction mix as follows:
5.8.7.2.3.1. Using a 2.5 µl pipettor, carefully add 1 µl of Quantification Enhancer to each fresh tube of reaction mix. Vortex each reaction mix tube briefly.

5.8.7.2.3.2. Mark each tube of reaction mix with “QE” to indicate that Quantification Enhancer has been added.

5.8.7.2.3.3. Record the lot number of the Quantification Enhancer on the Automated Extraction/Quantification Worksheet.

5.8.7.2.3.4. Quantification Enhancer shall be stored at room temperature.

5.8.7.2.4. Prepare the master mix as described in section 2 of the Forensic Biology Section Casework Test Method, using the volumes indicated on the Reagents tab. Note that for 40 or more samples, the master mix must be divided evenly into two tubes. Vortex the Master Mix 3 to 5 seconds, then centrifuge briefly.

5.8.7.2.5. Place the master mix tube(s) in wells A6 (and B6) of the Reagent Tube Rack as indicated below.

5.8.7.2.6. Prepare the standard dilution series as described in Quantifiler® Trio section of the Biology Section Casework Test Method, or use a previously prepared dilution series. Each tube must contain at least 20 µl of standard.

5.8.7.2.7. Place the standard tubes in column 2 of the Reagent Tube Rack as indicated below.

5.8.7.2.8. Open and fold back all tube caps and place the Reagent Tube Rack on deck position P8.

5.8.7.3. Running the Automated Quant Trio Setup Method

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Master Mix</td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Standard 2</td>
<td>Master Mix</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td>Standard 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Standard 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Master Mix</td>
</tr>
</tbody>
</table>

5.8.7.3. Running the Automated Quant Trio Setup Method
5.8.7.3.1. With the “Quant Trio” method open and the number of samples specified, click the “Run” button at the top of the screen.

5.8.7.3.2. A window will appear to confirm the amount and placement of the master mix tubes. Click “OK”.

5.8.7.3.3. A window will appear to confirm the deck layout as shown by the software. Click “OK”.

5.8.7.3.4. A window will appear to confirm the total amount of master mix, the amount of standard in each of the standard tubes, the sample count, and the quantification kit. Click “OK”.

5.8.7.3.5. The protocol will begin. When the run is finished, remove the elution plate with extracts and cover with a temporary seal until ready to proceed with amplification.

5.8.7.3.6. Seal the optical plate with an optical adhesive cover. Run the edge of the cover applicator between the rows and columns of the wells to ensure that all wells are sealed properly.

5.8.7.3.7. Spin the plate using either a centrifuge or a salad spinner to remove any bubbles and force samples into the bottom of each well.

5.8.7.3.8. Place the plate in the real-time PCR instrument, turn on the instrument, and open the 7500 System software.

5.8.7.4. **Create A Plate Document**

5.8.7.4.1. Open the Automation Workbook file containing the batch of samples being run, and click on the “Extraction-Quant” tab. Ensure that the corresponding plate document contains sample information, otherwise, add and save that information now. Also ensure that the batch number has been entered into the yellow box on the “Samples” tab.

5.8.7.4.2. Press the “Create Quant Setup File” button. A new text file named “Batch#_QuantSetup_Date” will appear in the same folder that contains the Automation Workbook. Click “OK” to proceed.

5.8.7.4.2.1. If there are duplicate sample names in the batch, an error message will list them and the Quant Setup file will not be created until the duplicate names are fixed.

5.8.7.4.3. On the computer connected to the real-time PCR instrument, create a new plate document as described in the Quantifiler® Trio section of the Biology Section Casework Test Method.

5.8.7.4.4. Import the text file you just created. The wells should populate with the names of the samples and standards.
5.8.7.4.5. Enter the plate name under “Experiment”. Save the plate document and proceed with real-time PCR analysis as described in the Quantifiler® Trio section of the Biology Section Casework Test Method.

5.8.8. PowerPlex® Fusion 6C Amplification
Prepared on the Biomek NX® Laboratory Automation Workstation

5.8.8.1. Vortexing Extracts

5.8.8.1.1. Prior to amplification, the extract plate (the elution plate from the DNA IQ™ procedure) shall be vortexed briefly at low speed to ensure uniform pipetting of sample.

5.8.8.1.2. Spin down the extract plate again before proceeding to amplification set-up. (CAUTION: Ensure that there are no bubbles in the wells.) Remove temporary seal.

5.8.8.2. Normalization Data Setup

5.8.8.2.1. Open the Automation Workbook file containing the batch to be amplified.

5.8.8.2.2. On the “Extraction-Quant” tab, click the “Import & Analyze Quant Results” button.

5.8.8.2.3. Browse for the appropriate text import file containing quantification data for this batch. Click “Open”.

5.8.8.2.4. The Automation Workbook will analyze the batch, create the Quantification Results and Standard Curve worksheets, create the Amplified Samples summary, create the Samples Not Amplified summary, and fill the samples on the Amplification Setup/CE Plate Record.

5.8.8.2.4.1. If any standard curve parameter fails, or if the NTC contains a value, or if a standard curve well has an undetected IPC, an error message will appear and the batch will not be analyzed until the standard curve is fixed. Points should be omitted in the Real-Time PCR software and a new results file exported.

5.8.8.2.5. A new .csv file named “Batch#_AmpSetup” (the AmpSetup file) will appear in the same folder that contains the Automation Workbook. Click “OK” to proceed.

5.8.8.2.6. Move or copy this AmpSetup file to the folder //IN PROGRESS/Amp Setups on the “Robot Team” drive.

5.8.8.3. Instrument Deck Setup

5.8.8.3.1. In the Biomek Software, open the “Normalize-Amp_Fusion6C” method contained in the Promega project.

5.8.8.3.2. Place the following labware on the deck as shown in the figure below:

5.8.8.3.2.1. Box of P250 Span-8 Barrier Tips on the Rapid-Shuck module.
5.8.8.3.2.2. Box of P50 Barrier Tips on position P1. A second box of P50 Barrier Tips may be required on position P3.

5.8.8.3.2.3. 1.1 ml square-bottom deepwell plate on position P5. A second 1.1 ml square-bottom deepwell plate may be required on position P8.

5.8.8.3.2.4. New 96-well optical amplification plate on position P6.

5.8.8.3.2.5. Extract plate containing samples on position P4.

5.8.8.3.2.5.1. CAUTION: ensure that the MagnaBot module has been removed.

5.8.8.3.3. Click “Run”.

5.8.8.3.4. The program will prompt for three values:

5.8.8.3.4.1. BatchNumber = The batch number being amplified, in the format Year-XXX. This directs the Biomek software to import the correct Amp Setup file from the //IN PROGRESS/Amp Setups folder.

5.8.8.3.4.2. First_P250_Tip = the number of the first unused tip in the 250 µl tip box on the Rapid-Shuck module, numbering down columns and then across. For a new box, enter 1.
5.8.8.3.4.3. Example: If two and a half columns (twenty tips) of P250 tips have been used, enter “First_P250_Tip” as 21.

5.8.8.4. Reagent Preparation

5.8.8.4.1. Follow the prompts within the Biomek Software. Note that depending on the dilution of samples within the batch, the protocol may require an additional 1.1 ml square-bottom deepwell plate on position P8.

5.8.8.4.2. Place the STR Master Mix tube in position 4 (front-most) of the Left Tube Holder on the reagent rack.

5.8.8.4.3. Place the tube containing diluted positive control (at least 20 µl) in position 1 (rear-most) of the Right Tube Holder on the reagent rack. Click “OK”.

5.8.8.4.4. Pipet the indicated amount of amplification-grade water or nuclease-free water into the center trough of the reagent rack. Place the reagent rack on deck position P2.

5.8.8.5. Running the Normalization/Amp Set-up Method

5.8.8.5.1. Check that the deck layout matches the layout indicated in the next prompt. Click “OK”.

5.8.8.5.2. The run will begin, performing normalization and amplification setup in one step.

5.8.8.5.3. When the run is finished, remove the amplification plate and cover with adhesive foil. Press the foil well using a roller tool.

5.8.8.5.4. Remove the elution plate containing extracted samples and cover with a temporary seal and refrigerate.

5.8.8.6. Create CE Plate Record

5.8.8.6.1. The Amp-CE Plate Record in the Automation Workbook is automatically populated with the amplified samples when the batch is analyzed with quantification results.

5.8.8.6.2. Open the Automation Workbook containing the batch of interest and click on the “Amp-CE” tab.

5.8.8.6.3. Click the “Export CE Setup File” button. A new text file named “Batch#_CESetup_Date” will appear in the same folder that contains the Automation Workbook. Click “OK” to proceed.

5.8.8.6.3.1. If no plate name has been filled in, the file will contain a default plate name in the format “Batch#_Date_01”. This can be changed on the “Amp-CE” tab or in the genetic analyzer software.
5.8.8.6.4. Samples may be added manually to the CE plate record and “CE Setup” tab, as needed, before clicking the “Export CE Setup File” button. Only samples listed on the “CE Setup” tab will be included in the exported CE Setup file.

5.8.8.6.5. Fill out the rest of the worksheet as designated, including dates, reagent lot numbers, amplification reaction type, and injection protocols.

5.8.9. Preparing a 3500 plate on the Biomek 3000

5.8.9.1. Biomek 3000 Preparation

5.8.9.1.1. Open the “Biomek Software” located on the desktop.

5.8.9.1.2. Calibrate the Biomek 3000 prior to operation.

5.8.9.1.3. All tubes of allelic ladder in the post-amplification kit shall be combined into a single 1.5 ml Eppendorf microcentrifuge tube or Promega 1.5 ml ClickFit microtube (do not use a “dolphin”-style tube), marked as “ladder” with associated lot numbers recorded on the tube, and stored with the kit when not in use.

5.8.9.2. Instrument Deck Setup

5.8.9.2.1. Click File \(\rightarrow\) Open, select “3500_Direct_transfer_with_ladder” for 3500xL setup.

5.8.9.2.1.1. This will open the designated program that will transfer a plate with dedicated ladder positions into the A6, A12, H3, and H9 positions for 3500xL setup.

5.8.9.2.2. Place the following labware on the deck as shown in the figure below:

5.8.9.2.2.1. Box of Beckman Coulter Biomek AP96 P250 Tips (Cat. no. 717253) on the ML1 position.

5.8.9.2.2.2. Two boxes of Beckman Coulter Biomek AP96 P20 Tips (Cat. no. 717256) on the ML2 and ML3 positions.

5.8.9.2.2.3. One new 96-well optical plate at position P2.

5.8.9.2.2.4. Spin down the amplification plate and ensure that no bubbles remain. Place the plate in deck position P3. Secure the amplified plate to the plate rack with tape.
5.8.9.2.3. In the software program, click the “Instrument Setup” step, which will bring up the Deck Display.

5.8.9.2.4. Right-click on P250 box in position ML1 and select “Properties” to open the “Labware Properties” menu as shown below.

5.8.9.2.5. Ensure that the “Unload Tips Into:” drop down menu is selected as “Disposal1”, the “When empty, send to:” drop down menu is selected as “<Home>”, and the “Load no more than” drop down menu is designated as “1”.

5.8.9.2.6. Select “Show Available Tips” as shown below.

5.8.9.2.7. By clicking on individual tip locations, you may designate whether tips are present (blue) or absent (white). For every location where a tip is absent from the physical deck, click the appropriate location to turn that location white. You may reference the bottom left corner of the menu to determine the number of available tips that are being designated as usable.
5.8.9.2.8. Configure Labware Properties and available tips for the P20 boxes located at positions ML2 and ML3 in the Deck Layout.

5.8.9.3. Reagent Preparation

5.8.9.3.1. To prepare master mix for automated dispensing by the Biomek 3000:

5.8.9.3.2. In a 1.5 ml Eppendorf microcentrifuge tube or Promega 1.5 ml ClickFit Microtube, prepare the appropriate volume of master mix (Hi-Di™ and ILS) for the associated number of samples and/or columns (see example chart below for 0.5 µl ILS/sample).

<table>
<thead>
<tr>
<th>Number of Samples+Ladders</th>
<th>Number of Columns</th>
<th>ILS (µl) (0.5 µl/sample)</th>
<th>Hi-Di (µl)</th>
<th>Total (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-24 (3500xL)</td>
<td>3</td>
<td>13</td>
<td>247</td>
<td>260</td>
</tr>
<tr>
<td>25-48 (3500xL)</td>
<td>6</td>
<td>25</td>
<td>475</td>
<td>500</td>
</tr>
<tr>
<td>49-72 (3500xL)</td>
<td>9</td>
<td>38</td>
<td>712</td>
<td>750</td>
</tr>
<tr>
<td>73-96 (3500xL)</td>
<td>12</td>
<td>49</td>
<td>931</td>
<td>980</td>
</tr>
</tbody>
</table>

5.8.9.3.2.1. Do not use a “dolphin”-style microcentrifuge tube, or the robot may fail to load master mix accurately to the columns.

5.8.9.3.2.2. Ensure that sufficient master mix is prepared to cover all capillaries during electrophoresis, or manually pipet Hi-Di™ into empty wells after the plate is complete.

5.8.9.3.3. Vortex and spin down, ensuring that no bubbles remain.

5.8.9.3.4. Place the prepared master mix tube in position A1 of the 24-well tube rack located in position P4 on the Deck, as shown in blue below.
5.8.9.3.5. Vortex and quickly spin down the combined tube of allelic ladder and ensure that no bubbles remain.

5.8.9.3.6. Place the tube of ladder in position D1 of the 24-well tube rack located in position P4 on the Deck, as shown in green above.

5.8.9.4. Starting the CE Plate Set-up Run

5.8.9.4.1. Remove all lids from tip boxes and from the tubes of prepared master mix and ladder and place them clear of the deck.

5.8.9.4.2. In the software program, click on the green “run” arrow located on the top command bar, as shown below.
5.8.9.4.3. Follow the prompts as they appear. You will be asked to input the number of columns for the plate setup. This number should be the same as originally determined when preparing the master mix (see chart above).

5.8.9.4.4. When the program has completed, remove and discard any empty tip boxes.

5.8.9.4.5. Discard the master mix tube, and store the allelic ladder tube with the post-amplification kit.

5.8.9.4.6. Seal the amplification plate with aluminum foil plate seal and store frozen.

5.8.9.4.7. Add a septa cover to the CE plate, and load onto genetic analyzer as described in section 2 of the Forensic Biology Section Casework Test Method.

5.8.10. Final Tube Transfer

5.8.10.1. Open the Automation Workbook containing the set of samples that have been run, and click on the “FTT Layout” tab. Click the “Consolidate Samples” button on the upper right. Only code T samples, which have been designated by the analyst to be returned to tubes, will be included in the final tube transfer. The remaining samples will remain in the elution plate.

5.8.10.1.1. The layout worksheet will tell you how many tubes/labels you will need. If you wish to print labels on a partially-used sheet, you may designate how many labels are missing from the sheet in the “# of used labels” box. A map of a label sheet is included on the right for reference.

5.8.10.1.1.1. You cannot use a partial sheet if the # of used labels + # of tubes required is greater than 80.
5.8.10.2. Click the “Export FTT File” button. A new.csv file named “<batch ID>_FTT Setup” will appear in the same folder that contains the Automation Workbook. Click “OK” to proceed.

5.8.10.3. Move or copy the .csv file to the folder //IN PROGRESS/FTT Setups on the “Robot Team” drive.

5.8.10.4. Place new, empty, labeled Molecular BioProducts (San Diego, CA) 1.5 ml screw-top tubes (Cat. no. 3474) in the tube racks (4x6 with white adapters), arranging the tubes according to the order shown in the “Consolidated Extracts in Tubes” layout on the “FTT Layout” tab of the Automation Workbook. Do not skip columns or spaces between samples.

5.8.10.5. Arrange the deck layout as shown in the figure below:

5.8.10.5.1. Place sample tube racks on positions P5, P6, P8, and P9, again paying attention to sample order according to the FTT Layout.

5.8.10.5.2. Place the plate containing extracted samples on position P4.

5.8.10.5.3. Place a new box of Beckman Coulter Biomek P250 Span-8 Barrier Tips on position P1.

5.8.10.6. Open the “Final Plate to Tube Transfer” method contained in the Promega project.

5.8.10.7. Click the green “Run” button at the top of the screen.
5.8.10.7.1. The method will prompt for the Batch ID. Type the Batch ID in the format “Year-000” (e.g., “2017-001”). This tells the software which .csv file to use in the folder “FTT Setups” mentioned above.

5.8.10.8. When the instrument has finished transferring sample from the extraction plate to the tubes, remove the tube racks from the deck and cap the screw-top tubes.

5.8.10.8.1. The extraction plate, which now contains only extracts of reference samples and property crime samples, shall be covered with a temporary seal, refrigerated, and saved for a minimum of 60 days, after which it may be discarded.

5.8.11. When processing is completed, the submitting analyst will be notified by e-mail that the data is available on the DNA server and the extracted DNA samples can be retrieved from a designated location.

5.9. Records:

5.9.1. N/A

5.10. Interpretation of Results:

5.10.1. N/A

5.11. Report Wording:

5.11.1. N/A

5.12. References:

5.12.1. N/A
Items outside of a Sexual Assault kit** (e.g., clothing, bedding, etc.) for Semen Identification

- Acid Phosphatase
  - Negative: Report Out
  - Positive: Sperm Search*
    - Negative: DNA Extraction*
    - Positive: Differential Extraction

*Optional/Analyst's discretion
**Underwear submitted separately from a sexual assault kit may be examined with kit protocols.
BLOOD IDENTIFICATION

PHENOLPHTHALEIN

POSITIVE

NEGATIVE

REPORT OUT

OPTIONAL CONFIRMATORY TESTING

DNA ANALYSIS

Any stain identification testing may be omitted if sample would be consumed before DNA analysis.
Above flowcharts reflect typical evidence but cannot account for all case scenarios. Deviation from above may be obtained with supervisor approval.

*Evidence collection kit samples that demonstrate no amplifiable male DNA shall be returned, and their extracts shall be discarded.
### Automation Sample Triage

**Sample Property Codes:**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Standard</td>
</tr>
<tr>
<td>M</td>
<td>Stop if no Male</td>
</tr>
<tr>
<td>L</td>
<td>Locked</td>
</tr>
<tr>
<td>T</td>
<td>Return to Tube</td>
</tr>
</tbody>
</table>

### Triage Process:

1. **Sufficient Autosomal?**
   - ≥ 0.01 ng/uL, ≤ 50 ng/uL
   - **Yes:** Code M? (Stop if no male)
   - **No:** Amped

2. **Code M?** (Stop if no male)
   - **Yes:** F:M Ratio ≤ 50? (Priority 3 or better)
   - **No:** Amped

3. **F:M Ratio ≤ 50?** (Priority 3 or better)
   - **Yes:** Extraction Type
     - Detected by "sfsp/ns/nsf" in sample name
   - **No:** Amped

4. **Extraction Type**
   - **Differential**
   - **Regular**

5. **Compare SF/SP vs. NS/NSF**
   - **"Losing" fraction**
   - **"Winning" fraction**

6. **Code L?** (Locked)
   - **Yes:** Remaining samples
   - **No:** Amped

7. **Main Triage**
   - Compares total male DNA amp input for all samples within a case. Takes normalization into account. Chooses best three samples to amp.
   - **Up to 3 best samples per case**
APPENDIX 2
HID Real-Time PCR Analysis Software v1.2 and Quantifiler®
Trio template set-up

1.1 Create a “CASEWORK” folder on the AB_SW&DATA D: drive and a shortcut on the desktop.
1.2 Create an “IMPORT” folder on the desktop.
1.3 Open the HID Real-Time PCR Analysis Software v1.2.
1.4 Select Tools → Preferences and select the “Defaults” tab.
   1.4.1 Change the default Data Folder and Export Folder destinations to the “CASEWORK” folder found on the D: drive. Change the default Import Folder destination to the “IMPORT” folder on the desktop.
   1.4.2 Select the “Startup” tab and deselect “User name required”. Mark only “FAM” and “VIC” for calibration status.

![Preferences Menu](image)
1.5 Select the **Quantifiler® Trio** icon on the Home screen.

1.6 Select **Analysis → Analysis Settings** to remove all flags from the “HID Settings” and “Flag Settings” tabs.
1.7 Verify the CT Settings in the image below.

1.8 Select **Plate Setup** from the left navigation pane and assign the 4 standard curve points to column 12 in duplicate.
1.8.1 The task for the Lg. Auto, Sm. Auto, and Y targets for each standard curve point shall be designated as “Standard”. The task for the IPC target shall be designated as “Unknown”.

1.8.2 Enter the appropriate quantity for each Lg. Auto, Sm. Auto, and Y targets. (See the Standard Curve Prep Table above)

1.9 Assign the NTC to well H11 and mark the task for the Lg. Auto, Sm. Auto, and Y targets as “Negative control”. The task for the IPC target shall be designated as “Unknown”.

1.10 All remaining wells shall be left blank.

1.11 Verify the Run Method.

Holding Stage: 95.0°C for 2.00 minutes.

Cycling stage: 40 cycles of 95°C for 9 seconds, 60.0°C for 30 seconds.
1.12 Select **Export** and change the options to match the following two images. Ensure the Results Export are in the following order: Well, Sample Name, Task, Target Name, C_T, and Quantity. Select **Save as default** at the bottom and **Start Export**.
1.13 Overwrite the QuantifilerTrio.edt template by selecting **Save → Save changes as template**. Navigate to **AB_SW&DATA (D:) → Applied Biosystems folder → 7500 folder → config folder → templates folder** and select **QuantifilerTrio.edt**.
Instrument setup for Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0

(only necessary the first time PowerPlex® Fusion 6C samples are run or if the parameters change)

1.0 Configure the Security Settings

1.1 Navigate to Tools and select “Security”.
1.2 Change Screen settings to those depicted below.
1.3 Click “Save Settings”.

Security Screen:
2.0 Edit User Roles

2.1 Click the “Users” button in the left navigation pane.

2.2 Open the “Roles” tab.

2.3 Set preferences to those depicted below.

2.4 Select “Scientist” and click “Edit”.

2.5 Click “Save Role”.

Scientist User Role:
3.0 Create User Accounts

3.1 Click on the “Users” tab.

3.2 Click “Create” to access a New User window.

3.3 Enter a unique User Name (ex. jdoe8251), set “Password” to lowercase “password” and re-enter. Enter user’s first and last name and change settings to those depicted below. Ensure the “User Role” is either set as an “Administrator” or “Scientist”.

3.4 Click Save.

New User Window:
4.0 Manage Audit Settings

4.1 Navigate to Tools and Select “Audit”.

4.2 Turn Auditing off by ensuring the “Disable Audit” is grayed out and the “Enable Audit” appears black as depicted below.

4.3 Audit settings may be altered depending on current need.

Disable Audit Settings:
5.0 Manage Electronic Signature Settings

5.1 Navigate to **Tools** and Select “E-Signature”.

5.2 Turn E-Signature off by ensuring that the “Disable E-Sig” is grayed out and the “Enable E-sig” is black as depicted below.

5.3 E-Signature settings may be altered depending on need.

**Disable E-Signature Settings:**

![Image of E-Signature settings](image-url)
6.0 Create an Instrument Protocol

6.1 Navigate to the Library and select “Instrument Protocols”.

6.2 Select “Create”.

6.3 Select “HID” for the Application Type.

6.4 Select “36” for the Capillary Length.

6.5 Select “POP4” for the Polymer.

6.6 Select “Promega_J6” for the Dye Set.

6.7 Select “HID36_POP4” for the Run Module on the 8-capillary 3500. Select “HID36_POP4xl” on the 24-capillary 3500xl.

6.8 Enter “13.0” for the Run Voltage (kVolts).

6.9 Enter “1.2” for Injection Voltage (kVolts).

6.10 Enter “15” seconds for the Injection Time on the 8-capillary 3500. Enter “20” seconds on the 24-capillary 3500xl.

6.11 Change the Run Time (sec) to “1500”.

6.12 Name the protocol with the kit name and the injection voltage and time (i.e. Fusion6C_1.2kv15s).

6.13 Mark “Locked” and click “Save”.

Instrument Protocol:
7.0 Create a Size Standard

7.1 Navigate to the Library and select “Size Standard”.

7.2 Select “Create”.

7.3 Assign the name “WEN ILS 500”.

7.4 Select “Orange” for the Dye Color.

7.5 Type the following into the left column: 60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500. Click “Add Size(s) >>”.

7.6 Mark “Locked” and click “Save”.

Size Standard:
8.0 Create a QC Protocol

8.1 Navigate to the Library and select “QC Protocols”.
8.2 Select “Create”.
8.3 Assign the name “WEN ILS 500”.
8.4 Change settings to match the figure below.
8.5 Mark “Locked” and click “Save”.

QC Protocol:
9.0 Create an Assay

9.1 Navigate to the Library and Select “Assays”.
9.2 Select “Create”.
9.3 Title the assay name “Fusion6C_1.2kv15s” on the 8-capillary 3500, and “Fusion6C_1.2kv20s” on the 24-capillary 3500xl.
9.4 Select “HID” for the Application Type.
9.5 Select “Fusion6C (WEN ILS 500)” as the QC Protocol.
9.6 Select the appropriate instrument protocol.
9.7 Mark “Locked” and click “Save”.

Assay:
10.0 Create a Naming Convention

10.1 Navigate to the Library and Select “File Name Convention”.

10.2 Select “Create”.

10.3 Title the name convention “Fusion6C_FNC”.

10.4 Select the attributes and delimiters in the image below, click “Add”. The order of the attributes and delimiters can be changed using the “Move Up” and “Move Down” buttons.

10.5 Leave file location as the default.

10.6 Look at the “Preview of File Name” field for accuracy.

10.7 Mark “Locked”, and Click “Save”.

File Name Convention:
11.0 Create a Results Group

11.1 Navigate to the Library and Select “Results Group”.

11.2 Select “Create”.

11.3 Title the results group “Fusion6C_RG”.

11.4 Select the attributes and delimiters in the image below, click “Add”. The order of the attributes and delimiters can be changed using the “Move Up” and “Move Down” buttons.

11.5 Ensure that “Store reinjection sample file with original sample files (same level)” is selected.

11.6 Leave file location as the default.

11.7 Click so the “Include a Result Group Name folder” box is selected.

11.8 Look at the “Preview of Results Group Name” field for accuracy.

11.9 Mark “Locked” and click “Save”.

Results Group:
GeneMapper® ID-X

1. Setting Up GeneMapper® ID-X Version 1.4 Software User Accounts and Security System

1.1 Setting Up Password Policies

1.1.1 Open the GeneMapper® ID-X version 1.4 software.

1.1.2 Login using an administrator user account.

1.1.3 Select “Admin” then “Security Manager”.

1.1.4 Login with the same administrator user account.

1.1.5 Select “Settings” then “Password Policies”.

1.1.6 Change the settings to match the figure below.

Password Policies:

1.1.7 Save changes.

1.2 Creating a User Group

1.2.1 Open the Security Manager.

1.2.2 Select the appropriate default user group in the left navigation pane (e.g., “Casework User Group”).

1.2.3 Select “Edit” then “Duplicate”.

Below are the system-wide password policies.

- Attempts:
  - Max Login Attempts: 5
  - Upon Failure:
    - Send log message
    - Set User State:
      - Remain active
      - Suspend for: 10 min(s)

- Password:
  - Password Lifetime: 90 days
  - Password Grace Logins: 5
  - Password Reusability:
    - Password Reuse Period: 30 days
    - Passwords kept per user: 10

- Password Format:
  - Minimum Password Length: 6 characters
1.2.4 In the “General” section, enter a name for the user group (e.g., “ISP Casework User Group”).

1.2.5 In the “Default Rights” section, make sure the “Read” and “Update” options are checked.

1.2.6 Select the “Security Groups” tab. Ensure all associated security groups are checked, including the “GeneMapper ID-X” security group.

1.3 Creating a Security Group

1.3.1 Open the Security Manager.

1.3.2 Select the appropriate default security group in the left navigation pane (e.g., “Casework Security Group”).

1.3.3 Select “Edit” then “Duplicate”.

1.3.4 In the “General” section, enter a name for the security group (e.g., “ISP Casework Security Group”).

1.3.5 In the “Associate” column, select the appropriate user groups to associate with that security group (e.g., “ISP Casework User Group”). Make sure the “Read” and “Update” options are checked for the selected user groups.

1.4 Creating a Profile

1.4.1 Open the Security Manager.

1.4.2 Select the appropriate default profile in the left navigation pane (e.g., “Analyst”).

1.4.3 Select “Edit” then “Duplicate”.

1.4.4 In the “General” section, enter a name for the profile (e.g., “ISP Analyst”).

1.4.5 In the “Installed Elements” table, select allowed actions for that particular profile. Allowed actions are not automatically inherited from the default profile and have to be manually entered. For the “ISP Analyst” profile, check the same allowed actions as those for the default GeneMapper® ID-X “Analyst” profile, with the exception of the “Update Panel” and “Update Size Standard” actions. Change those actions to match the selections in the image below.
1.5 Setting Up A User Account

1.5.1 Open the Security Manager.

1.5.2 Select the appropriate default user type in the left navigation pane for that particular user (e.g., “Casework Analyst”).

1.5.3 Select “Edit” then “Duplicate”.

1.5.4 In the “General” section, enter a name. This will be the login name.

1.5.5 In the “User Details” section, enter a full name. Leave the status set to “Active.” Uncheck “Show EULA”.

1.5.6 Select a profile (e.g., “ISP Analyst”).

1.5.7 Select one or more user groups (e.g., “ISP Casework User Group”).
1.5.8 In the “Password” section, select “Set Password”. Enter the same password twice and click “OK”. Check “Pre-Expire”.

2.0 GeneMapper® ID-X Version 1.4 Software Settings - PowerPlex® Fusion 6C

2.1 Import Panel and Bin Files

2.1.1 Open the GeneMapper® ID-X version 1.4 software.

2.1.2 Select Tools → Panel Manager.

2.1.3 Highlight the “Panel Manager” icon in the navigation pane.

2.1.4 Select File → Import Panels.

2.1.5 Navigate to the saved panel, bin, and stutter files. Select “PowerPlex_Fusion_6C_v2_Panels_ISP_IDX_v1.1” and click “Import”.

2.1.6 Select the “ISP Casework Security Group”. Click “OK”.

2.1.7 In the navigation pane, highlight the “PowerPlex_Fusion_6C_v2_ISP_IDX_v1.1” folder.

2.1.8 Select File → Import Bin Set.

2.1.9 Select “PowerPlex_Fusion_6C_v2_Bins_ISP_IDX_v1.1” and click “Import”.

2.1.10 In the navigation pane, highlight the “PowerPlex_Fusion_6C_v2_ISP_IDX_v1.1” folder.

2.1.11 Select File → Import Marker Stutter. A warning box will appear asking to overwrite the current values. Select “Yes”.

2.1.12 Select “PowerPlex_Fusion_6C_v2_Stutter_ISP_IDX_v1.1” and click “Import”. This will import the Promega Marker Stutter file that has been modified to include the Indiana State Police PowerPlex® Fusion 6C stutter percentages for filtering out mean +3SD stutter as determined by internal validation studies.

2.1.13 In the Panel Manager window, select “Apply”, then “OK”.

2.1.14 Repeat this process with the panels, bins and marker stutter files for analysis of unknowns to be run in STRmix™.

2.1.14.1 Panels: “STRmix_v2_Fusion_6C_v2_Panels_ISP_IDX_v1.1_Panels”.

2.1.14.2 Bins: “STRmix_v2_Fusion_6C_v2_Bins_ISP_IDX_v1.1_bins”.

2.1.14.3 Marker Stutter: “STRmix_v2_Fusion_6C_v2_Stutter_ISP_IDX_v1.1_stutter”.

2.2 Create a Casework Analysis Method

2.2.1 Select Tools → GeneMapper Manager.

2.2.2 Select the Analysis Methods tab.

2.2.3 Enter the name “Fusion6C_v2”.

2.2.4 Select the “ISP Casework Security Group”.

2.2.5 Enter “3500” as the instrument.

2.2.6 Select the Allele tab. In the “Bin Set” drop-down menu select “PowerPlex_Fusion_6C_v2_Bins_ISP_IDX_v1.1”. Verify that the “Use marker-
specific stutter ratio and distance if available” box is checked. All values shall be “0.0”.

Allele Tab:
2.2.8 Select the **Peak Detector** tab. Change the settings to match those shown in the following figure.

**Peak Detector Tab:**

![Peak Detector Tab Image]

2.2.9 Select the **Peak Quality** tab. Change the settings to match the following figure.

**Peak Quality Tab:**

![Peak Quality Tab Image]
2.2.10 Select the **SQ and GQ Settings** tab. Change the settings to match the following figure.

**SQ and GQ Settings:**

![Diagram of SQ and GQ Settings](image)

2.2.11 Select “Save”.

2.2.12 Repeat these steps to create the “STRmix_Fusion6C_v2” analysis method used to analyze unknown profiles for STRmix™ interpretation. All steps are identical except the following:

2.2.12.1 Enter the name “STRmix_Fusion6C_v2”.

2.2.12.2 Select the **Allele** tab. In the “Bin Set” drop-down menu select “STRmix_v2_PowerPlex_Fusion_6C_Bins_ISP_IDX_v1.1”.

2.3 *Create a Size Standard*

2.3.1 Select **Tools → GeneMapper Manager**.

2.3.2 Select the **Size Standard** tab and click “New”.

2.3.3 Name the size standard “WEN ILS 500” in the “Size Standard Editor” screen, choose the “ISP Casework Security Group”, and choose “Orange” as the color for the size standard dye.

2.3.4 Enter the sizes of the 21 allelic ladder fragments: 60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500.

2.3.5 Select “OK”.
2.4 Create a Table Setting

2.4.1 Select Tools → GeneMapper Manager.

2.4.2 Select the Table Setting tab and click “New”.

2.4.3 Under the General tab name the Table Setting “STRmix_Fusion6C” and select the “ISP Casework Security Group”.

2.4.4 Under the Samples tab ensure that check marks are located next to only the following: Status, Sample File, Sample Name, Sample Type, Analysis Method, Panel, Size Standard, Sizing Quality Overridden, Sample File Not Found, Sample Off-Scale, and Sizing Quality.

2.4.4.1 Sort by “Sample Type” and then by “Sample Name”. Select the “Ascending” option for both, and leave the final sort option to “None”.

2.4.4.2 Leave the font “Arial” and the size “11”.

2.4.5 Under the Genotypes tab ensure that check marks are located next to only the following: Sample Name, Marker, Allele, Size, and Height.

2.4.5.1 Sort by “Sample File”, then by “Sample Name”, and then by “Marker”. Select the “Ascending” option for all three.

2.4.5.2 Change the “Show number of alleles” to 20 and ensure that “Keep Allele, Size, Height, Area, Data Point, Mutation and Comment together” is NOT checked. (If the option to “Keep Allele, Size, Height…” is not visible in the window, expand the window size until the option appears.)

2.4.5.3 Leave the font “Arial” and the size “11”.

2.4.6 Select “OK”.

2.5 Create a Plot Setting – Samples, Controls, and Ladders

2.5.1 Select Tools → GeneMapper Manager.

2.5.2 Select the Plot Settings tab and click “New”.

2.5.3 Under the General tab name the Plot Setting “Fusion6C” and select the “ISP Casework Security Group”.

2.5.4 Under the Sample Header tab ensure that check marks are located next to the following: Sample File, Sample Name, Panel, Sizing Quality Overridden, Sample Off-Scale, and Sizing Quality.

2.5.5 Under the Genotype Header tab ensure that check marks are located next to the following: Sample File, Sample Name, Panel, Marker, Sample Off-Scale, Out of Bin Allele, Peak Height Ratio, Control Concordance, and Genotype Quality.

2.5.6 Under the Sizing Table tab ensure that check marks are located next to the following: Dye/Sample Peak, Sample File Name, Marker, Allele, Size, Height, Area, and Data Point. Leave the font “Arial” and the size “11”.

2.5.7 Select the Labels tab. Change the settings to match the following figure. Alternatively, if the “allele edit comment” function is not being used, “Label 4” for “Assigned Allele”, “Custom Allele” and “Artifact” can be changed to “NONE”.
Labels Tab:

![Plot Settings Editor](image)

- **Show Labels on Samples and Genotype Plot**
  - **Assigned Allele**
    - Label 1: Allele Call
    - Label 2: Height
    - Label 3: Size
    - Label 4: AE Reason for Char...
  - **Custom Allele**
    - Allele Call
  - **Allele Ladder**
    - Height
    - Size
  - **Artifact**
    - Height
    - Size

- **Font**
  - Font: Times New Roman
  - Size: 8

- **When opening the Plot Window**
  - Show PTV trigger peak (LPH,UKH,DD,OS)
  - Show data type prefixes
  - Display virtual allele label in black
  - Show type of edit
  - Label Color: Dye Color/Border

[OK] [Cancel] [Help]
2.5.8 Under the Display Settings tab, change the display settings so that they match the following figure and select “OK”.

Display Settings Tab:

![Image of Display Settings Tab]

2.6 GeneMapper® ID-X Maintenance

2.6.1 The number of audit records on the GeneMapper® ID-X database should be routinely checked. Audit records should be backed-up, saved to the DNA server, and then deleted from the GeneMapper® ID-X database routinely or if the number of records exceeds 40,000. If the number of audit records exceeds 60,000, the performance of the software may be affected.

2.6.2 The amount of database space in the GeneMapper® ID-X software should be routinely checked. If the occupied space exceeds 80%, additional disk space should be allocated.
APPENDIX 5

STRmix™ SETTINGS

1.0 STRmix™ Installation and Set-up

1.1 Install the current version of STRmix™ (v2.5.11).

1.2 Copy and Replace the following files from the BiologyQA drive to the STRmix™ Program files located on the (C:) drive:

   1.2.1 AlleleFreq folder, Kits folder, lib folder, plugins folder, Populations folder, stutters folder, Default Configuration settings, ISP Lab Logo, Report Defaults XML document, STRmix.dat file, and STRmix.ist file.

1.3 Update to the floating license:

   1.3.1 After opening STRmix™, if no prompt comes up with the ability to install a license/validate license server, select About, and then select Remove License. It will tell you that you won’t be able to use STRmix™ again until a license is installed and will close the program.

   1.3.2 Reopen the program and follow the prompt to validate the license server.

   1.3.3 In the Host name, put the following IP address – 10.16.105.36 and the port# 16090.

   1.3.4 Select Validate. It should then connect via the floating license server and access a license.

1.4 Kit Parameters

   1.4.1 To access the run parameter settings from the STRmix™ main menu, select Settings (an administrator password shall be required), then select Manage DNA profiling kits.

   1.4.2 The following settings shall be used for the interpretation of profiles:
1.4.3 In the “Gender Locus?” column, AMEL shall be checked.

1.4.4 In the “Ignore Locus?” column, DYS391, DYS576, and DYS570 shall be checked.

1.4.5 The Detection Threshold for all loci shall be set at 150.

1.5 Default Settings

1.5.1 To access the default settings, from the STRmix™ main menu, select Settings (an administrator password shall be required), then select Configure STRmix Defaults.

1.5.1.1 The following default analysis settings shall be used for the interpretation of profiles:
1.6 Population Settings

1.6.1 The following four population databases shall be used to perform statistical calculations: NIST_2017_Caucasian, NIST_2017_African_American, NIST_2017_Hispanic, and NIST_2017_Asian.

1.6.2 To access the population parameter settings, from the STRmix™ main menu, select Settings, then select Manage Populations.

1.6.3 The following population settings shall be used for the interpretation of profiles.

1.6.3.1 \( F_{ST} \) Coancestry Coefficient, Theta (\( \theta \)): corrects for two alleles identical by descent in different individuals. An \( F_{ST} \) of 0.01 was selected for the four populations.
1.7 Report Settings

1.7.1 To access the Summary Report settings, from the STRmix™ main menu, select Settings, then select Configure Report Defaults, and then select Summary Report.

1.7.2 The following report settings shall be used. Drag the individual Included Components to arrange their reporting order.

1.7.3 Select the LR Summary component, and verify that Show Unified LR and Show Stratified LR are checked.

1.7.4 Select Genotype Probability Distribution, and verify that Highlight Weight Greater Than is set to 0.99, and Row Limit Per Locus is set to -1.

1.7.5 Select Component Interpretation, and verify that Inconclusive Value is set to F, that Genotype Weighting Threshold is set to 99%, and Show Individual Contributors is checked.

1.7.6 To access the CODIS Report settings, from the STRmix™ main menu, select Settings, then select Configure Report Defaults, and then select CODIS Report.

1.7.7 Change Destination ORI and Source Lab accordingly (same setting for both).

1.7.7.1 IRL = INISP5200

1.7.7.2 ERL = INISP3500
1.7.7.3 FWRL = INISP2200
1.7.7.4 LRL = INISP1300

1.7.8 Change User ID to match the bottom-left corner of screen.

1.7.9 Verify that **Max Alleles** is set to 4, that **Genotype Weight Threshold** is set to 99%, and that **Force Single Genotype Match Only** is checked.

1.7.10 Select **Save**.

### 1.8 Setting Up Default Database Search

1.8.1 During the initial set-up of STRmix™, default database search parameters need to be set. Select **Database Search** on the STRmix™ main menu.

1.8.2 The following settings shall be used.

1.8.2.1 The Database utilized shall be the most recent database approved by the Technical Leader located on the QA drive.

1.8.3 Select **Save as kit defaults**.
The average observed percent stutter for each locus and mean +3SD (99.7% confidence level) of stutter observed in the PowerPlex® Fusion 6C validation are listed in the table below. Stutter exception files utilized in STRmix™ analysis are determined through different methods outlined and documented in the STRmix™ validation.

### Stutter Guidelines for PowerPlex® Fusion 6C

<table>
<thead>
<tr>
<th>Locus</th>
<th>n-3/n-4/n-5 Mean</th>
<th>n-3/n-4/n-5 Mean + 3SD</th>
<th>n-6/n-8/n-10 Mean</th>
<th>n-6/n-8/n-10 Mean + 3SD</th>
<th>n+3/n+4/n+5 Mean</th>
<th>n+3/n+4/n+5 Mean + 3SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3S1358</td>
<td>8.90%</td>
<td>13.93%</td>
<td>0.75%</td>
<td>1.29%</td>
<td>0.80%</td>
<td>1.38%</td>
</tr>
<tr>
<td>D1S1656</td>
<td>8.11%</td>
<td>13.86%</td>
<td>1.10%</td>
<td>2.12%</td>
<td>1.23%</td>
<td>2.39%</td>
</tr>
<tr>
<td>D2S441</td>
<td>5.08%</td>
<td>8.55%</td>
<td>0.45%</td>
<td>0.75%</td>
<td>0.88%</td>
<td>1.39%</td>
</tr>
<tr>
<td>D10S1248</td>
<td>8.45%</td>
<td>12.99%</td>
<td>0.74%</td>
<td>1.30%</td>
<td>0.43%</td>
<td>0.83%</td>
</tr>
<tr>
<td>D13S317</td>
<td>4.80%</td>
<td>10.66%</td>
<td>0.42%</td>
<td>0.75%</td>
<td>0.90%</td>
<td>1.77%</td>
</tr>
<tr>
<td>Penta E</td>
<td>3.08%</td>
<td>7.17%</td>
<td>n/a</td>
<td>n/a</td>
<td>1.27%</td>
<td>2.98%</td>
</tr>
<tr>
<td>D16S539</td>
<td>6.76%</td>
<td>12.22%</td>
<td>0.54%</td>
<td>0.95%</td>
<td>1.25%</td>
<td>3.18%</td>
</tr>
<tr>
<td>D18S51</td>
<td>8.23%</td>
<td>15.09%</td>
<td>0.90%</td>
<td>1.77%</td>
<td>1.20%</td>
<td>3.99%</td>
</tr>
<tr>
<td>D2S1338</td>
<td>8.43%</td>
<td>13.43%</td>
<td>0.84%</td>
<td>1.84%</td>
<td>n/a</td>
<td>2.2%</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>6.49%</td>
<td>11.68%</td>
<td>0.85%</td>
<td>3.16%</td>
<td>1.19%</td>
<td>2.43%</td>
</tr>
<tr>
<td>Penta D</td>
<td>2.02%</td>
<td>3.98%</td>
<td>n/a</td>
<td>n/a</td>
<td>1.11%</td>
<td>1.35%</td>
</tr>
<tr>
<td>TH01</td>
<td>1.89%</td>
<td>4.01%</td>
<td>0.42%</td>
<td>n/a</td>
<td>n/a</td>
<td>1.5%</td>
</tr>
<tr>
<td>vWA</td>
<td>7.39%</td>
<td>17.13%</td>
<td>0.94%</td>
<td>1.90%</td>
<td>0.88%</td>
<td>2.30%</td>
</tr>
<tr>
<td>D21S11</td>
<td>8.65%</td>
<td>12.49%</td>
<td>0.62%</td>
<td>1.03%</td>
<td>1.32%</td>
<td>2.32%</td>
</tr>
<tr>
<td>D7S820</td>
<td>5.06%</td>
<td>10.69%</td>
<td>0.55%</td>
<td>0.86%</td>
<td>0.78%</td>
<td>1.40%</td>
</tr>
<tr>
<td>D5S818</td>
<td>6.65%</td>
<td>10.76%</td>
<td>0.51%</td>
<td>0.91%</td>
<td>1.15%</td>
<td>2.17%</td>
</tr>
<tr>
<td>TPOX</td>
<td>2.70%</td>
<td>5.94%</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>1.1%</td>
</tr>
<tr>
<td>D8S1179</td>
<td>7.24%</td>
<td>11.01%</td>
<td>0.61%</td>
<td>1.14%</td>
<td>0.88%</td>
<td>1.69%</td>
</tr>
<tr>
<td>D12S391</td>
<td>9.95%</td>
<td>18.35%</td>
<td>1.02%</td>
<td>2.14%</td>
<td>1.13%</td>
<td>2.21%</td>
</tr>
<tr>
<td>D19S433</td>
<td>7.00%</td>
<td>11.47%</td>
<td>0.85%</td>
<td>2.77%</td>
<td>1.14%</td>
<td>2.44%</td>
</tr>
<tr>
<td>SE33</td>
<td>10.34%</td>
<td>16.20%</td>
<td>1.03%</td>
<td>1.58%</td>
<td>1.17%</td>
<td>2.39%</td>
</tr>
<tr>
<td>D22S1045</td>
<td>8.10%</td>
<td>18.07%</td>
<td>0.88%</td>
<td>1.54%</td>
<td>5.18%</td>
<td>10.71%</td>
</tr>
<tr>
<td>DYS391</td>
<td>6.90%</td>
<td>9.62%</td>
<td>1.86%</td>
<td>3.77%</td>
<td>1.32%</td>
<td>2.70%</td>
</tr>
<tr>
<td>FGA</td>
<td>7.52%</td>
<td>12.98%</td>
<td>0.92%</td>
<td>2.59%</td>
<td>0.83%</td>
<td>1.68%</td>
</tr>
<tr>
<td>DYS576</td>
<td>9.02%</td>
<td>11.93%</td>
<td>1.18%</td>
<td>2.83%</td>
<td>1.70%</td>
<td>3.19%</td>
</tr>
<tr>
<td>DYS570</td>
<td>8.84%</td>
<td>11.84%</td>
<td>1.08%</td>
<td>1.91%</td>
<td>1.24%</td>
<td>2.16%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Locus</th>
<th>n-2 Mean</th>
<th>n-2 Mean + 3SD</th>
<th>n+2 Mean</th>
<th>n+2 Mean + 3SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1S1656</td>
<td>1.81%</td>
<td>3.00%</td>
<td>SE33</td>
<td>1.30%</td>
</tr>
<tr>
<td>D19S433</td>
<td>n/a</td>
<td>1.4%*</td>
<td></td>
<td>2.14%</td>
</tr>
<tr>
<td>SE33</td>
<td>4.77%</td>
<td>5.94%</td>
<td></td>
<td>2.14%</td>
</tr>
<tr>
<td>FGA</td>
<td>n/a</td>
<td>1.2%*</td>
<td></td>
<td>2.41%</td>
</tr>
</tbody>
</table>

* Supplemental values provided by Promega’s developmental validation.
PowerPlex® Fusion 6C Stutter Values Per Allele

The below figure is taken from the PowerPlex® Fusion 6C Validation. It indicates the back stutter ratios per allele observed in the validation.
REPORT WORDING

These are general wording guidelines for commonly occurring test results. Alterations must be approved by a supervisor. Any words in these guidelines that are in *italics* should be changed to reflect your results. Words or phrases in [ ] are optional.

WHEN MULTIPLE CONTENTS ARE IN AN ITEM AND NOT ACCOUNTED FOR IN THE BOLDED ITEM OR SUBITEM DESCRIPTION:

**Item X**  
**Item Description:** # of item description [item X] was/were present.

NEGATIVE RESULTS:

**Item X**  
**Item Description:** No blood/seminal material was detected by presumptive chemical testing.

POSITIVE RESULTS:

**Blood**  
**Item Description:** [Human] Blood was detected by presumptive chemical testing and confirmatory crystalline/immunological testing. X samples were retained as item XA.

**Semen**  
**Item Description:** Seminal material was detected by presumptive chemical testing and confirmatory microscopic examination. X samples were retained as item XA.

PRESumptive testing positive and confirmatory testing negative:

**Item X**  
**Item Description:** Presumptive chemical testing indicated the possible presence of blood/seminal material. [Confirmatory crystalline/immunological testing did not confirm the presence of [human] blood]. X samples were retained in item XA.

Or

Confirmatory microscopic examination did not confirm the presence of seminal material.

PRESumptive testing positive and sample size limited:

**Item X**  
**Item Description:** Presumptive chemical testing indicated the possible presence of blood/seminal material. Additional confirmatory testing for [human] blood/seminal material was not performed in order to preserve the sample for DNA analysis. X samples were retained in item XA.
Presumptive testing positive and no probative value:

Item X  
**Item Description:** Presumptive chemical testing indicated the possible presence of blood/seminal material. No confirmatory testing was performed [at this time]. [If further analysis is desired, please contact the reporting analyst.]

Presumptive testing positive and taken directly to extraction:

Item X  
**Item Description:** Presumptive chemical testing indicated the possible presence of seminal material. No confirmatory testing was performed [at this time]. [X samples were retained in item XA].

No testing performed:

Item X  
**Item Description:** No stains were observed for serological testing. [A sample was retained as item XA.]

Trace evidence:

The reporting term "collected" shall only be used if the evidence is being retained within a subitem.

Within the item

Item X  
**Item Description:** Potential trace evidence was observed/collection and retained as item XA.

At the end of the report:

Trace evidence [observed on/collection from item(s) X] may include but is not limited to paint, glass, hair, and fibers. To determine if further examination is warranted, please contact the reporting analyst.

Hair statements:

Pubic hair combings, pubic hair standards head hair combings and head hair standards may be reported out as “Hair was present” or by use of the Trace statement.

The reporting term "collected" shall only be used if the hair is being retained within a subitem.

Item X  
**Item Description:** Hair demonstrating macroscopic and microscopic characteristics consistent with human hair and having root material with the potential for nuclear DNA analysis was observed/collection and retained as item XA.

Human hair without roots, or other hairs may be considered trace evidence when not significant. The wording below is to be used when of evidentiary value.
Item X  **Item Description:** Hair demonstrating macroscopic and microscopic characteristics consistent with human hair but not having root material with the potential for nuclear DNA analysis was observed /collected and retained as item XA. To determine if further analysis is beneficial, please contact the reporting analyst.

Item X  **Item Description:** Hair demonstrating macroscopic and microscopic characteristics not consistent with human hair was observed.

**STANDARDS:**

Item X  **Blood Standard – John Smith:** A stain card (item XA) was prepared.

Item X  **Buccal swab/hair/other – John Smith:** [Two] Swabs were [present and] retained as XA.

Item X  The oral swab standard/red topped whole blood standard present was not retained/examined due to the presence of multiple standards.

At the end of the report:

**SEROLOGY REPORT STATEMENT FOR SEPARATE DNA EXAMINATION:**

When completed, results of any DNA analysis will be provided separately. All qualifying DNA profiles will be entered into the Combined DNA Index System (CODIS) and searched on a routine basis.

**A STANDARD IS EXCLUDED VISUALLY OR INDIVIDUALLY WITH A STRMIX™ CALCULATED LR= 0 or 1/LR ≥ 100 (to be placed after the appropriate interpretation statement and any inclusionary statements):**

*John Doe* (item XA) is excluded as a contributor to the DNA profile/mixture.

**A DESIGNATED UNKNOWN INDIVIDUAL HAS BEEN DETERMINED AT >12 LOCI IN ANOTHER PROFILE AND HAS BEEN INCLUDED IN A MIXTURE (AT THE ANALYST’S DISCRETION):**

*Unknown Female/Male/Individual #1* cannot be excluded as a contributor to the mixture.

**SINGLE SOURCE STATEMENTS:**
The DNA profile obtained/developed [from item description item XA] was interpreted as originating from a single individual. The probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from John Doe (item XA).
H2: The profile originated from an unknown, unrelated individual.

The DNA profile is at least 1 trillion/LR times more likely if it originated from John Doe than if it originated from an unknown, unrelated individual. This analysis provides limited/moderate/strong/very strong support for the proposition that John Doe is a contributor to the DNA profile.

Detection of One Additional Allele at Amelogenin or Y-STR loci:

The DNA profile obtained/developed [from item description item XA] was interpreted as originating from a single individual. However, one additional allele was detected from which no conclusion can be drawn. The probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from John Doe (item XA).
H2: The profile originated from an unknown, unrelated individual.

The DNA profile is at least 1 trillion/LR times more likely if it originated from John Doe than if it originated from an unknown, unrelated individual. This analysis provides limited/moderate/strong/very strong support for the proposition that John Doe is a contributor to the DNA profile.

Unknown Profile Only (STRmix™ deconvolution performed, but no LR calculated):

The DNA profile obtained/developed [from item description item XA] was interpreted as originating from a single unknown male/female/individual [(Unknown Male/Female/Individual #)].

Single Source Sample consistent with an Elimination Standard:

The DNA profile obtained/developed [from item description item XA] was interpreted as originating from a single individual. Assuming Jane Doe (item XA) as a contributor, no additional alleles were detected.
Single Source Sample consistent with an Elimination Standard, with One Additional Allele at Amelogenin or Y-STR loci:

**Item XA**
The DNA profile *obtained/developed* [from item description item XA] was interpreted as originating from a single individual. Assuming *Jane Doe* (item XA) as a contributor, one additional allele was detected from which no conclusion can be drawn.

Unknown Profile Only (STRmix™ deconvolution performed, but no LR calculated), with One Additional Allele at Amelogenin or Y-STR loci:

**Item XA**
The DNA profile *obtained/developed* [from item description item XA] was interpreted as originating from a single unknown *male/female/individual* [((Unknown Male/Female/Individual #)]; however, one additional allele was detected from which no conclusion can be drawn.

**MIXTURE STATEMENTS:**

Unknown Profiles Only (STRmix™ deconvolution performed, but no LR calculated):

**Item XA**
The DNA profile *obtained/developed* [from item description item XA] was interpreted as originating from *two/three/four* unknown individuals [, at least one of which is male].

Unknown Profiles with Conditioned Reference (STRmix™ deconvolution performed, but no LR calculated):

**Item XA**
The DNA profile *obtained/developed* [from item description item XA] was interpreted as originating from two individuals. Assuming *Jane Doe* (item XA) as a contributor, an unknown *[male/female]* profile was determined [((Unknown Male/Female/Individual #)].

**Item XA**
The DNA profile *obtained/developed* [from item description item XA] was interpreted as originating from *three/four* individuals [, at least one of which is male]. Assuming *Jane Doe* (item XA) as a contributor, a mixture of *two/three* unknown individuals was determined.

Sample Consistent with Multiple Elimination Standards:

**Item XA**
The DNA profile *obtained/developed* [from item description item XA] was interpreted as originating from two individuals. Assuming *Jane Doe* (item XA) and *John Doe* (item XA) as contributors, no additional alleles were detected.
Sample Consistent with an Elimination Standard and a Profile from Corresponding Fraction of a Differential Extraction:

Item XA  The DNA profile obtained/developed from the non-sperm/sperm fraction [of item description item XA] was interpreted as originating from two individuals. Assuming Jane Doe (item XA) and the DNA contributor [determined] from the corresponding sperm/non-sperm fraction as contributors, no additional alleles were detected.

General Mixture Statement (LR ≥ 2, result supports H1, inclusion of one person of interest):

Item XA  The DNA profile obtained/developed [from item description item XA] was interpreted as originating from N individuals. The probability of the evidence has been calculated by considering the following propositions:

H1:  The profile originated from John Doe (item XA) and N-1 unknown individual[s].
H2:  The profile originated from N unknown, unrelated individuals.

The DNA profile is at least 1 trillion/LR times more likely if it originated from John Doe and N-1 unknown individual[s] than if it originated from N unknown, unrelated individuals. This analysis provides limited/moderate/strong/very strong support for the proposition that John Doe is a contributor to the DNA profile.

Mixture with Conditioning (LR ≥ 2, result supports H1, inclusion of one person of interest):

Item XA  The DNA profile obtained/developed [from item description item XA] was interpreted as originating from two individuals. Assuming John Doe as a contributor, the probability of the evidence has been calculated by considering the following propositions:

H1:  The profile originated from John Doe (item XA) and Jane Doe (item XA).
H2:  The profile originated from John Doe (item XA) and an unknown, unrelated individual.

The DNA profile is at least 1 trillion/LR times more likely if it originated from John Doe and Jane Doe than if it originated from John Doe and an unknown, unrelated individual. This analysis provides limited/moderate/strong/very strong support for the proposition that Jane Doe is a contributor to the DNA profile.

Exclusionary Statement (STRmix™ LR calculated, 2≤1/LR<100, result supports H2):
Item XA  The DNA profile obtained/developed [from item description item XA] was interpreted as originating from \( N \) individuals. The probability of the evidence has been calculated by considering the following propositions:

H1:  The profile originated from *John Doe* (item XA) and \( N-1 \) unknown individual[s].
H2:  The profile originated from \( N \) unknown, unrelated individuals.

The DNA profile is *at least 1 trillion/LR* times more likely if it originated from \( N \) unknown, unrelated individuals than if it originated from *John Doe* and \( N-1 \) unknown individual[s]. This analysis provides limited support for the proposition that *John Doe* is excluded as a contributor to the DNA profile.

Inconclusive Statement (STRmix™ LR calculated, LR rounds to 1.0):

Item XA  The DNA profile obtained/developed [from item description item XA] was interpreted as originating from \( N \) individuals. The probability of the evidence has been calculated by considering the following propositions:

H1:  The profile originated from *John Doe* (item XA) and \( N-1 \) unknown individual[s].
H2:  The profile originated from \( N \) unknown, unrelated individuals.

A likelihood ratio of 1.0 was obtained. The DNA profile is equally as likely if it originated from *John Doe* and \( N-1 \) unknown individual[s] or if it originated from \( N \) unknown, unrelated individuals. This result is considered uninformative.

Alternate Propositions (e.g., number of contributors assumption stays the same):

Item XA  The DNA profile obtained/developed [from item description item XA] was interpreted as originating from two individuals. The probability of the evidence has been calculated by considering multiple propositions.

**Proposition Set 1:**

H1:  The profile originated from *Jane Doe* (item XA) and *John Doe* (item XA).
H2:  The profile originated from two unknown, unrelated individuals.
The DNA profile is at least 1 trillion/LR times more likely if it originated from Jane Doe and John Doe than if it originated from two unknown, unrelated individuals. This analysis provides limited/moderate/strong/very strong support for the proposition that Jane Doe and John Doe are both contributors to the DNA profile.

**Proposition Set 2:**
Assuming John Doe as a contributor, the probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from John Doe (item XA) and Jane Doe (item XA).
H2: The profile originated from John Doe (item XA) and an unknown, unrelated individual.

The DNA profile is at least 1 trillion/LR times more likely if it originated from John Doe and Jane Doe than if it originated from John Doe and an unknown, unrelated individual. This analysis provides limited/moderate/strong/very strong support for the proposition that Jane Doe is a contributor to the DNA profile.

**Statement to Be Added When Two Contributors Have Support for H1 Individually, But No Support for H1 When Run Together (Statement to be reported after the inclusionary statements):**

Under the assumption that the mixture originated from N individuals, there is support for the propositions that the DNA profile originated from Jane Doe or John Doe individually. However, there is no scientific support for the proposition that the DNA profile originated from Jane Doe and John Doe together. Refer to the independent inclusionary statistics reported above.

**Alternate Propositions (e.g., different numbers of contributors):**

**Item XA**

The DNA profile obtained/developed [from item description item XA] was interpreted as originating from two individuals. The probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from Jane Doe (item XA) and John Doe (item XA).
H2: The profile originated from two unknown, unrelated individuals.
The DNA profile is at least 1 trillion/LR times more likely if it originated from Jane Doe and John Doe than if it originated from two unknown, unrelated individuals. This analysis provides limited/moderate/strong/very strong support for the proposition that Jane Doe and John Doe are both contributors to the DNA profile.

Alternatively: This profile was also interpreted as originating from three individuals. The probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from John Doe (item XA), Jane Doe (item XA) and an unknown individual.
H2: The profile originated from three unknown, unrelated individuals.

The DNA profile is at least 1 trillion/LR times more likely if it originated from John Doe, Jane Doe and an unknown individual than if it originated from three unknown, unrelated individuals. This analysis provides limited/moderate/strong/very strong support for the proposition that John Doe and Jane Doe are contributors to the DNA profile.

Alternate Propositions Calculated and All Stats are > 1 Trillion:

Item XA

The DNA profile obtained/developed [from item description item XA] was interpreted as originating from two individuals. The probability of the evidence has been calculated by considering multiple propositions.

**Proposition Set 1:**
H1: The profile originated from Jane Doe (item XA) and John Doe (item XA).
H2: The profile originated from two unknown, unrelated individuals.

**Proposition Set 2:** Assuming Jane Doe as a contributor
H1: The profile originated from Jane Doe (item XA) and John Doe (item XA).
H2: The profile originated from Jane Doe and one unknown, unrelated individual.

**Proposition Set 3:** Assuming John Doe as a contributor
H1: The profile originated from Jane Doe (item XA) and John Doe (item XA).
H2: The profile originated from John Doe and one unknown, unrelated individual.
The DNA profile is at least 1 trillion times more likely if it originated from *Jane Doe* and *John Doe* than if it originated from any of the combinations proposed by H2. In each calculation, the analysis provides very strong support for the proposition that *Jane Doe* and *John Doe* are both contributors to the DNA profile.

**SAMPLES UNSUITABLE FOR COMPARISON:**

**No Alleles Detected:**

Item XA  
[Item description] Failed to demonstrate a DNA profile.

**Inconclusive Due to Inability to Assume a Specific Number of Contributors:**

Item XA  
The DNA profile obtained/developed [from item description item XA] demonstrated a partial DNA profile/the presence of a mixture in which the number of contributors cannot reasonably be assumed. Therefore, no further conclusions were drawn.

**Sample consistent with an Elimination Standard and No Conclusion Being Drawn From Additional Alleles:**

Item XA  
The DNA profile obtained/developed [from item description item XA] demonstrated the presence of a mixture. Assuming *Jane Doe* (item XA) as a contributor, no further conclusions could be drawn due to the uncertainty in the number of contributors.

**Inconclusive Due to Inability to Perform a Statistical Calculation:**

Item XA  
The DNA profile obtained/developed [from item description item XA] demonstrated the presence of a mixture of more than four individuals. The results do not qualify for statistical calculations; therefore, no further conclusions were drawn.

**Inconclusive Due to a Failed Control:**

Item XA  
No conclusion can be drawn [on item description item XA] because the/a test control(s) did not meet required parameters.

**If Multiple Samples Are Being Reported Out As Inconclusive Due To A Failed Control:**

Within the item

Item XA  
No conclusion can be drawn regarding [item description] item XA.

At end of report
No conclusion could be drawn regarding items X, Y and Z because the/a test control(s) did not meet required parameters.

**SAMPLES NOT AMPLIFIED:**

**Item Qualified for Amplification, But Chose Not To:**

Item XA  
*Item description* [item XA] was/were extracted and quantified; however, no additional DNA analysis was performed [at this time] due to the development of DNA profiles on other items.

In a sample with insufficient (male) DNA for amplification, where it is valuable to identify a male contributor from a female contributor (i.e. sexual assault cases), the Quantifiler® Trio Y Target results shall be reported.

**Insufficient Human DNA:**

Item XA  
*Item description* [item XA] failed to demonstrate a sufficient quantity of DNA for further analysis.

**Insufficient Male DNA for Autosomal Analysis:**

Item XA  
*Item description* [item XA] failed to demonstrate a sufficient quantity of male DNA for autosomal STR analysis.

**Insufficient Male DNA for Autosomal or Y-STR Analysis:**

Item XA  
*Item description* [item XA] failed to demonstrate a sufficient quantity of male DNA for further analysis.

**Undetected Male DNA:**

Item XA  
No male DNA was detected on *Item description* [item XA].

**STANDARDS:**

Item XA  
The DNA profile obtained/developed of/from *item description* [item XA] was/will be used/developed for comparison purposes.

When standards from another case have been used for comparison but are not mentioned with any developed profiles, the following paragraph should be placed at the end of the report:

The DNA profiles developed were compared to the DNA profile of John Doe (item Xxa, Indiana State Police Laboratory Case XXX-XXXXX, Other Police Department Case XXXXXX).

**When Standards Are Used For Comparison To Another Case:**
The DNA profile of *John Doe* (item XXA) was compared to the evidence in Indiana State Police Laboratory Case XXX-XXXXX, *Other* Police Department Case XXXXX.

**No DNA Profile Developed:**

Item XA  No DNA profile was developed from the standard of/from *item description* [item XA] at this time/due to a lack of evidence for comparison.

When a profile is developed but all unknowns quant out or are inconclusive:

Item XA  Data has been generated but not interpreted due to a lack of evidence for comparison.

**SAMPLE/SUBITEM NOT EXAMINED:**

Item XA  No DNA analysis was performed on *item description* [item XA] at this time [due to a lack of evidence for comparison].

Item XA  Due to limited sample size, no DNA analysis was performed on *item description* [item XA] at this time.

Item XA  No DNA analysis was performed on *item description* [item XA] at this time. If further DNA analysis is desired, permission to consume the sample is required. Please contact the reporting analyst.

**CONFIRMATION OF SPERMATOZOA DURING DIFFERENTIAL EXTRACTION:**

Item XA  The presence of *semen/seminal material* was confirmed during DNA testing of the sperm [cell] fraction.

**IDENTIFICATION OF CONTAMINATION FROM LABORATORY PERSONNEL (WHEN LR ≥ 10,000).** Not all possible combinations are given, consultation with the Technical Leader and/or Supervisor is required:

Item XA  No DNA profile of apparent value was identified on *item description* [item XA]. The DNA profile of an individual working in the lab was identified.

**IDENTIFICATION OF CONTAMINATION FROM OTHER PERSONNEL (WHEN LR ≥ 10,000).** To be added at the end of the appropriate results paragraph. Not all possible combinations are given, consultation with the Technical Leader and/or Supervisor is required:

The DNA profile of an individual involved in the collection of this evidence was identified.
IDENTIFICATION OF IDENTICAL TWINS:

The DNA profiles obtained from Jane Doe (item XA) and Susan Doe (item XA) demonstrated the same allelic profile. This is typically associated with identical twins. The conclusions reflect the comparisons with the provided standards.

Representative Results Paragraph: Not all possible combinations are given, consultation with the Technical Leader and/or Supervisor is recommended.

Item XA  The DNA profile obtained/developed [from item description item XA] is consistent with the DNA profiles of Jane Doe (item XA) and Susan Doe (item XA). Because identical twins are genetically identical, Jane Doe or Susan Doe could be a contributor to the DNA profile.

CODIS STATEMENTS:

Profile Entered (within the item):

[A portion/Portions of] the DNA profile obtained/developed from item description [item XA] was/were entered into the Combined DNA Index System (CODIS) and will be searched on a routine basis. In the event of a database match, information regarding the match(es) will be provided separately.

Pending Standard Submission:

Upon submission of an appropriate DNA standard from Victim, the DNA profile obtained/developed from [item description] item XA will be re-evaluated for possible entry into the Combined DNA Index System (CODIS).

Pending Additional Information:

Additional information is required regarding Item Description before it can be determined if any profiles are eligible to be searched in the Combined DNA Index System (CODIS). Please contact the reporting analyst if a database search is desired.

WORDING WHEN RE-EVALUATING DATA PREVIOUSLY REPORTED OUT WITH NEW FBI ALLELE FREQUENCIES

The statistical calculations were adjusted to reflect the amended allele frequencies published by the FBI. Moretti, T.R., Budowle, B. and Buckleton, J. S., Erratum, Journal of Forensic Sciences 2015; 60(4).

WORDING WHEN RE-EVALUATING DATA PREVIOUSLY REPORTED OUT WITH NEW INTERPRETATION GUIDELINES Requires Supervisor’s Approval and Shall be Placed at the Beginning of the Results Section:
In the DNA analysis detailed below, sample data was re-evaluated using statistical methods implemented after the original report was issued. Accordingly, the following conclusions may differ from the original report.

**WORDING WHEN RE-ISSUING STATISTICAL CONCLUSIONS PREVIOUSLY REPORTED WITH A DIFFERENT VERBAL EQUIVALENT** Shall be Placed at the Beginning of the Results Section:

In the DNA analysis detailed below, sample conclusions were updated utilizing a verbal qualifying statement recommended by the Scientific Working Group on DNA Analysis Methods which was implemented after the original report was issued. Accordingly, the following conclusions may differ from the original report.

**STATEMENTS LOCATED AT THE END OF THE REPORT:**

**REQUIRED STATEMENTS (one or the other must be at the end of the report):**

**DNA Profiles Generated Using PowerPlex® 16 HS:**

In the DNA analysis detailed above, profiles were developed using Polymerase Chain Reaction (PCR) with the PowerPlex® 16 HS System by Promega Corporation.

**DNA Profiles Generated Using PowerPlex® Fusion 6C:**

In the DNA analysis detailed above, profiles were developed using Polymerase Chain Reaction (PCR) with the PowerPlex® Fusion 6C System by Promega Corporation.

**No Samples Amplified:**

Extraction and quantification were performed in the DNA analysis of the sample(s) detailed above.

**ADDITIONAL ITEMS IN KIT NOT EXAMINED:**

The *item description, item description and item description (items XF-XH)* were not examined at this time. Please contact the reporting analyst if additional DNA testing is desired.

**REQUESTS FOR STANDARDS:**

**Standard for Comparison:**

If additional [analysis is/comparisons are] desired, please submit an appropriate DNA standard (such as an oral/buccal swab standard) from [*victim/consensual partner or any suspect(s).*]

**SAMPLES FORWARDED FOR ADDITIONAL ANALYSIS:**

**Y-STR Evaluation Pending:**
This case will be evaluated for possible Y-STR analysis. Any results from additional testing will be provided separately.

**Criminal Paternity/Kinship Analysis Pending:**

When completed, *Paternity/Kinship* analysis of the DNA profiles determined for *John Doe* (item XA), *Jane Doe* (item XA), and *Baby Doe* (item XA) will be provided separately.

**Samples Sent To Another Laboratory:**

Item(s) XA [were/was] sent to *XYZ Laboratory, city, state* for [additional] DNA analysis as per the authority of *John Smith, Police Department*.

**Samples Sent To UNT:**

[A portion of] The *sample/bone* (item XA) was sent to the University of North Texas Center for Human Identification Laboratory for [additional] DNA analysis and entry into the National Missing Persons DNA Database on *date* as per the authority of *John Smith, Police Department*.

**Requests for Family Reference Standards:**

Upon submission of an appropriate DNA standard (such as an oral/buccal swab standard) from *John Doe* and the required Family Reference Standard paperwork, samples will be sent to the University of North Texas Center for Human Identification Laboratory for analysis and entry into the Biological Relatives of Missing Persons Database.

**CODIS Statement When Profiles Are Developed But None Are Suitable For Entry:**

No DNA profiles were *suitable/eligible* for entry into the Combined DNA Index System (CODIS).

**Alternate Propositions Calculated But Not Reported:**

Alternate calculations have been performed for item(s) XA, XB and XC and are available upon request.

**Wording of Statistical Analysis:**

When a calculation with a frequency is reported for PowerPlex® 16 HS data, the following paragraph shall be added:

Statistical estimates were performed based on the recommended concepts endorsed by the Scientific Working Group on DNA Analysis Methods (1/14/10). Calculations for the Caucasian, African American, and Hispanic populations have been performed. The most
common frequency has been reported unless all calculated frequencies exceed 1 in 8 trillion.

**When A Calculation With A Frequency Is Reported Prior to November 1, 2017 For PowerPlex® Fusion 6C Data The Following Paragraph Shall Be Added:**

Statistical estimates were performed based on the recommended concepts endorsed by the Scientific Working Group on DNA Analysis Methods (1/12/17). Y-STR loci included with the PowerPlex® Fusion 6C System were used for interpretations, but were not included in statistical estimates. Calculations for the Caucasian, African American, and Hispanic populations have been performed. The most common frequency has been reported unless all calculated frequencies exceed 1 in 8 trillion.

**When A STRmix™ Likelihood Ratio Is Reported For PowerPlex® Fusion 6C Data, The Following Paragraph Shall Be Added:**

The propositions presented in this report are based upon the case information provided. If an additional set of propositions should be considered, please contact the reporting analyst. If all parties agree that the DNA profile originated from the same individual(s), or if there is equal support for both propositions, the likelihood ratio would equal 1. A likelihood ratio of 1 is uninformative.

Y-STR loci included with the PowerPlex® Fusion 6C System were used for interpretations, but were not included in statistical estimates. Calculations for the Caucasian, African American, Hispanic, and Asian populations have been performed. The lowest likelihood ratio has been reported unless all calculated likelihood ratios exceed 1 trillion.

[In some DNA mixtures, false inclusions of other closely-related family members (such as parents, offspring, and siblings) can occur due to the elevated sharing of genetic information between relatives.]

The statistical calculations are reported in conjunction with a verbal qualifying statement used to express the strength of statistical support. These statements follow the verbal scale recommended by the Scientific Working Group on DNA Analysis Methods (7/12/18). The scale reflects stronger degrees of support as the likelihood ratio increases in magnitude.

<table>
<thead>
<tr>
<th>Likelihood Ratio</th>
<th>Support for H1</th>
<th>Support for H2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>uninformative</td>
<td>uninformative</td>
</tr>
<tr>
<td>$2 \leq LR &lt; 100$</td>
<td>limited</td>
<td>limited</td>
</tr>
<tr>
<td>$100 \leq LR &lt; 10,000$</td>
<td>moderate</td>
<td>exclusion</td>
</tr>
<tr>
<td>$10,000 \leq LR &lt; 1,000,000$</td>
<td>strong</td>
<td>exclusion</td>
</tr>
<tr>
<td>$1,000,000 \leq LR$</td>
<td>very strong</td>
<td>exclusion</td>
</tr>
</tbody>
</table>
When A STRmix™ Likelihood Ratio Was Calculated For PowerPlex® Fusion 6C Data And All LRs Fell In The Range For Exclusions, The Following Paragraph Shall Be Added (this is not necessary if only reporting visual exclusions):

The reported exclusion(s) may include statistical calculations to support the verbal qualifying statement. These statements follow the verbal scale recommended by the Scientific Working Group on DNA Analysis Methods (7/12/18). The scale reflects stronger degrees of support as the likelihood ratio increases in magnitude. Y-STR loci included with the PowerPlex® Fusion 6C System were used for interpretations.

<table>
<thead>
<tr>
<th>Likelihood Ratio</th>
<th>Support for H1</th>
<th>Support for H2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>uninformative</td>
<td>uninformative</td>
</tr>
<tr>
<td>2 ≤ LR &lt; 100</td>
<td>limited</td>
<td>limited</td>
</tr>
<tr>
<td>100 ≤ LR &lt; 10,000</td>
<td>moderate</td>
<td>exclusion</td>
</tr>
<tr>
<td>10,000 ≤ LR &lt; 1,000,000</td>
<td>strong</td>
<td>exclusion</td>
</tr>
<tr>
<td>1,000,000 ≤ LR</td>
<td>very strong</td>
<td>exclusion</td>
</tr>
</tbody>
</table>

STATEMENTS WHEN A DIFFERENTIAL EXTRACTION WAS USED:

The terms “sperm fraction” and “non-sperm fraction” refer to the two portions of the extract generated during a differential extraction procedure. The presence of DNA or a DNA profile in the “sperm fraction” does not inherently confirm the presence of seminal material and may or may not indicate the type of cells from which the DNA originated.

EVIDENCE DISPOSITION STATEMENT:

Unless noted above, all portions of the evidence not consumed during analysis will be returned to the submitting agency. Items stated as retained will remain at the Indiana State Police Laboratory for the possibility of future analysis and the remainder of the evidence or the original packaging will be returned.

WITHDRAWAL STATEMENT:

The request for analysis/DNA analysis was withdrawn by John Smith, Police Department, on Date. The items will be returned to the submitting agency.

EXAMPLES

Opening paragraph for an evidence kit (similar formatting will be used for an item containing multiple items).
Item 001 Evidence Collection Kit – Victim: Items 001A through 001Z1 were present in or prepared from items in the kit.

Item 001A Blood standard: A stain card was prepared and retained as item 001A1.

Item 001A1 Stain card standard for Jane Doe: The DNA profile developed was used for comparison purposes.

Item 001B Vaginal wash: Two swabs were collected.

The combined swabs failed to demonstrate a sufficient quantity of male DNA for autosomal STR analysis.

Item 001C Vaginal/cervical swabs: Two swabs were present.

The DNA profile obtained from the sperm fraction of the combined swabs was interpreted as originating from a single unknown male (Unknown Male #1). The DNA profile developed was entered into the Combined DNA Index System (CODIS) and will be searched on a routine basis. In the event of a database match, information regarding the match(es) will be provided separately.

The DNA profile obtained from the non-sperm fraction of the combined swabs was interpreted as originating from a single individual. Assuming Jane Doe (item 001A1) as a contributor, no additional alleles were detected.

The swabs were retained.

Item 001D Anal swabs: Two swabs were present.

The [sperm and non-sperm fractions of the] combined swabs failed to demonstrate a sufficient quantity of male DNA for autosomal STR analysis.

Each item and subitem will have testing results reported. See examples below:

Item 002 Duct tape: Two pieces of duct tape were present. Four samples were made and retained as item 002A.
Item 002A
The DNA profile developed from the swab (item 002A2) was interpreted as originating from a single unknown female (Unknown Female #1). This profile was entered into Combined DNA Index System (CODIS) and will be searched on a routine basis. In the event of a database match, information regarding the match(es) will be provided separately.

The combined swabs (items 002A1 and 002A3) failed to demonstrate a sufficient quantity of DNA for further analysis.

No DNA analysis was performed on the swab (item 002A4) at this time.

Item 005

**Wipes:** Three wipes were present and labeled 005A1, 005A2 and 005A3. Presumptive chemical testing indicated the possible presence of blood on item 005A1. Confirmatory immunological testing did not confirm the presence of human blood. Three samples were retained within item 005A. Blood was detected by presumptive chemical testing and confirmatory immunological testing on items 005A2 and 005A3. Four samples were retained within item 005A.

Item 005A

**Item 005A1a**

The DNA profile developed from item 005A1a was interpreted as originating from a single individual. The probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from John Smith (item 007A).
H2: The profile originated from an unknown, unrelated individual.

The DNA profile is at least 1 trillion times more likely if it originated from John Smith than if it originated from an unknown, unrelated individual. This analysis provides very strong support for the proposition that John Smith is a contributor to the DNA profile.

Bob Roberts (item 008A) is excluded as a contributor to the DNA profile.

**Item 005A2a**

The DNA profile developed from item 005A2a was interpreted as originating from two individuals. The probability of the evidence has been calculated by considering the following propositions:
H1: The profile originated from John Smith (item 007A) and one unknown individual.
H2: The profile originated from two unknown, unrelated individuals.

The DNA profile is 810 times more likely if it originated from John Smith and one unknown individual than if it originated from two unknown, unrelated individuals. This analysis provides moderate support for the proposition that John Smith is a contributor to the DNA profile.

Bob Roberts (item 008A) is excluded as a contributor to the DNA profile.

Items 005A1b and 005A1c
Items 005A1b and 005A1c failed to demonstrate a sufficient quantity of DNA for further analysis.

Items 005A2b, 005A3a and 005A3b
No DNA analysis was performed on items 005A2b, 005A3a and 005A3b at this time.

**Item 007**  
**Oral swabs – John Smith:** Two swabs were present and retained as item 007A.

Item 007A  
The DNA profile developed was used for comparison purposes.

**Item 008**  
**Oral swabs – Bob Roberts:** Two swabs were present and retained as item 008A.

Item 008A  
The DNA profile developed was used for comparison purposes.

Examples of Property Crime Report

**Example 1**

**Item 001**  
**Swabs of window:** Two swabs (items 001A and 001B) were present. Presumptive chemical testing indicated the possible presence of blood on item 001A. Confirmatory immunological testing did not confirm the presence of human blood. No blood was detected by presumptive chemical testing on item 001B.
The DNA profile developed from item 001A was interpreted as originating from a single individual. The probability of the evidence has been calculated by considering the following propositions:

H1: The profile originated from Robert Jones (item 003A).
H2: The profile originated from an unknown, unrelated individual.

The DNA profile is 68 times more likely if it originated from Robert Jones than if it originated from an unknown, unrelated individual. This analysis provides limited support for the proposition that Robert Jones is a contributor to the DNA profile.

No DNA analysis was performed on the swab (item 001B) at this time.

**Item 002**

**Crowbar:** A sample of the crowbar failed to demonstrate a sufficient quantity of DNA for further analysis.

**Item 003**

**DNA standard – Robert Jones:** Two swabs were present and retained as item 003A.

**Item 003A**
The DNA profile developed was used for comparison purposes.

**Example 2**

**Item 002**

**Swabs of doorknob:** Two swabs were present.

The combined swabs failed to demonstrate a sufficient quantity of DNA for further analysis.

**Item 003**

**DNA standard – Sally Smith:** No DNA analysis was performed at this time due to a lack of evidence for comparison.

### Relationship Testing Wording

<table>
<thead>
<tr>
<th>DNA STR</th>
<th>Mother (Item 1A)</th>
<th>Child (Item 2A)</th>
<th>Alleged Father (Item 3A)</th>
<th>Paternity Index (Race)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locus</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AMELOGENIN</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D3S1358</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D1S1656</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D2S441</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D10S1248</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D13S317</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Penta E</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D16S539</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
D18S51  
D2S1338  
CSF1PO  
Penta D  
TH01  
vWA  
D21S11  
D7S820  
D5S818  
TPOX  
D8S1179  
D12S391  
D19S433  
SE33  
D22S1045  
DYS391  
FGA  
DYS576  
DYS570  

Combined Paternity Index =  
Probability of Paternity =  %

All tested loci shall be displayed on the Certificate of Analysis, even for loci not used in statistical evaluations.

PARENTAGE RESULTS:

A parentage case where alleged individual cannot be excluded:
John Doe (item XA), the alleged father, cannot be excluded as the biological father of the child (item XA). The genetic results listed below are CPI times more likely if John Doe is the biological father of the child than a random, untested, unrelated man in the Caucasian/African American/Hispanic population. The probability of paternity (assuming a prior probability of 0.5) is [W] %.

A parentage case where alleged individual can be excluded:
Given the lack of genetic markers that must be contributed to the child by the biological father in the genetic results listed below, John Doe (item XA), the alleged father, can be excluded as the biological father of the child (item XA).

A parentage case with inconclusive results:
The genetic results listed below do not strongly favor the hypothesis of John Doe (item XA), the alleged father, being the biological father of the child (item XA). The Combined Paternity Index of CPI is low and does not meet our laboratory standards in order to establish paternity; therefore, these results are inconclusive. The genetic results are based only on the current data and additional genetic testing is recommended.
A reverse parentage case where alleged individuals cannot be excluded: Jane Doe (item XA), the alleged mother, and John Doe (item XA), the alleged father, cannot be excluded as the biological parents of the child. The genetic results listed below are CPI times more likely if Jane Doe and John Doe are the biological parents of the child than random, untested, unrelated individuals in the Caucasian/African American/Hispanic population. The probability of parentage (assuming a prior probability of 0.5) is [W] %.

SIBSHIP RESULTS:

A sibship comparison with evidence of relationship: The genetic results listed below support the conclusion that John Doe (item XA) and Joe Doe (item XA) are related as full siblings. These genetic results are CRI times more likely if John Doe is a full sibling of Joe Doe than if they are unrelated. The probability of relationship (assuming a prior probability of 0.5) is [W] %.

A sibship comparison with no evidence of relationship: The genetic results listed below support the hypothesis that John Doe (item XA) and Joe Doe (item XA) have different biological parents over the hypothesis that John Doe and Joe Doe share biological parents. These genetic results are CRI times more likely if John Doe is unrelated to Joe Doe than if they are full siblings. The genetic results are based only on the current data and do not supersede any additional genetic testing.

A sibship comparison with inconclusive results: The genetic results listed below do not strongly support the hypothesis that John Doe (item XA) and Joe Doe (item XA) share the same biological parents nor does it indicate that John Doe and Joe Doe have different biological parents; therefore, it is deemed inconclusive. The Combined Relationship Index for full siblings of CRI/ is low and does not meet the laboratory standards necessary to establish a relationship. The genetic results are based only on the current data and additional genetic testing is recommended. Please contact the reporting analyst in regards to further genetic testing.

CASES WITH AN OBSERVED MUTATION:

A single genetic inconsistency between the child and the alleged father was observed at Locus. This has been incorporated into the calculation as a mutation.

CASES WITH AN OBSERVED MIXTURE:

A mixture was observed in the sample of John Doe (item XA). The following loci were not suitable for statistical calculations as the obligate paternal allele was not able to be determined: (list loci).

CASES WITH MULTIPLE EVIDENTIARY OR STANDARD SAMPLES:
DNA profiles were developed for [two] additional samples of *item description* (item XA); however, these profiles were not used for statistical purposes.

**WHEN A STATISTICAL CALCULATION IS BEING REPORTED:**

Statistical calculations were performed based on the recommendations of the AABB (American Association of Blood Banks).
REQUIRED STATEMENTS (PLACED AFTER RESULTS):

**DNA Profiles Generated Using PowerPlex® Y23:**
In the DNA analysis detailed above, Y-STR profiles were developed using Polymerase Chain Reaction (PCR) with the PowerPlex® Y23 System by Promega Corporation.

**OR**

**No Samples Amplified:**
Quantification was performed in the Y-STR analysis of the samples(s) detailed above.

SINGLE SOURCE STATEMENTS:

**Use Of Exclusionary Statement (Full Profile Obtained From Sample; Standard Is Excluded):**

| Item XA | The Y-STR profile obtained [from item description (item XA)] is consistent with an unknown male. John Doe (item XA) can be excluded as a contributor to the sample. |

**Use Of Consistent Statement (Full Profile Obtained From Sample; No Differences From Standard):**

| Item XA | The Y-STR profile obtained [from item description (item XA)] is consistent with the Y-STR profile obtained from John Doe (item XA). Therefore, John Doe and all his male paternal relatives cannot be excluded as potential Y-STR contributors to the sample. Utilizing the U.S. Y-STR Database/Y-Chromosome Haplotype Reference Database on January 1, 2014 the Y-STR profile has been observed as follows: |

<table>
<thead>
<tr>
<th>POPULATION</th>
<th>HAPLOTYPE</th>
<th>95% UPPER CONFIDENCE INTERVAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caucasian</td>
<td>0 in 5758</td>
<td>1 in 1923</td>
</tr>
<tr>
<td>African American</td>
<td>0 in 4664</td>
<td>1 in 1558</td>
</tr>
<tr>
<td>Hispanic</td>
<td>0 in 3008</td>
<td>1 in 1005</td>
</tr>
</tbody>
</table>

**Use Of Consistent Statement (Full Profile Obtained From Sample; No Differences From Standard with additional allele):**

| Item XA | The Y-STR profile obtained [from item description (item XA)] is consistent with the Y-STR profile obtained from John Doe (item XA); however, an/one additional allele was detected. Therefore, John Doe and all his male paternal relatives cannot be excluded as potential Y-
INDIANA STATE POLICE
FORENSIC BIOLOGY SECTION
TEST METHODS

STR contributors to the sample. No conclusion can be made regarding the additional allele. Utilizing the U.S. Y-STR Database/Y-Chromosome Haplotype Reference Database on January 1, 2014 the Y-STR profile has been observed as follows:

<table>
<thead>
<tr>
<th>POPULATION</th>
<th>HAPLOTYPE</th>
<th>95% UPPER CONFIDENCE INTERVAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caucasian</td>
<td>0 in 5758</td>
<td>1 in 1923</td>
</tr>
<tr>
<td>African American</td>
<td>0 in 4664</td>
<td>1 in 1558</td>
</tr>
<tr>
<td>Hispanic</td>
<td>0 in 3008</td>
<td>1 in 1005</td>
</tr>
</tbody>
</table>

Partial Profile Obtained from Sample:

Item XA  The partial Y-STR profile obtained [from item description (item XA)] is consistent with the Y-STR profile obtained from John Doe (item XA). Therefore, John Doe and all his male paternal relatives cannot be excluded as potential Y-STR contributors to the sample. Utilizing the U.S. Y-STR Database/Y-Chromosome Haplotype Reference Database on January 1, 2014 the Y-STR profile has been observed as follows:

<table>
<thead>
<tr>
<th>POPULATION</th>
<th>HAPLOTYPE</th>
<th>95% UPPER CONFIDENCE INTERVAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caucasian</td>
<td>0 in 5758</td>
<td>1 in 1923</td>
</tr>
<tr>
<td>African American</td>
<td>0 in 4664</td>
<td>1 in 1558</td>
</tr>
<tr>
<td>Hispanic</td>
<td>0 in 3008</td>
<td>1 in 1005</td>
</tr>
</tbody>
</table>

MIXTURE STATEMENTS:

Indistinguishable Mixture:
Item XA  The Y-STR result obtained [from item description (item XA)] demonstrated the presence of a mixture in which the number of contributors cannot reasonably be assumed. Therefore, no further conclusions were drawn.

Distinguishable Major And Minor Components:
Item XA  The Y-STR result obtained [from item description (item XA)] demonstrated the presence of a mixture with a major profile. The major Y-STR profile is consistent with John Doe (item XA). Therefore, John Doe and all his male paternal relatives cannot be excluded as potential Y-STR contributors to the sample. No conclusion can be drawn from the remaining alleles. Utilizing the U.S. Y-STR
Database/Y-Chromosome Haplotype Reference Database on January 1, 2014, the major Y-STR profile has been observed as follows:

<table>
<thead>
<tr>
<th>POPULATION</th>
<th>HAPLOTYPE</th>
<th>95% UPPER CONFIDENCE INTERVAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caucasian</td>
<td>0 in 5758</td>
<td>1 in 1923</td>
</tr>
<tr>
<td>African American</td>
<td>0 in 4664</td>
<td>1 in 1558</td>
</tr>
<tr>
<td>Hispanic</td>
<td>0 in 3008</td>
<td>1 in 1005</td>
</tr>
</tbody>
</table>

SAMPLES UNSUITABLE FOR COMPARISON:

Item XA Due to the limited quantity and/or quality of the sample, the Y-STR profile obtained [from item description (item XA)] failed to demonstrate conclusive results.

Item XA Item description failed to demonstrate a Y-STR profile.

Item XA No conclusion can be drawn regarding item description (item XA) because the/a test control(s) did not meet required parameters.

SAMPLES NOT AMPLIFIED:

Item XA Item description failed to demonstrate a sufficient quantity of male DNA for further Y-STR analysis.

Item XA Item description (item XA) was quantified; however, no further Y-STR analysis was performed at this time.

Item XA No further Y-STR analysis was performed on the DNA standard of John Doe (item XA) due to a lack of evidence for comparison.

SAMPLE/SUBITEM NOT EXAMINED:

Item XA No Y-STR analysis was performed on # additional samples at this time.

Item XA No Y-STR analysis was performed on the DNA standard of John Doe (item XA) due to a lack of evidence for comparison.

Upon evaluation, no samples were determined to be suitable for Y-STR analysis.

IDENTIFICATION OF CONTAMINATION FROM LABORATORY PERSONNEL (Not all possible continuations are given, consultation with the Technical Leader and/or Supervisor is recommended):
INDIANA STATE POLICE
FORENSIC BIOLOGY SECTION
TEST METHODS

Item XA  No Y-STR profile of apparent value was identified on item description (item XA). The Y-STR profile of a laboratory analyst/non-laboratory person was identified.

Item XA  The Y-STR result obtained from item description (item XA) demonstrated the presence of a mixture with a major profile. The major Y-STR profile is consistent with the Y-STR profile of a laboratory analyst/non-laboratory person.

REQUESTS FOR STANDARDS:

Additional Y-STR comparisons will be made upon submission of an appropriate male DNA standard(s) (such as an oral/buccal swab standard).

WORDING OF STATISTICAL ANALYSIS:

When A Calculation With A Frequency Is Reported The Following Paragraph Shall Be Added:

Statistical estimates were performed based on the recommended concepts endorsed by the Scientific Working Group on DNA Analysis Methods (1/9/14). Loci from the PowerPlex® Y kit and from the PowerPlex® Y23 kit have been searched, with the statistical estimate providing the most genetic information and/or highest discrimination potential reported.

CODIS STATEMENT (Placed At The End of Any Report Detailing New Profiles):

At this time, Y-STR profiles cannot be entered or searched in the Combined DNA Index System (CODIS).
DEFINITIONS

1. 99% 1-Sided Lower HPD – A confidence interval is applied to the point estimate to account for uncertainty. The interval gives a range of where the true allele probabilities lie. The lower end of the HPD is reported to be the most conservative to the person of interest.

2. Acid Phosphatase – a chemical component of semen; also found in other body fluids at significantly lower concentrations.

3. Allele – the alternative form of a gene.

4. Allele Frequency – the proportion of a particular allele found in a population.

5. Allelic Ladder – a set of DNA fragments of the commonly known alleles for each locus. By comparing the samples to the allelic ladder, the correct allele designation may be assigned.

6. Ambiguous Zygosity – a locus where a single allele is present in which it is unclear if the locus is homozygous or if the sister allele is dropped out or masked.

7. Amelogenin – the marker for determining the gender of the individual contributor to a DNA profile.

8. Amplification – using the PCR process to create many copies of a specific DNA sequence(s). An increase in the number of copies of a specific DNA fragment.

9. Analyst Discretion - the use of individual judgment, based on an analyst’s training and experience to determine the optimum modes of analysis for an item of evidence.

10. Artifact – non-allelic product of the amplification process, an anomaly of the detection process, or a by-product of primer synthesis. A data peak that does not represent a true allele.

11. Base Pairs – paired nucleotides which make up the DNA molecule. Two complementary nucleotides joined by a hydrogen bond.

12. Blood – the fluid that circulates through the body, containing red and white blood cells carrying oxygen and nutrients to cells throughout the body; and carrying away waste and carbon dioxide.

13. Burn-in – The initial 100,000 accepts during the MCMC process that allow the chains to converge on a “good space”. These iterations are discarded.

14. Capillary Electrophoresis – a method to separate DNA fragments based on size using electrical current. The DNA sample is placed in a thin tube (capillary) containing polymer and subjected to high voltage current allowing the DNA fragments to migrate through the tube.

15. Chromosome – the structure on which genes are naturally arranged and how DNA is organized.

16. Combined DNA Index System (CODIS) – refers to the DNA database and its software. It is composed of National (NDIS), State (SDIS), and Local (LDIS) components. It contains DNA profiles from offenders, crime scenes and includes a missing person database.

17. Conditioning – A likelihood ratio in which an individual is included in both $H_1$ and $H_2$.

18. Contamination – the process of making a sample impure or unusable.

19. Deconvolution – Process to determine the potential contributor genotypes to a mixed DNA profile.

20. Deduced – the inference of an unknown contributor’s DNA profile after taking into consideration the contribution of an assumed contributor’s DNA profile in an intimate sample based on quantitative peak height information.

21. Degradation – the breaking down of the DNA molecule into smaller fragments.
22. Denaturation – the separation of the double stranded DNA molecule into two single strands.
23. Deoxyribonucleic Acid (DNA) - the genetic material present in the nucleus of most cells. Also located in cell mitochondria.
24. DNA Sequence - a specific order of base pairs.
25. Electropherogram – the visual representation of the DNA fragments contained in each sample; generated by the analysis software of the Capillary Electrophoresis Instrument.
26. Electrophoresis – the method to separate molecules based on their size by placing them in a medium and applying an electrical current. The molecules will travel through the medium at different rates, the smaller molecules traveling through the medium more quickly than the larger ones.
27. Enzyme – a protein which acts as a catalyst, speeding up a specific chemical reaction without being changed or consumed in the process.
28. Epithelial Cells – skin cells and other surface cells such as from the mouth (buccal cells) or the vaginal cavity.
29. Factor of N! – Likelihood ratio which compares the person of interest to the total mixture, independent of contributor order.
30. Gelman-Rubin – A value which informs the user whether the MCMC chains have converged.
32. Genotype – the specific genetic sequence of a person’s DNA.
33. Genotype Probability Distribution – A summary of the genotype combinations accepted at each locus and the percentage of accepts per genotype.
34. $H_1/H_P$ – Interchangeable terms for the most likely proposition assigned to the prosecution.
35. $H_2/H_O$ – Interchangeable terms for the most likely proposition assigned to the defense.
36. Hair – a slender outgrowth from the skin of mammals.
37. Heme – the iron containing complex of the hemoglobin molecule.
38. Hemin – the oxidized heme molecule.
39. Hemoglobin - the iron containing protein in blood.
40. Heterozygous – having different alleles at a particular locus.
41. Homozygous – having two of the same allele at a particular locus.
42. Internal Lane Standard (ILS) – a set of DNA fragments of known length(s). The ILS is simultaneously injected with all DNA samples during electrophoresis. This allows accurate measurement of the length of each allele in a DNA sample.
43. Intimate samples – biological sample that is obtained directly from an individual's body.
44. Iteration – A proposed genotype combination and mass parameters that are either accepted or rejected during the MCMC process.
45. Likelihood Ratio – A ratio of the probability of the evidence given two different propositions ($H_1$ and $H_2$).
46. Locus (loci) – the physical location of a gene on a chromosome.
47. LUS – Longest uninterrupted sequence for an allele variation.
48. Marker – a gene of known location and phenotype used as a point of reference.
49. Mass Parameters – Collection of parameters (degradation rate per contributor, amplification efficiencies per locus, replicate amplification strength, template per contributor, and kit efficiency), that are used to determine expected peak heights during deconvolution. Collectively referred to as DARTB.
50. MCMC (Markov Chain Monte Carlo) – A mathematical method that uses a process of random resampling to give the best explanation of observed data.
51. Meaningful profile – a profile that is developed from an item or location where the individual’s profile would not reasonably be expected. A person’s profile may be expected on an item or sample from their own body, their own clothing, or their property such as their house or vehicle. All other samples will generally be considered meaningful.

52. Minimum allele frequency - a conservative frequency correction for alleles observed less than 5 times in the STR population frequency tables.

53. Mitochondria - a part of a cell used in energy production. Contains circular DNA inherited from the mother only.

54. Modified Random Match Probability - an estimate based on the assumption of the number of contributors within a sample, of the probability of selecting an unrelated individual at random that would be included as a potential contributor to the mixed profile.

55. Nucleus - the part of a cell that contains the double stranded DNA inherited from both parents.

56. Obligate allele – an allele in a mixed DNA typing result that is a) foreign to an assumed contributor, or b) based on quantitative peak height information, determined to be shared with the assumed contributor.

57. Partial profile – DNA profile for which typing results were not obtained for all tested loci.

58. Phenotype – the expressed genotype.

59. Polymerase – an enzyme that initiates the duplication of a DNA molecule.

60. Polymerase Chain Reaction (PCR) – a process for amplifying (copying) the DNA molecule.

61. Polymorphism – the presence of more than one possible allele set for a specific gene.


63. Primer – a short nucleotide fragment of known sequence used to locate its complementary sequence on the DNA molecule for the initiation of PCR. Primers target the specific loci to be amplified.

64. Proficiency Testing – a test to evaluate the competency of an analyst in a specific procedure.

65. Property crime – a category of crime that includes, among other crimes, burglary, theft, arson, drug offenses, vandalism, and criminal mischief. Property crimes do not involve force or threat of force.

66. Proposition – A proposed explanation of the data. Interchangeable with “hypothesis”.

67. Post Burn-in – The iterations after burn-in from which the deconvolution is determined.

68. Random Match Probability (RMP) - the probability of obtaining a match between two distinct and unrelated individuals.

69. Replicate – An identical reamplification of an extract.

70. Saliva – digestive fluid from the mouth.

71. Semen/Seminal Fluid – the male ejaculate. In a dried state may be referred to as seminal material. Semen normally contains spermatozoa.

72. Short Tandem Repeat (STR) – small sections of DNA that contain short segments (2, 3, 4 or more base pairs) which repeat several times. The number of repeat units may vary between individuals. STRs are located between specific genes and are considered non-functional.

73. Source attribution - a RMP threshold at which a degree of confidence can be assured that an unknown sample can be attributed to a known reference sample.

74. Spermatozoa – the male reproductive cell, sperm cell.

75. Stochastic effect – peak imbalance observed in a locus and/or allele drop-out due to random, disproportionate amplification of alleles in low quality/quantity template samples.
76. STRmix™ - A fully continuous probabilistic genotyping software which combines biological modeling with mathematical processes to deconvolute DNA profiles and then compare them to reference standards and provide statistical weight in the form of a likelihood ratio.

77. Stratified Likelihood Ratio – A single LR that samples across all populations.

78. Stutter – an artifact that occurs as a by-product of the PCR process. It is observed as a minor peak typically observed one repeat unit smaller than a primary STR allele caused by strand slippage during amplification. Stutter has been observed and documented in other positions.

79. Substrate – the material on which a biological sample is deposited such as at a crime scene.


81. Theta - a value to adjust for population substructure in homozygous loci.

82. Unified Likelihood Ratio – LR that takes in to account that the unknown contributors are made up of both relatives and unrelated people.

83. Validation – a study to assess whether a particular procedure (or instrument) can obtain a desired result reliably and reproducibly. The study includes looking at the conditions necessary to obtain those results and the limitations of the procedure/instrument. All DNA analysis methods shall be validated prior to implementation.

84. Verbal Scale – A verbal representation of the relative strength of the likelihood ratio results.

85. Work Product – the material that is generated as a function of analysis, which may include extracts and amplified product, in tubes or plates, and any aliquots thereof.

86. X chromosome – a sex chromosome, present twice in female cells and once in male cells.

87. Y chromosome – a sex chromosome, present once in male cells (and absent in female cells), paired with the X chromosome.
APPENDIX 9

DNA SERVER INSTRUCTIONS

The DNA servers will be used in place of CDs for storage and archiving of data and photos. Real Time PCR files, 3500 run folders, GeneMapper® ID-X projects, genotypes table .txt files, STRmix™ files, and photos will be saved to the server. Any worksheets, statistic sheets, typed notes pages, or workbooks shall NOT be saved to the server. The printed copy that will be scanned into LIMS upon completion of the case will be the official, tracked copy. We want to avoid duplication of items between LIMS and the server.

On the server, each analyst will have a folder that only he or she will be able to write to. Other analysts will be able to view items in the folder, but will not be able to change, delete or add items within the folder. Within the analyst’s folder there will be one folder for each laboratory case number and request. Each folder will contain all associated data for that request. Any projects or run folders that contain batched data will be saved individually within each of the associated case folders. The following nomenclature shall be used:

Analyst's Folder (created by Lab IT)

- Laboratory case and request folder – “case number_request number” – ex. “10I1234_1” – the request number corresponds to the laboratory request number assigned in LIMS.
  - RT-PCR projects: “1st case on the plate_date_plate#” – ex. “10I1234_01Jan11_01”
  - 3500 run folder: “1st case on the plate_date_plateinjection#” – ex. “10I1234_01Jan11_01” – plate injection number indicates how many times that plate preparation has been put in the instrument for injection; if the same plate preparation is run on a different date, the original date should still be used from when the plate was prepared. If a second preparation of a plate is made on the same date as the first, it shall be designated with a “-2” after the date. Ex. “10I1234_01Jan11-2_01”
  - GeneMapper® ID-X project name: must contain the date the run was started (in most cases the same as the date in the run folder name)- ex. “01Jan11”, “10I1234_01Jan11” or “Controls_01Jan11”. The exported genotypes table .txt file will maintain the same name as the project with the automatic extension “Genotypes Table” added during export.
  - STRmix™ results folders: The deconvolution results folder should include “case number_item number_Decon number”. The LR from previous results folder should include “case number_item number_Decon number-LRPrev number”. If additional characters are added to the name of the either the deconvolution results folder or the LR from previous results folder, those characters shall be added after the specified naming convention.
  - Photos: create a folder per item photographed – folder name “case_item#” ex. “10I1234_item1”. The individual photo file names are left to the analyst’s discretion.

Note: RT-PCR and 3500 Plates generated by the automation team may substitute Batch ID # for Lab Case #. RT-PCR plate names generated by the automation team shall also include the automation analyst initials and PE number.

Note: For RT-PCR projects and 3500 run folders – only the first case on the plate should be included in the name. Do not write more than one case number and do not write “et al.” after the name.
**RELATIONSHIP COMPARISON STATISTICAL REFERENCE SHEET**

Formulas for Paternity Index (PI) and Random Man Not Excluded (RMNE) *(Table below adapted from the AABB, Standards for Relationship Testing Laboratories, 9th Edition, Appendix 7 and 8)*

<table>
<thead>
<tr>
<th>Mother</th>
<th>Child</th>
<th>Alleged Father</th>
<th>PI</th>
<th>RMNE</th>
<th>PE</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD</td>
<td>AB</td>
<td>AC</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>BC</td>
<td>AB</td>
<td>AC</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>BC</td>
<td>AB</td>
<td>AB</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>BC</td>
<td>AB</td>
<td>A</td>
<td>1/a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>B</td>
<td>AB</td>
<td>AC</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>B</td>
<td>AB</td>
<td>AB</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>B</td>
<td>AB</td>
<td>A</td>
<td>1/a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>AC</td>
<td>1/[2(a+b)]</td>
<td>1-(1-a-b)^2</td>
<td>(1-a-b)^2</td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>AB</td>
<td>1/(a+b)</td>
<td>1-(1-a-b)^2</td>
<td>(1-a-b)^2</td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>A</td>
<td>1/(a+b)</td>
<td>1-(1-a-b)^2</td>
<td>(1-a-b)^2</td>
</tr>
<tr>
<td>AB</td>
<td>A</td>
<td>AC</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>AB</td>
<td>A</td>
<td>AB</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>AB</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
<td>1/a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
</tr>
<tr>
<td>AB</td>
<td>AC</td>
<td>1/4a</td>
<td>1-(1-a-b)^2</td>
<td>(1-a-b)^2</td>
<td></td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>(a+b)/4ab</td>
<td>1-(1-a-b)^2</td>
<td>(1-a-b)^2</td>
<td></td>
</tr>
<tr>
<td>AB</td>
<td>A</td>
<td>1/2a</td>
<td>1-(1-a-b)^2</td>
<td>(1-a-b)^2</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>AC</td>
<td>1/2a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>1/a</td>
<td>1-(1-a)^2</td>
<td>(1-a)^2</td>
<td></td>
</tr>
</tbody>
</table>

**Paternity Index for Autosomal Mutations = \( \mu/PE \)**  
\( \mu \) = mutation rate for the locus  
PE is calculated from the above table using the obligate paternal allele

**Paternity Index for Y-STR Mutation = 0.001**

**Combined Paternity Index (CPI) = PI₁ x PI₂ x PI₃...**

**Probability of Paternity (W) = \([CPI \times Pr]/[CPI \times Pr + (1-PR)]\)**  
Pr = Prior Probability
Formulas for Reverse Paternity

(Table below adapted from the AABB, Guidelines for Mass Fatality DNA Identification Operations, 2010, Appendix B)

<table>
<thead>
<tr>
<th>Mother</th>
<th>Possible Child</th>
<th>Father</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
<td>AB</td>
<td>1/2a^2</td>
</tr>
<tr>
<td>A</td>
<td>AB</td>
<td>AB</td>
<td>1/4ab</td>
</tr>
<tr>
<td>A</td>
<td>AB</td>
<td>BC</td>
<td>1/4ab</td>
</tr>
<tr>
<td>AB</td>
<td>A</td>
<td>AB</td>
<td>1/4a^2</td>
</tr>
<tr>
<td>AB</td>
<td>A</td>
<td>AC</td>
<td>1/4a^2</td>
</tr>
<tr>
<td>BC</td>
<td>AB</td>
<td>AB</td>
<td>1/8ab</td>
</tr>
<tr>
<td>BC</td>
<td>AB</td>
<td>AC</td>
<td>1/8ab</td>
</tr>
<tr>
<td>BD</td>
<td>AB</td>
<td>AC</td>
<td>1/8ab</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
<td>1/a^2</td>
</tr>
<tr>
<td>AB</td>
<td>A</td>
<td>A</td>
<td>1/2a^2</td>
</tr>
<tr>
<td>B</td>
<td>AB</td>
<td>A</td>
<td>1/2ab</td>
</tr>
<tr>
<td>BC</td>
<td>AB</td>
<td>A</td>
<td>1/4ab</td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>AC</td>
<td>1/8ab</td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>A</td>
<td>1/4ab</td>
</tr>
<tr>
<td>AB</td>
<td>AB</td>
<td>AB</td>
<td>1/4ab</td>
</tr>
</tbody>
</table>

Formulas for Sibship

(Table below adapted from the AABB, Guidelines for Mass Fatality DNA Identification Operations, 2010, Appendix B)

<table>
<thead>
<tr>
<th>Sibling</th>
<th>Possible Full Sibling</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB</td>
<td>AB</td>
<td>(1+a+b+2ab)/8ab</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>(1+a)^3/(2a)^3</td>
</tr>
<tr>
<td>A</td>
<td>AB</td>
<td>(1+a)/4a</td>
</tr>
<tr>
<td>AB</td>
<td>AC</td>
<td>(1+2a)/8a</td>
</tr>
<tr>
<td>AB</td>
<td>CD</td>
<td>1/4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Half Sibling</th>
<th>Possible Half Sibling</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB</td>
<td>AB</td>
<td>(a+b+4ab)/8ab</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>(1+a)/2a</td>
</tr>
<tr>
<td>A</td>
<td>AB</td>
<td>(1+2a)/4a</td>
</tr>
<tr>
<td>AB</td>
<td>AC</td>
<td>(1+4a)/8a</td>
</tr>
<tr>
<td>AB</td>
<td>CD</td>
<td>1/2</td>
</tr>
</tbody>
</table>

Mutation Rates


Average paternal and maternal mutation rates calculated from tetranucleotide markers listed in AABB, Standards for Relationship Testing Laboratories, 10th Edition, Appendix 6 for D1S1656, D2S441, D10S1248, D12S391, D22S1045.

<table>
<thead>
<tr>
<th>LOCUS</th>
<th>PATERNAL</th>
<th>MATERNAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSF1PO</td>
<td>0.002021</td>
<td>0.000283</td>
</tr>
<tr>
<td>D10S1248</td>
<td>0.001692</td>
<td>0.000409</td>
</tr>
<tr>
<td>D12S391</td>
<td>0.001692</td>
<td>0.000409</td>
</tr>
<tr>
<td>D13S317</td>
<td>0.001743</td>
<td>0.000436</td>
</tr>
<tr>
<td>D16S539</td>
<td>0.001127</td>
<td>0.000481</td>
</tr>
<tr>
<td>D18S51</td>
<td>0.002530</td>
<td>0.000748</td>
</tr>
<tr>
<td>D19S433</td>
<td>0.000745</td>
<td>0.000596</td>
</tr>
<tr>
<td>D1S1656</td>
<td>0.001692</td>
<td>0.000409</td>
</tr>
<tr>
<td>D21S11</td>
<td>0.001709</td>
<td>0.001295</td>
</tr>
<tr>
<td>D22S1045</td>
<td>0.001692</td>
<td>0.000409</td>
</tr>
<tr>
<td>D2S1338</td>
<td>0.001526</td>
<td>0.000245</td>
</tr>
<tr>
<td>D2S441</td>
<td>0.001692</td>
<td>0.000409</td>
</tr>
<tr>
<td>D3S1358</td>
<td>0.001691</td>
<td>0.000211</td>
</tr>
<tr>
<td>D5S818</td>
<td>0.001742</td>
<td>0.000300</td>
</tr>
<tr>
<td>D7S820</td>
<td>0.001348</td>
<td>0.000073</td>
</tr>
<tr>
<td>D8S1179</td>
<td>0.002031</td>
<td>0.000333</td>
</tr>
<tr>
<td>FGA</td>
<td>0.003713</td>
<td>0.000522</td>
</tr>
<tr>
<td>Penta D</td>
<td>0.000259</td>
<td>&lt;0.000253</td>
</tr>
<tr>
<td>Penta E</td>
<td>0.000260</td>
<td>&lt;0.000253</td>
</tr>
<tr>
<td>SE33</td>
<td>0.006400</td>
<td>&lt;0.003000</td>
</tr>
<tr>
<td>THO1</td>
<td>0.000070</td>
<td>0.000043</td>
</tr>
<tr>
<td>TPOX</td>
<td>0.000130</td>
<td>0.000081</td>
</tr>
<tr>
<td>vWA</td>
<td>0.003258</td>
<td>0.000494</td>
</tr>
</tbody>
</table>

PowerPlex® Fusion 6C STR Population Data
APPENDIX 11

Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0 - Instrument

(only necessary the first time PowerPlex® Y23 samples are run or if the parameters change)

See Appendix 3 for security, user roles, and user account settings.

1.0 Create an Instrument Protocol

1.1 Navigate to the Library and select “Instrument Protocols”.

1.2 Select “Create”.

1.3 Select “HID” for the Application Type.

1.4 Select “36” for the Capillary Length.

1.5 Select “POP4” for the Polymer.

1.6 Select the appropriate Dye Set: “Promega G5 WEN”.

1.7 Select “HID36_POP4” for the Run Module.

1.8 Enter the desired Injection Time and Injection Voltage.

1.9 Change the run time to 1500 seconds.

1.10 Name the protocol with the kit name and the injection voltage and time (ex. “PPY23_WEN_3kV3s”).

1.10.1 Instrument protocols shall be created for 3kV3s and 3kV8s.

1.10.2 Instrument protocols using WEN ILS 500 shall include “WEN” in the protocol name.

1.11 Mark “Locked” and click “Save”.

Instrument Protocol:
2.0 Create a Size Standard

2.1 Navigate to the Library and select “Size Standard”.

2.2 Select “Create”.

2.3 Assign the appropriate name: “WEN ILS 500 Y23”.

2.4 Select “Orange” for the Dye Color.

2.5 Type the following into the left column: 60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500. Click “Add Size(s)”.

2.6 Mark “Locked” and click “Save”.

Size Standard:
3.0 Create a QC Protocol

3.1 Navigate to the Library and select “QC Protocols”.

3.2 Select “Create”.

3.3 Assign the appropriate name: “WEN_ILS_500_Y23”.

3.4 Change settings to match the figure below.

3.5 Mark “Locked” and click “Save”.

QC Protocol:
4.0 Create an Assay

4.1 Navigate to the Library and Select “Assays”.

4.2 Select “Create”.

4.3 Assign a descriptive assay name (ex. “PPY23_WEN_3kV3s”).

4.3.1 Assays using WEN ILS 500 shall include “WEN” in the assay name.

4.4 Select “HID” for the Application Type.

4.5 Select the appropriate QC Protocol: “WEN_ILS_500_Y23”.

4.6 Select the appropriate instrument protocol created in 4.7.3.2.

4.7 Mark “Locked” and click “Save”.

Assay:

4.8 An assay shall be created for each instrument protocol.

4.9 If multiple instrument protocols need to be run on the same samples an assay shall be created for that combination of protocols.

4.10 Follow steps 4.1 to 4.7.

4.11 Select “Yes” to assign multiple instrument protocols to this assay.

4.12 Select each desired instrument protocol and click “Add to List”.

4.13 Mark “Locked” and click “Save”.

Assay – Multiple Injections:
Setup an Assay

* Assay Name: PPY23_WEN_3kv3s_3kv8s
Application Type: HID

Protocols

Do you wish to assign multiple instrument protocols to this assay?  No  Yes

Instrument Protocols

Available Library
Instrument Protocols:  

2 Instrument Protocol(s) Assigned to this Assay

<table>
<thead>
<tr>
<th>Injection</th>
<th>Instrument Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PPY23_WEN_3kv3s</td>
</tr>
<tr>
<td>2</td>
<td>PPY23_WEN_3kv8s</td>
</tr>
</tbody>
</table>

NOTE: Order the list of protocols in the order you want them injected

* QC Protocol: WEN_JLS_500_Y23
GeneMapper IDX Protocol: 

Save
5.0 Create a Naming Convention

5.1 Navigate to the **Library** and Select “File Name Convention”.

5.2 Select “Create”.

5.3 Assign a descriptive name (ex. PPY23_FNC).

5.4 Select desired attributes and click “Add”.

5.5 Select desired delimiters and click “Add”.

5.6 Leave file location as the default.

5.7 Look at the “Preview of File Name” field for accuracy.

5.8 Mark “Locked” and click “Save”.

**File Name Convention:**

![File Name Convention](image-url)
6.0 Create a Results Group

6.1 Navigate to the Library and Select “Results Group”.

6.2 Select “Create”.

6.3 Assign a descriptive assay name (ex. PPY_ResultsGroup).

6.4 Select the desired attributes and click “Add”.

6.5 Select the desired delimiters, click the “Add between attributes” box and click “Add”.

6.5.1 The order of the attributes and delimiters can be changed using the “Move Up” and “Move Down” buttons.

6.6 Ensure that “Store reinjection sample file with original sample files (same level)” is selected.

6.7 Leave file location as the default.

6.8 Click so the “Include a Result Group Name folder” box is selected.

6.9 Look at the “Preview of “Results Group Name” field for accuracy.

6.10 Mark “Locked” and click “Save”.

Results Group:
1.0 Importing Panel and Bin Files for use with WEN ILS 500
1.1 Open the GeneMapper® ID-X Version 1.4 software.
1.2 Select Tools → Panel Manager.
1.3 Highlight the “Panel Manager” icon in the navigation pane.
1.4 Select File → Import Panels.
1.5 Navigate to the saved panel, bin, and stutter files. Select “PowerPlexY23_PanelsIDX_v2.0” then click “Import”.
1.6 Select the “ISP Casework Security Group”. Click “OK”.
1.7 In the navigation pane, highlight the “PowerPlexY23_PanelsIDX_v2.0” folder.
1.8 Select File → Import Bin Set.
1.9 Select “PowerPlexY23_BinsIDX_v2.0” then click “Import”.
1.10 In the navigation pane, highlight the “PowerPlexY23_PanelsIDX_v2.0” folder.
1.11 Select File → Import Marker Stutter. A warning box will appear asking to overwrite the current values. Select “Yes”.
1.12 Select “PowerPlexY23_StutterIDX_v2.0” then click “Import”. This will import the Promega Marker Stutter file that has been modified to include the Indiana State Police PowerPlex® Y23 stutter percentages for filtering out stutter as determined by the internal validation studies.
1.13 In the Panel Manager window, select “Apply”, then “OK”.

2.0 Creating a Casework Analysis Method
2.1 Select Tools → GeneMapper Manager.
2.2 Select the “Analysis Methods” tab.
2.3 Select “New” and a new analysis method dialog box will open.
2.4 Enter the name: “PowerPlex Y23 WEN”.
2.5 Select the “ISP Casework Security Group”.
2.6 Enter 3500 as the instrument.
2.7 Select the “Allele” tab. In the “Bin Set” drop-down menu select the appropriate bin set: “PowerPlexY23_BinsIDX_v1.2” or “PowerPlexY23_BinsIDX_v2.0”. Ensure that the “Use marker-specific stutter ratio and distance if available” box is checked. The table values may be left as the factory defaults.
The Allele Tab:

2.8 Select the “Peak Detector” tab. Change the settings to match the figure below.
2.9 The Peak Amplitude Threshold (analytical threshold) values were determined during the internal validation by calculating the noise level of each instrument and determining the cut-off in which the majority of the noise peaks would be below.
2.10 Select the “Peak Quality” tab. Change the settings to match the image below.

The Peak Quality Tab:

2.11 Leave the “SQ and GQ Settings” tab set to the factory defaults.

2.12 Select “Save”.

...
3.0 Creating a Size Standard

3.1 Create the “WEN ILS 500” size standard (see figure below for exact settings and sizes).
4.0 Creating a Table Setting

4.1 Select Tools → GeneMapper Manager.

4.2 Select the “Table Setting” tab and click “New”.

4.3 Under the “General” tab, name the Table Setting “PPY23” and select the “ISP Casework Security Group”.

4.4 Under the “Samples” tab, ensure that check marks are located next to only the following: Status, Sample File, Sample Name, Sample Type, Analysis Method, Panel, Size Standard, Sizing Quality Overridden, Sample File Not Found, Sample Off-Scale, and Sizing Quality. Leave the font “Arial” and the size “11”. Sort by “Sample Type” and then by “Sample Name”. Select the “Ascending” option for both, and leave the final sort option to “None”.

4.5 Under the “Genotypes” tab, ensure that check marks are located next to only the following: Sample Name, Marker, Allele, and Height. Sort by “Sample Name”, then by “Marker”, and then by “None”. Select the “Ascending” option for all three. Change the “Show number of alleles” to 8 and check “Keep Allele, Size, Height, Area, Data Point, Mutation and Comment together”. (If the option to “Keep Allele, Size, Height…” is not visible in the window, expand the window size until the option appears.) Leave the font “Arial” and the size “11”.

4.6 Select “OK”.

5.0 Creating a Plot Setting – Samples, Controls, and Ladders

5.1 Select Tools → GeneMapper Manager.

5.2 Select the “Plot Settings” tab and click “New”.

5.3 Under the “General” tab, name the Plot Setting “PPY23” and select the “ISP Casework Security Group”.

5.4 Under the “Sample Header” tab, ensure that check marks are located next to the following: Sample File, Sample Name, Panel, Sizing Quality Overridden, Sample Off-Scale, and Sizing Quality.

5.5 Under the “Genotype Header” tab, ensure that check marks are located next to the following: Sample File, Sample Name, Panel, Marker, Sample Off-Scale, Out of Bin Allele, Peak Height Ratio, Control Concordance, and Genotype Quality.

5.6 Under the “Sizing Table” tab, ensure that check marks are located next to the following: Dye/Sample Peak, Sample File Name, Marker, Allele, Size, Height, Area, and Data Point. Leave the font “Arial” and the size “11”.

5.7 Select the “Labels” tab. Change the settings to match the following figure. Alternatively, if the allele edit comment” function is not being used, “Label 4” for “Assigned Allele”, “Custom Allele”, and “Artifact” can be changed to “NONE”.

Labels Tab:

5.8 Under the “Display Settings” tab, change the display settings so that they match the following figure and select “OK”.

![Plot Setting Editor](image)
Display Settings Tab:

When opening the Plot Window:

- Use the display settings last used for this plot
- Use these display settings:

For both Sample and Genotype plots:

- Panes: 2
- Labels:
  - No Labels
  - Horizontal Labels
  - Vertical Labels

- Show:
  - Plot Header
  - Marker Range
  - Peak Positions
  - Bring Grids to Top
  - Bring Ladders to Top
  - Allele Changes
  - Bins
  - Toolbar
  - Off-scale

- Axes:
  - Y-Axis: Scale individually
  - X-Axis: Basepairs

For Sample plot only:

- Select Dyes:
  - Blue
  - Green
  - Yellow
  - Red
  - Purple
  - Orange
  - All Dyes

- All Dye Range (bp): *
  - Start Range: 0.0
  - End Range: 1000.0

- Labels:
  - Size Std Labels

For Genotype plot only:

- Marker Margin: 5 bp

* Will be overridden if Retain X-axis Zoom Range is enabled on Plots -> Zoom menu
## APPENDIX 13

POWERPLEX® Y23 STUTTER TABLE

<table>
<thead>
<tr>
<th>Locus</th>
<th>Stutter</th>
<th>Mean% Stutter</th>
<th>Mean+3SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS576</td>
<td>n-4</td>
<td>9.82</td>
<td>12.57</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>1.39</td>
<td>4.00</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.74</td>
<td>1.78</td>
</tr>
<tr>
<td>DYS389I</td>
<td>n-4</td>
<td>5.51</td>
<td>7.14</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>0.44</td>
<td>1.12</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.57</td>
<td>1.50</td>
</tr>
<tr>
<td>DYS448</td>
<td>n-6</td>
<td>2.17</td>
<td>2.55</td>
</tr>
<tr>
<td>DYS389II</td>
<td>n-4</td>
<td>11.32</td>
<td>14.80</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>1.05</td>
<td>2.44</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>1.23</td>
<td>2.30</td>
</tr>
<tr>
<td></td>
<td>n-2</td>
<td>7.76</td>
<td>9.09</td>
</tr>
<tr>
<td></td>
<td>n+2</td>
<td>2.81</td>
<td>4.36</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>0.66</td>
<td>1.55</td>
</tr>
<tr>
<td>DYS19</td>
<td>n-4</td>
<td>7.00</td>
<td>9.74</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.71</td>
<td>2.19</td>
</tr>
<tr>
<td></td>
<td>n-2</td>
<td>0.50</td>
<td>1.05</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>0.70</td>
<td>4.01</td>
</tr>
<tr>
<td>DYS391</td>
<td>n-3</td>
<td>17.78</td>
<td>25.93</td>
</tr>
<tr>
<td></td>
<td>n+3</td>
<td>2.52</td>
<td>5.12</td>
</tr>
<tr>
<td></td>
<td>n-6</td>
<td>3.05</td>
<td>5.04</td>
</tr>
<tr>
<td></td>
<td>n-4</td>
<td>6.61</td>
<td>9.66</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>1.11</td>
<td>2.02</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.99</td>
<td>1.69</td>
</tr>
<tr>
<td>DYS481</td>
<td>n-4</td>
<td>6.68</td>
<td>9.05</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>0.99</td>
<td>2.19</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.69</td>
<td>1.68</td>
</tr>
<tr>
<td>DYS549</td>
<td>n-5</td>
<td>3.03</td>
<td>5.10</td>
</tr>
<tr>
<td></td>
<td>n+5</td>
<td>0.66</td>
<td>1.61</td>
</tr>
<tr>
<td>DYS533</td>
<td>n-4</td>
<td>4.94</td>
<td>7.96</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>0.69</td>
<td>1.75</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.69</td>
<td>0.98</td>
</tr>
<tr>
<td>DYS438</td>
<td>n-4</td>
<td>9.26</td>
<td>14.41</td>
</tr>
<tr>
<td></td>
<td>n+4</td>
<td>0.90</td>
<td>1.88</td>
</tr>
<tr>
<td></td>
<td>n-8</td>
<td>0.69</td>
<td>1.30</td>
</tr>
<tr>
<td></td>
<td>DYS635</td>
<td></td>
<td>DYS390</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>-----</td>
<td>--------</td>
</tr>
<tr>
<td>n-4</td>
<td>6.27</td>
<td>8.55</td>
<td>6.06</td>
</tr>
<tr>
<td>n+4</td>
<td>0.48</td>
<td>0.44</td>
<td>0.87</td>
</tr>
<tr>
<td>n-8</td>
<td>0.69</td>
<td>0.51</td>
<td>0.51</td>
</tr>
<tr>
<td>n-8/n-9</td>
<td>1.01</td>
<td>1.01</td>
<td>1.01</td>
</tr>
</tbody>
</table>

**DYS635**
- n-4: 6.27, 10.67
- n+4: 0.48, 1.26
- n-8: 0.69, 1.74

**DYS390**
- n-4: 8.55, 12.80
- n+4: 0.44, 1.14
- n-8/n-9: 1.01, 2.67

**DYS439**
- n-4: 6.06, 9.19
- n+4: 0.87, 2.31
- n-8: 0.51, 1.02

**DYS392**
- n-3: 9.64, 14.09
- n+3: 5.93, 12.11
- n-6: 1.09, 2.23

**DYS643**
- n-5: 2.33, 5.41
- n+5: 0.50, 1.31

**DYS393**
- n-4: 9.78, 13.05
- n+4: 1.44, 2.71
- n-8: 1.03, 1.97

**DYS458**
- n-4: 9.73, 12.71
- n+4: 0.80, 1.88
- n-8: 0.84, 1.31

**DYS385**
- n-4: 7.89, 14.14
- n+4: 0.82, 1.58
- n-8: 1.09, 2.22

**DYS456**
- n-4: 10.71, 15.71
- n+4: 1.85, 2.68
- n-8: 1.37, 2.93

**Y-GATA-H4**
- n-4: 7.41, 10.05
- n+4: 1.44, 2.25
- n-8: 1.09, 2.10